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1 Introduction

1	 Introduction

1.1	 Symbols Used
Table 1 lists the symbols that are used throughout this User Guide and their meanings.

Table 1 User guide symbols

This symbol indicates you must be logged in as an Administrator to perform the task.

This symbol indicates you must be logged in as an Administrator or have the appropriate 
permission to perform the task.

This symbol indicates you must be logged in as a Typical user or higher or have the appropriate 
permission to perform the task.

This symbol indicates you must be logged in as a Restricted user or higher or have the 
appropriate permission to perform the task.

This symbol indicates important information.

This symbol indicates cautions or warnings.

1.2	 Conventions
The following conventions are used throughout this User Guide.

Table 2 Text conventions

Temperature scale Italics denote menus, menu options, dialog and window captions, and field names 
on dialogs and windows

File | Print | Report The pipe symbol ‘|’ denotes submenu options

Play .WAV file Bold type denotes selectable options

<unknown format> Angle brackets ‘< >’ denote special markers 

1.3	 What is LogWare?
LogWare is a Windows® application that retrieves, stores, and analyzes data from the Fluke 
Corporation, Hart Scientific Division’s (Hart) 1620A “DewK” Thermo-Hygrometer (logger). 
Hart’s 1620 “DewK” and Fluke’s 5020A Thermo-Hygrometers are also supported by LogWare.

LogWare can either be setup in a single-user configuration on a stand-alone computer, or it can 
be setup on an Ethernet network in a client/server, multi-user configuration to maximize the use 
of LogWare’s features and provide access to LogWare’s data from remote computers.

LogWare can log data from multiple loggers in real-time via RS-232, Ethernet, and wire-
less communications. Real-time data may be logged from one or both of a logger’s sensors. 
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LogWare also allows the data acquired by real-time log sessions to be remotely monitored from 
any computer on the network where LogWare is installed. In addition, LogWare can import data 
batches from PC cards or download data directly from the logger’s memory.

All data, whether imported, downloaded, or acquired in real-time, is stored in LogWare’s data 
server and is easily retrievable using LogWare’s data retrieval features. Configurable user login 
accounts and customizable group and permission settings can ensure appropriate security and 
integrity of all stored data. 

Both real-time and previously logged data may be viewed in customizable graphic and tabular 
formats. Graphs can be displayed for both temperature and humidity in user-selectable time-
increments. A variety of critical statistical functions can also be shown for each set of data, 
including minimum, maximum, spread, average, and standard deviation. Alarm settings ac-
company imported, downloaded or real-time data. Alarm events can also be triggered from the 
software while logging data in real-time or remotely monitoring a real-time log session.

LogWare allows onscreen viewing of logged data. It also prints reports and exports data easily 
to multiple file formats that can be viewed in Excel® or other common spreadsheet and data-
base programs. 

LogWare also includes e-mail features to keep you up to date wherever you are. E-mail mes-
sages can be generated for alarm conditions, log session state changes, sensor calibration due 
events, user login/logout, and more. E-mail messages can be sent via SMTP server to any valid 
e-mail address including cell phones, PDAs, etc.

1.4	 License Agreement
For information and details regarding the software End User License Agreement (EULA), refer 
to Section 13, Appendix A – License Agreement.

1.5	 Requirements
LogWare is designed to work with the following thermo-hygrometers (loggers):

Hart Model 1620A “DewK” Thermo-Hygrometer 

Hart Model 1620 “DewK” Thermo-Hygrometer

Fluke Model 5020A “DewK” Thermo-Hygrometer

Single-User Configuration – Stand-Alone Computer Requirements
The following minimum computer configuration is required to install and use LogWare in a 
stand-alone, single-user configuration:

Microsoft® Windows® 2000 (SP4) or XP (SP2) operating system

IBM Compatible Pentium® IV 1GHz processor or better 

512MB RAM 

200MB Hard Drive space for installation (2+GB recommended for data storage)

USB port for installation and license application

●

●

●

●

●

●

●

●
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Multi-User Configuration – Server Computer Requirements
The following minimum server computer configuration is required to install the LogWare server 
files:

Microsoft® Windows® 2000 (SP4) or XP (SP2) or Windows® Server 2003 operating 
system

IBM Compatible Pentium® IV 1GHz processor or better 

1 GB RAM

200MB Hard Drive space for installation (10+GB recommended for data storage)

USB port for installation and license application

Shared folder on network with Full Access for all LogWare users

Multi-User Configuration – Client Computer Requirements
The following minimum client computer configuration is required to install and use the Log-
Ware client software:

Microsoft® Windows® 2000 (SP4) or XP (SP2) operating system

IBM Compatible Pentium® III 700MHz processor or better 

256 MB RAM (512 MB RAM or more recommended)

40MB Hard Drive space 

Access to shared folder on server 

Communications Requirements
To perform real-time logging or to download data from the logger’s memory, LogWare supports 
using any of the following communication protocols:

Serial (RS-232) communications

Ethernet (TCP/IP) communications

Wireless communications (requires additional hardware)

Refer to Section 1.10, Methods of Communication, for more information on the requirements 
and details on how to use these communication protocols in LogWare.

LogWare can either be setup in a single-user configuration on a stand-alone computer, or it can 
be setup on an Ethernet network in a client/server, multi-user configuration.

Additional Requirements
In addition to the requirements above, the following items may be required depending on your 
system configuration and your intended use of LogWare:

Ethernet network connection for client/server confiuration and/or Ethernet 
communications

Ethernet patch cable(s) for Ethernet communications

Wireless RF modem(s) for wireless communications

RS-232 serial (COM) port(s) and “null modem” cable(s) for serial communications

●

●

●

●

●

●

●

●

●

●

●

●
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Access to a Simple Mail Transfer Protocol (SMTP) server for sending e-mail messages

USB port for adding licenses

1.6	 Installation
LogWare can either be setup in a single-user configuration on a stand-alone computer, or it 
can be setup on an Ethernet network in a client/server, multi-user configuration. Before you 
begin installing LogWare, decide which configuration you want to use. Below are some general 
guidelines to use to determine how you should proceed to install LogWare. After deciding 
which configuration to use, refer to the appropriate following section for the instructions to 
install LogWare. 

Note: Before installing LogWare, be sure to read Section 13, Appendix A - License 
Agreement, and the warranty information. Also, refer to Section 1.5, Requirements, to 
make sure the computer(s) you are going to use meet the minimum requirements.

Stand-Alone, Single-User Configuration
You should install LogWare in a stand-alone, single-user configuration if…

You only need to log data in a few locations or processes

You do not need access to LogWare’s data from other computers

You do not have Ethernet network capabilities

You do not plan to expand your system

Client/Server, Multi-User Configuration
You should install LogWare in a client/server, multi-user configuration if…

You need to log data in many locations or processes

Your computer is connected to an Ethernet network

You need access to LogWare’s data from multiple computers

You need access to LogWare’s data from remote locations using the internet and a VPN 
connection to your network

You currently only need to use LogWare on a single computer, but may decide to expand 
in the future 

Preparing for Installation
Before beginning the installation process, make sure you follow these preparatory steps on the 
stand-alone computer or the server computer for a multi-user configuration.

Make backup copies of all existing programs and data before starting the installation 
process. 

Run a disk-checking program to ensure that the disk has no lost clusters. This normally 
involves running a program such as SCANDISK. You may also want to run a disk 
defragmentation program. Consult the computer documentation or a local support person 
for directions on how to perform these tasks.

●

●
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Close all running programs except for the operating system itself.

You may also want to shut down and restart the computer. Doing this ensures that all 
programs are cleared from memory. Be sure to close any applications that may have 
started automatically.

Login to Windows® as an administrator or using an account with administrative rights. If 
you do not have administrative rights on the computer, ask your system administrator for 
assistance. 

1.6.1	 Stand-Alone Single-User Installation
When installing LogWare in a stand-alone, single-user configuration, only one computer is 
required. Both the “server” files (including the data storage files) and the “client” files (includ-
ing the LogWare application itself and all configuration files) are installed on the same com-
puter. Before beginning the installation process, make sure your computer meets the minimum 
requirements. LogWare will not run very efficiently, or may not run at all, on computers that 
do not meet these requirements. Refer to Section 1.5, Requirements, for more information on 
minimum requirements.

Note: To successfully install LogWare, you must be logged into Windows® as an 
Administrator. If you do not have administrative rights, check with your system 
administrator.

Installing LogWare is a three phase process:

Phase 1 – Install the shared LogWare server files

Phase 2 – Install the MET/BASE G2 Application Server and database files

Phase 3 – Install the LogWare client files

All three phases need to be completed on the same computer for a stand-alone, single-user 
configuration. The total time to install LogWare may exceed 20 minutes, depending on the 
performance of the computer. Step by step instructions for completing the installation process 
are outlined below.

Installing LogWare 

Phase 1
1.	 To begin the installation process, insert the USB drive into a USB port on the computer 

and double-click the CDSetup.exe file located in the root directory. The installation 
menu screen should be displayed. Click the icon for LogWare III to launch the server 
setup process. If the setup files were downloaded from the internet, double-click the 
LW3ServerSetup.exe file to launch the server setup process.

2.	 If the Open File – Security Warning dialog is displayed, click Run. 

3.	 When the Welcome dialog is displayed, click Next > to proceed.

4.	 A dialog is displayed with a message regarding becoming familiar with the installation 
process before continuing. Click Next > to proceed or click Cancel to abort the process.

●

●

●
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5.	 Read through the software license agreement. If you accept the terms, select the I accept 
the terms of the license agreement option and click Next > to proceed.

6.	 Read the installation notes file that is displayed for important information regarding 
known installation issues, then click Next > to proceed.

7.	 Enter the serial number that was provided when you purchased LogWare. If you are 
evaluating LogWare, leave the Serial box blank. Click Next > to proceed. 

8.	 When prompted to select the type of configuration, click the Stand-Alone button. 

9.	 If the Insufficient Memory Warning message is displayed, this computer may not have 
enough memory to allow LogWare to run efficiently in a stand-alone configuration. If 
you want to continue and install LogWare anyway, click Yes. Otherwise, click No to abort 
the process.

10.	Setup is now ready to begin installing the server software files. Click Install to proceed. 
Setup will begin copying files to the server computer.

11.	If setup is unable to locate the license file (provided when LogWare is purchased), the 
Select License Folder dialog is displayed. Navigate to the folder containing the  
license.xml file and click OK. Typically, the license file is located in the \License 
subfolder on the USB drive (typically X:\9936A\License where X: is the drive letter of 
the USB drive).

Note: When evaluating LogWare, a limited use license is automatically installed. 
LogWare may be used in its entirety for up to 50 total logins or a maximum of 2 months 
from the date of installation to evaluate the software’s features. When the license expires, 
you will be required to purchase the software (and additional licenses if needed) to 
continue using the software.

Phase 2
1.	 Setup will automatically launch the MET/BASE G2 Application Server Installation. 

On the Introduction dialog, click Next to proceed.

2.	 On the Choose Install Set dialog, the Single Workstation option is selected by default. 
Click Next to proceed.

3.	 On the Choose Install Folder dialog, select the folder where the application server files 
should be installed. It is recommended to use the default setting. Click Next to proceed.

4.	 On the Choose Shortcut Folder dialog, select the desired option for creating application 
server icons. It is recommended to use the default setting. Click Next to proceed.

5.	 Review the information on the Pre-Installation Summary dialog and click Install to 
begin the application server installation. This process will also launch the Java RunTime 
installation process as well as the PostgreSQL installation process. No user interaction is 
required for either of these processes.

6.	 When the application server installation process is complete, click Done. 

Phase 3
1.	 The LogWare III Client Setup is automatically started. When the Welcome dialog is 

displayed, click Next > to proceed.
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2.	 If a previous version of LogWare III is detected on this computer, a prompt is displayed 
to uninstall the previous version. The previous version must be uninstalled before this 
version may be installed. Click Yes to automatically uninstall the previous version or 
click No to abort the process.

Note: Uninstalling a previous version of LogWare III will not delete the database 
containing logged data. When the installation process is complete, data logged by the 
previous version may be migrated into the new data storage system. Refer to Appendix 15, 
Migrating Data From Previous Versions, for more information on migrating data.

3.	 If the Insufficient Memory Warning message is displayed, your computer may not have 
enough memory to allow LogWare to run efficiently in a stand-alone configuration. If 
you want to continue and install LogWare anyway, click Yes. Otherwise, click No to abort 
the process.

4.	 Read through the software license agreement. If you accept the terms, select the I accept 
the terms of the license agreement option and click Next > to proceed.

5.	 If the serial number was not entered during Phase 1 of the installation, the serial number 
dialog is displayed. Enter the serial number that was provided when you purchased 
LogWare. If you are evaluating LogWare, leave the Serial box blank. Click Next > to 
proceed. 

6.	 If setup is not able to automatically determine the server name and port information for 
communicating with the server, a dialog is displayed. The server name should always be 
set to LOCALHOST for a stand-alone configuration. The port should always be 8080. 
Click Next to proceed.

7.	 Setup is now ready to begin installing the client software files. Click Install to proceed.  

8.	 Setup will begin copying client files to the computer and setup the application shortcuts. 
When the installation is complete, select the Yes, I want to restart my computer now 
option and click Finish to complete the installation.

Note: When restarting the computer, login to Windows® as an Administrator to allow the 
installation to complete. You may login to Windows® normally on subsequent logins.

The installation process sets up a couple of services on the computer. The names of these ser-
vices are:

Fluke METBASE G2 Application Server (METBASEG2AS_SVC in Task Manager)

PostgreSQL Database Server (postgres.exe, pg_ctl.exe, and postmaster.exe as 
displayed in Task Manager)

These services are configured to start automatically when the computer is booted and MUST be 
running in order for LogWare to run. It may take between 1 and 5 minutes for the METBASE-
G2AS_SVC service to be ready to accept logins.

●

●
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Note: When installing the LogWare client on a Windows® XP computer that is a stand-
alone computer or a member of a workgroup instead of a domain, you must disable 
simple file sharing if you want to allow all users on this computer to be able to run 
LogWare. Refer to Section 1.6.2.2, Server Firewall Configuration and File Sharing, for 
more information.

1.6.2	 Client/Server Multi-User Installation
When installing LogWare in a client/server, multi-user configuration, one computer is required 
to act as the server and one or more computers are required to act as the clients. The computer 
being used as the server may also be used as a client. The “server” files (including the data stor-
age files and LogWare client installation files) are installed to the server. The “client” files (in-
cluding the LogWare application support and configuration files) may then be installed on the 
client computers by running the client installation from the server computer. Before beginning 
the installation process, make sure your computer meets the minimum requirements. LogWare 
will not run very efficiently, or may not run at all, on computers that do not meet these require-
ments. Refer to Section 1.5, Requirements, for more information on minimum requirements.

Note: To successfully install LogWare, you must be logged into Windows® as an 
Administrator. If you do not have administrative rights, check with your system 
administrator.

Installing LogWare is a three phase process:

Phase 1 – Install the shared LogWare server files on the server computer

Phase 2 – Install the MET/BASE G2 Application Server and database files on the server 
computer

Phase 3 – Install the LogWare client files on the server computer and/or other client computers

Phases 1 and 2 must be performed on the server computer. Phase 3 must be performed on all 
client computers and may also be performed on the server computer if desired. The total time 
to install the LogWare server files (phases 1 and 2) may exceed 20 minutes, depending on the 
performance of the server computer. Step by step instructions for completing the installation 
process are outlined below.

All computers in a client/server configuration must be on the same network. All client comput-
ers must be able to see and have access to the server computer. If your network supports using 
Virtual Private Network (VPN) software, you may be able to install and run LogWare from 
client computers over the internet. Consult your system or network administrator for more 
information and assistance.

Note: Installing LogWare on a network may require enabling file sharing and configuring 
firewall settings on the server computer. If you have never performed these operations, 
are not familiar with how to do this, or if you are unfamiliar with these terms, you may 
want to consult your system or network administrator before beginning the installation 
process.
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Installing LogWare – Server Installation

Phase 1
1.	 To begin the installation process, insert the USB drive into a USB port on the server 

computer and double-click the CDSetup.exe file located in the root directory. The 
installation menu screen should be displayed. Click the icon for LogWare III to launch 
the server setup process. If the setup files were downloaded from the internet, double-
click the LW3ServerSetup.exe file to launch the server setup process.

2.	 If the Open File – Security Warning dialog is displayed, click Run. 

3.	 When the Welcome dialog is displayed, click Next > to proceed.

4.	 A dialog is displayed with a message regarding becoming familiar with the installation 
process before continuing. Click Next > to proceed or click Cancel to abort the process.

5.	 Read through the software license agreement. If you accept the terms, select the I accept 
the terms of the license agreement option and click Next > to proceed.

6.	 Read the installation notes file that is displayed for important information regarding 
known installation issues, then click Next > to proceed.

7.	 Enter the serial number that was provided when you purchased LogWare. If you are 
evaluating LogWare, leave the Serial box blank. Click Next > to proceed. 

8.	 When prompted to select the type of configuration, click the Client/Server button. 

9.	 If the Insufficient Memory Warning message is displayed, this computer may not have 
enough memory to allow LogWare to run efficiently in a client/server configuration. If 
you want to continue and install LogWare anyway, click Yes. Otherwise, click No to abort 
the process.

10.	When prompted to enter the name to use for the shared folder on the server, enter a name 
in the Share field. This is the name to be assigned to the shared folder on the server that 
other computers (clients) will need to connect to in order to install the LogWare client 
software and to run LogWare. It is recommended to use the default setting LogWare III. 
Click Next > to proceed.

11.	Setup is now ready to begin installing the server software files. Click Install to proceed. 
Setup will begin copying files to the server computer.

12.	If setup is unable to locate the license file (provided when LogWare is purchased), the 
Select License Folder dialog is displayed. Navigate to the folder containing the  
license.xml file and click OK. Typically, the license file is located in the \License 
subfolder on the USB drive (typically X:\9936A\License where X: is the drive letter of 
the USB drive).

Note: When evaluating LogWare, a limited use license is automatically installed. 
LogWare may be used in its entirety for up to 50 total logins or a maximum of 2 months 
from the date of installation to evaluate the software’s features. When the license expires, 
you will be required to purchase the software (and additional licenses if needed) to 
continue using the software.

13.	A dialog is displayed with a message regarding file sharing and firewall settings on 
the server. Read the message and click Next > to proceed or click Cancel to abort the 
process.
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Note: You must enable file sharing and configure the firewall on the server computer prior 
to attempting to install the LogWare client software on other computers. 

Phase 2
1.	 Setup will automatically launch the MET/BASE G2 Application Server Installation. 

On the Introduction dialog, click Next to proceed.

2.	 On the Choose Install Set dialog, select either the Small Network, Medium Network, 
or Large Network option, whichever most closely matches this implementation of 
LogWare, and click Next to proceed. Setup will customize the configuration of the 
application server to best suit the option selected.

3.	 On the Choose Install Folder dialog, select the folder where the application server files 
should be installed. It is recommended to use the default setting. Click Next to proceed.

4.	 On the Choose Shortcut Folder dialog, select the desired option for creating application 
server icons. It is recommended to use the default setting. Click Next to proceed.

5.	 Review the information on the Pre-Installation Summary dialog and click Install to 
begin the application server installation. This process will also launch the Java RunTime 
installation process as well as the PostgreSQL installation process. No user interaction is 
required for either of these processes.

6.	 When the application server installation process is complete, click Done. 

7.	 When the server installation is complete, a prompt is displayed for installing the 
LogWare III Client files on the server computer. If you want to install the client software 
on the server computer, check the Yes, install LogWare III client files on this computer 
now checkbox. Otherwise, uncheck the checkbox. Click Finish to complete the server 
installation process. The LogWare III Client Setup is automatically launched if that 
option was selected (see Phase 3 below).

Note: If you plan to migrate data from a previous version of LogWare III, you should 
install the client files on the server computer in order to use the migration utility. Refer to 
Appendix 15, Migrating Data From Previous Versions, for more information on migrating 
data.

8.	 If the option to install the LogWare III Client files was not selected, a restart dialog is 
displayed. Click OK to complete the server installation process and restart the server 
computer.

Note: When restarting the computer, login to Windows® as an Administrator to allow the 
installation to complete. You may login to Windows® normally on subsequent logins.

The installation process sets up a couple of services on the server computer. The names of these 
services are:

Fluke METBASE G2 Application Server (METBASEG2AS_SVC as displayed in 
Task Manager)

PostgreSQL Database Server (postgres.exe, pg_ctl.exe, and postmaster.exe as 
displayed in Task Manager)

●

●
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These services are configured to start automatically when the server computer is booted and 
MUST be running in order for LogWare to run. It may take between 1 and 5 minutes for the 
METBASEG2AS_SVC service to be ready to accept logins.

If you chose to install the client files on the server computer, setup will automatically launch 
the client setup. This phase must also be performed on all other computers that need to run 
LogWare. 

Note: Make a note of the computer name of the server computer and the share name. This 
information will be needed when installing the LogWare client files on other computers. 
To find the computer name, right-click the My Computer icon on the desktop and select 
Properties. Select the Computer Name tab. The computer name should be indicated  (for 
example, SERVERNAME.domainname.com).

Installing LogWare – Client Installation

Phase 3
1.	 To launch the LogWare III Client Setup on other client computers, click the Start button 

on the Windows® Taskbar and select Run. In the Open field, enter \\<SERVERNAME>\
<ShareName>\ClientSetup\Setup.exe where <SERVERNAME> is the name of the 
server computer recorded above, and <ShareName> is the name of the share on the 
server where the LogWare files are installed. Click OK to launch the client setup.

2.	 When the Welcome dialog is displayed, click Next > to proceed.

3.	 If a previous version of LogWare III is detected on this computer, a prompt is displayed 
to uninstall the previous version. The previous version must be uninstalled before this 
version may be installed. Click Yes to automatically uninstall the previous version or 
click No to abort the process.

Note: Uninstalling a previous version of LogWare III will not delete the database 
containing logged data. When the installation process is complete, data logged by the 
previous version may be migrated into the new data storage system. Refer to Appendix 15, 
Migrating Data From Previous Versions, for more information on migrating data.

4.	 If the Insufficient Memory Warning message is displayed, your computer may not have 
enough memory to allow LogWare to run efficiently as a client in the client/server 
configuration. If you want to continue and install LogWare anyway, click Yes. Otherwise, 
click No to abort the process.

5.	 Read through the software license agreement. If you accept the terms, select the I accept 
the terms of the license agreement option and click Next > to proceed.

6.	 If the serial number was not entered during Phase 1 of the installation, the serial number 
dialog is displayed. Enter the serial number that was provided when you purchased 
LogWare. If you are evaluating LogWare, leave the Serial box blank. Click Next > to 
proceed. 

7.	 If setup is not able to automatically determine the server name, port, and share name 
information for communicating with the server, a dialog is displayed. Enter the server 
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name. The port should always be 8080. Enter the name of the share on the server. Click 
Next to proceed.

8.	 Setup is now ready to begin installing the client software files. Click Install to proceed.  

9.	 Setup will begin copying client files to the computer and setup the application shortcuts. 
When the installation is complete, select the Yes, I want to restart my computer now 
option and click Finish to complete the installation.

Note: When restarting the computer, login to Windows® as an Administrator to allow the 
installation to complete. You may login to Windows® normally on subsequent logins.

If the installation process was unable to setup the shared folder during the server installation 
process, this folder may have to be shared manually to allow other computers access to the Log-
Ware client installation files. Refer to Section 1.6.2.1, Sharing a Folder, for more information 
on sharing a folder.

Note: When installing the LogWare client on a Windows® XP computer that is a stand-
alone computer or a member of a workgroup instead of a domain, you must disable 
simple file sharing if you want to allow all users on this computer to be able to run 
LogWare. Refer to Section 1.6.2.2, Server Firewall Configuration and File Sharing, for 
more information.

1.6.2.1	 Sharing a Folder

The basic process of sharing a folder on a Windows® XP computer running on a Microsoft 
network is outlined below. This process may differ on other types of networks and on other op-
erating systems. Completing this process may require administrative permissions. Consult your 
system or network administrator for assistance.

Sharing a Folder on the Network
1.	 On the computer that contains the folder to share (server computer), open Windows® 

Explorer and locate the folder.

2.	 Right-click on the folder to display the popup menu, and select the Properties option. 
This folder’s Properties dialog is displayed.

3.	 Click the Sharing tab.

4.	 Select the Share As or Share this folder option and enter a Share name, such as LogWare 
III.

5.	 Click the Permissions button to display the Permissions for <folder> dialog.

6.	 Select the Everyone group in the Group or user names list and check the Full Control 
checkbox in the Permissions for Everyone list. If the Everyone group does not exist, click 
the Add button to create it first.
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Figure 1 Permissions dialog

7.	 Click OK to close the Permissions for <folder> dialog. Click OK to close the Properties 
dialog. 

1.6.2.2	 Server Firewall Configuration and File Sharing

When configuring LogWare to be used in a client/server, multi-user configuration, all client 
computers must be able to communicate with the server computer. If the server computer is 
running firewall software, the firewall software must be configured to allow LogWare client 
computers to connect to it by adding an exception for a TCP port.  

Note: Improperly configuring firewall software can leave your network susceptible to 
viruses and other attacks from malicious software. Always consult your system or network 
administrator before changing firewall and file sharing settings!
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The steps below indicate how to configure the default Windows® XP firewall to allow LogWare 
client computers to connect to the LogWare server computer. The process of configuring fire-
wall software will differ from one firewall software package to another as well as one operating 
system to another. Consult your firewall software’s documentation for details on adding excep-
tions for a TCP port.

To configure the Windows® XP firewall settings on LogWare’s server computer…

1.	 On the server computer, open the Control Panel window by clicking the Start button and 
selecting the Control Panel option, or the Control Panel option in the Settings menu, 
depending on your Start menu configuration.

2.	 In the Control Panel window, click the Security Center icon and select Windows Firewall 
(if in Category View) or double-click the Windows Firewall icon (if in Classic View) to 
display the Windows Firewall dialog.

3.	 Select the Exceptions tab and click the Add Port button. The Add a Port dialog is 
displayed. 

4.	 In the Name field, enter an appropriate name to identify this exception, such as LogWare 
III Datastore. In the Port number field, enter 8080. Select the TCP option and click OK 
to close the dialog. This should appear as an entry in the Programs and Services list now. 

Figure 2 Add a Port dialogFigure 2 Add a Port dialog
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The checkbox in front of the entry should be checked. 

5.	 Click OK to close the Windows Firewall dialog.

The Windows® XP firewall is now configured to allow LogWare client computers to connect to 
it.

File sharing must also be enabled on the server computer to allow other client computers to 
access the shared client files. The steps below indicate the basic process of configuring file 
sharing in Windows® XP for a Microsoft network. The process of configuring file sharing will 
differ from one network to another as well as one operating system to another. Consult your 
operating system’s help files for details on enabling file sharing.

To enable file sharing on Windows® XP for Microsoft networks on LogWare’s server 
computer…

1.	 On the server computer, open the Control Panel window by clicking the Start button and 
selecting the Control Panel option, or the Control Panel option in the Settings menu, 
depending on your Start menu configuration.

Figure 3 Windows Firewall dialog - Exceptions tabFigure 3 Windows Firewall dialog - Exceptions tab
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2.	 In the Control Panel window, click the Network and Internet Connections icon and select 
Network Connections (if in Category View) or double-click the Network Connections 
icon (if in Classic View) to display the Network Connections window.

3.	 Locate and right-click on the icon for your local area connection and select Properties 
from the popup menu to display the Local Area Connection Properties dialog. 

4.	 In the This connection uses the following items list, locate the File and Printer Sharing 
for Microsoft Networks item. If this item is not checked, check it. Click OK to close the 
Local Area Connection Properties dialog.

Figure 4 Local Area Connection Properties dialog 

5.	 Close the Network Connections window and/or Control Panel window.

File sharing is now enabled. You may be required to restart the computer for the changes to take 
effect. If the installation process failed to share the folder on the server containing the shared 
client files, you may need to share the folder manually. Refer to Section 1.6.2.1, Sharing a 
Folder, for more information on sharing a folder.
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If the LogWare client is installed on a Windows® XP computer that is not a member of a 
network (stand-alone) or is a member of a workgroup instead of a domain, you must disable 
simple file sharing if you want all Windows® users for the computer to be able to run LogWare.

To disable simple file sharing on Windows® XP computer…

1.	 Open Windows® Explorer by right-clicking the Start button and selecting the Explore 
option.

2.	 Select the Folder Options option in the Tools menu to display the Folder Options dialog.

3.	 Select the View tab. In the Advanced settings list, locate and uncheck the Use simple file 
sharing (Recommended) item.

4.	 Click OK to close the Folder Options dialog.

{Figure 5 Folder Options-View Tab - Simple File Sharing

This will allow all users of the computer access to LogWare’s shared files.
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1.7	 Running LogWare
The following information is intended to provide a brief overview on how to get LogWare up 
and running quickly.

1.7.1	 Getting Started
Once the LogWare server and client installations are complete, you may run LogWare and 
configure it for use. In a multi-user, client/server configuration, each LogWare client computer 
should be configured for use according to the users of that client computer. Some of LogWare’s 
default settings are system-wide, but most settings are local to each client.

To configure LogWare…
1.	 Click or double-click the LogWare III icon to run LogWare. An icon was placed on the 

desktop during installation, or locate the icon in the Programs or All Programs option in 
the Start menu.

2.	 The software will start and display the LogWare User Login dialog. Login to LogWare 
using the built-in administrator account. Refer to Section 2.1, Administration, for more 
information on the built-in administrator account. 

3.	 Once logged in, select the Manage User Accounts option from the Tools menu and create 
one or more user accounts. Assign each user account to the appropriate user group. 
Passwords may be created the first time an account is used to login. Refer to Section 
2.2.3, Managing User Accounts, for more information on creating user accounts. 

4.	 Select the Options option from the Tools menu and check LogWare’s default settings. 
Customize the settings as needed for each client computer. Refer to Section 3, LogWare 
III Options, for more information on LogWare’s default settings.

Info: For maximum security, change the password on the built-in administrator account 
LogWare to prevent unauthorized use. Select the LogWare item from the Users list and 
click the Reset Password button. DO NOT FORGET THE PASSWORD! Refer to 
Section 2.2.4, Setting and Changing Account Passwords, for more information on 
changing user account passwords.

To use LogWare…
1.	 Login using one of the newly created user accounts. Select the Login as New User option 

from the File menu and enter the user name for the account to use. Leave the Password 
field blank when logging in using an account for the first time. The Change Password 
dialog is displayed. Enter a password for this user account and click OK to continue. On 
subsequent logins, both the user name and password must be entered.

Note: Be sure not to forget your passwords! Write down your passwords and keep them in 
a secure place.

2.	 When LogWare runs, the Real-Time Log Session Settings dialog is displayed (this feature 
can be disabled if desired). Use this dialog to configure a real-time log session. Refer to 
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Section 5.1, Real-Time Log Session Settings, for more information on setting up a real-
time log session.

3.	 To start a real-time log session, make sure the logger is connected and setup properly. 
Select the appropriate communication settings and click the Query Logger button. 
LogWare reads in the current logger and sensor model numbers, serial numbers, location 
settings (sensor ID), alarm settings, etc. and fills in the information on the Logger tab. 
You may change this information as required. Be sure to set the Location field for 
each sensor appropriately as this information can be used to select logged data for 
viewing, printing, or exporting.

4.	 Click the Session tab. Select the logging interval and start and end criteria.

5.	 Click the Start button to start logging data.

6.	 Additional real-time log sessions may also be setup by selecting the New Log Session 
option from the File menu and repeating steps 2 to 5.

Log session settings can be saved to a configuration file by clicking the Save As button on the 
Real-Time Log Session Settings dialog prior to starting the log session. Refer to Section 3, Log-
Ware III Options, for options on loading configuration files and starting a log session automati-
cally when LogWare starts. 

Note: LogWare supports automatic logins. However, there are some limitations to using 
this feature. Be sure you fully understand this feature and its proper use before 
implementing it. Refer to Section 2.4, Automatic Logins, for more information on setting 
up LogWare to automatically login.

1.8	 LogWare Main Display
When LogWare starts, the main display window is shown. The main display window consists of 
the menus, toolbar, a workspace area and a status bar. 
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Figure 6 Main display window

Menus allow access to the various features of the software. A general description of each menu 
is given below:

File – Create new real-time log sessions, open real-time log session configuration files, 
import and export data, print reports and graphs, login as a new user and exit LogWare. 
Refer to Section 1.8.1.1, File menu, for more information on the File menu options.

Datalog – Create new real-time log sessions, stop and close real-time log sessions, mute 
alarms. Refer to Section 1.8.1.2, Datalog menu, for more information on the Datalog 
menu options.

View – Show/hide toolbar and status bar, view previously logged data, and start a remote 
monitoring session. Refer to Section 1.8.1.3, View menu, for more information on the 
View menu options.

Graph – Show alarms, data points and annotations on the graphs, zooming and printing 
graphs. Refer to Section 1.8.1.4, Graph menu, for more information on the Graph menu 
options.

Tools – Download data from a logger, manage assets and locations, user accounts, log 
sessions and software licenses, create, edit and delete annotations, and change LogWare 
options. Refer to Section 1.8.1.5, Tools menu, for more information on the Tools menu 
options.

Window – Rearrange and switch between open windows. Refer to Section 1.8.1.6, 
Window menu, for more information on the Window menu options.

●

●

●

●

●

●
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Help – Display help topics and About dialog. Refer to Section 1.8.1.7, Help menu, for 
more information on the Help menu options.

Toolbars allow quick access to the most common menu functions. Toolbars are divided into sec-
tions that correspond to related functions. Toolbars may be rearranged as desired by clicking on 
the vertical bar on the left side of the section and dragging it to the desired location. The follow-
ing toolbars are available:

File Toolbar

New - Create a new real-time log session

Open – Open a real-time log session configuration file

Import - Import data from record files 

Export - Export data to HTML, RTF, or CSV files

Print - Print reports and graphs

Datalog Toolbar
 

Setup - Create a new real-time log session

Stop – Stop a real-time log session

Close - Close a real-time log session window

Stop and close all – Stop and close all real-time log sessions

Mute all alarms - Prevents alarm events from occurring

View Toolbar

Logged data – Select logged data to display

Remote Monitoring – Open a remote monitoring session

Graph Toolbar

Show alarms - Shows horizontal alarm lines on the graphs

Show data points - Shows markers at data points on the graphs

Show annotations - Shows annotations on the graphs

Undo zoom - Restores the graphs to show all data

Tools Toolbar

Download - Download data from a logger

Manage assets and locations - Manage loggers, sensors, and locations

●

●

●

●

●

●

●

●

●

●

●

●

●

●

●

●

●

●

●
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Manage user accounts - Manage user accounts, passwords, and permissions

Manage log sessions – Manage real-time log sessions

Options - Change LogWare’s default settings

Help Toolbar

Help - Opens the on-line help file

The status bar, located along the bottom of the window, indicates the function that the software 
is currently performing, server name and connection status, current user and permission infor-
mation, and the current system date and time.

Info: The date and time displayed are local time settings based on the computer’s clock 
and can be modified through the Windows® Control Panel. 

1.8.1	 Menus
The following sections briefly outline each of LogWare’s menus and menu options.

1.8.1.1	 File menu

The File menu contains the following options:

New log session - Creates a new real-time log session; Refer to Section 5, Real-Time 
Data Logging

Open Log Session - Opens a real-time log session configuration file

Import - Imports data from files; Refer to Section 8, Importing Logged Data

Export - Exports logged data to files; Refer to Section 9.2, Exporting Logged Data

Print - Provides options  to print graphs and reports

Graph - Prints the graphs in the active window

Report - Prints reports of logged data; Refer to Section 9.3, Printing Reports

Login as New User - Logs out the current user and displays the LogWare User Login 
dialog to login as a new user

●

●

●

●

●

●

●

●

●

❍
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●
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Exit - Exits LogWare

1.8.1.2	 Datalog menu

The Datalog menu contains the following options:

Setup - Creates a new real-time log session

Stop - Stops a real-time log session

Close - Closes a real-time log session window

Stop and Close All - Stops all real-time log sessions and closes log session windows

Mute All Alarms - Prevents real-time log session alarm events from occurring

1.8.1.3	 View menu

The View menu contains the following options:

Toolbar - Shows/hides the toolbar buttons

Status Bar - Shows/hides the status bar at the bottom of the main display

Logged Data - Displays logged data; Refer to Section 9.1, Viewing Logged Data

Remote Monitoring - Allows real-time log sessions to be remotely monitored; Refer to 
Section 6, Remote Monitoring

1.8.1.4	 Graph menu

The Graph menu contains the following options:

●

●

●

●

●

●

●

●

●

●
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Show Alarms - Shows/hides horizontal alarm lines on the graphs

Show Annotations - Shows/hides vertical annotation lines on the graphs

Show Data Points - Shows/hides data point markers on the graphs

Undo Zoom - Restores the graphs to their normal state

Print Graph - Prints the graphs in the active window

1.8.1.5	 Tools menu

The Tools menu contains the following options:

Download - Downloads data from the logger’s memory; Refer to Section 7, 
Downloading Logged Data

Manage Assets and Locations - Manages loggers, sensors, and locations; Refer to 
Section 10.2, Managing Assets and Locations

Manage User Accounts - Manage user accounts; Refer to Section 2.2.3, Managing User 
Accounts

Manage Log Sessions - Manage real-time log sessions; Refer to Section 10.3, Managing 
Log Sessions

Manage Licenses - Add, remove, and manage licenses. Refer to Section 10.1.1, Manage 
Licenses

Delete Log Sessions - Delete log session data; Refer to Section 10.4, Deleting Log 
Sessions

Annotations - Provides options for managing annotations; Refer to Section 9.1.3, 
Annotations

●

●

●

●

●

●

●

●

●

●

●

●
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Add - Adds an annotation to a data point

Edit - Edits an annotation of a data point

Remove - Removes an annotation from a data point

Options - Allows access to LogWare’s default options and settings; Refer to Section 3, 
LogWare III Options

1.8.1.6	 Window menu

The Window menu contains the following options:

Cascade - Cascades all open windows

Tile Horizontal - Tiles all open windows horizontally

Tile Vertical - Tiles all open windows vertically

Arrange Icons - Arranges the icons for all minimized windows at the bottom of the main 
display

Window List - Displays a list of all open windows

1.8.1.7	 Help menu

The Help menu contains the following options:

Contents - Opens the on-line help file to the Contents topic

Technical Support - Opens the on-line help file to the Technical Support topic

About - Displays the About dialog 

❍

❍

❍
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1.9	 Options
LogWare has many features and settings that can be customized by the user to allow LogWare 
to operate in certain ways. For more information on these options, please refer to Section 3, 
LogWare III Options.

1.10	 Methods of Communication
LogWare supports communicating with the Model 1620A “DewK” Thermo-Hygrometer using 
various methods. Each method of communication has certain properties and settings that need 
to be set properly. 

The following methods of communication are currently supported by LogWare:

Serial (RS-232) – Refer to Section 1.10.1, Serial (RS-232) Communications

Ethernet (TCP/IP) – Refer to Section 1.10.2, Ethernet (TCP/IP) Communications

Wireless – Refer to Section 1.10.3, Wireless Communications

Any of these methods can be used to run real-time log sessions and download data from a 
logger.

Info: The Hart Model 1620 “DewK” Thermo-Hygrometer and Fluke Model 5020A 
“DewK” Thermo-Hygrometer only support the serial (RS-232) communication protocol. 
An Ethernet to RS-232 adapter is available for connecting logger models 1620 and 
5020A to an Ethernet network.

The following sections describe in detail the use of each communication method.

1.10.1	 Serial (RS-232) Communications
In order to use the RS-232 method of communication, you must connect the logger to a serial 
(COM) port on the computer using the “null modem” cable provided with the logger. 

To setup LogWare to use the Serial method of communication, select Serial (RS-232) as the 
communication protocol. The RS-232 Communication Settings dialog displays the settings for 
the Serial (RS-232) method of communication. This dialog is displayed when the Communica-
tion Settings button is clicked and the Serial (RS-232) communication option is selected.

●

●

●
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Figure  7 RS-232 Communication Settings dialog

The COM port field indicates which COM port on the computer should be used for communi-
cating with a logger. This list contains only COM ports which are currently active and available 
on the computer at the time this dialog was displayed and includes both standard and virtual 
COM ports. Use the drop-down list to select the COM port to use. If the COM port to use is not 
listed, it may already be in use by LogWare or another application.

The Baud rate field indicates the default baud rate to use to communicate with a logger. Use the 
drop-down list to select the default baud rate to use.

Info: LogWare is designed to automatically detect the baud rate that a logger is 
operating at. Changing this setting only indicates which baud rate LogWare will try first 
when attempting to communicate with a logger.

The Use redirector option should only be checked when the selected COM port is a virtual 
COM port that uses redirector software. Redirector software creates “virtual” COM ports and 
allows them to be mapped to IP addresses or other supported communication devices. When 
using standard COM ports, this option should not be checked.

The Use RF modem (wireless) option should be left unchecked when using RS-232 to com-
municate with a logger. This option is only used when using wireless communications. Refer 
to Section 1.10.3, Wireless Communications, for more information on configuring wireless 
communications.

Many new computers today do not come with RS-232 ports built-in. LogWare supports using 
many off-the-shelf USB to RS-232 adapters. However, not all such adapters may be compat-
ible with LogWare. Hart has tested many adapters and recommends some of them for use 
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with LogWare. For the most up-to-date information, visit our website at www.hartscientific.
com/software.

1.10.2	 Ethernet (TCP/IP) Communications
In order to use the Ethernet method of communication, you must connect the logger to an Eth-
ernet network using an Ethernet patch cable. To use this protocol, select the Ethernet (TCP/IP) 
communication option when prompted.

Before you can communicate with a logger using the Ethernet protocol, make sure the logger’s 
Ethernet (LAN) communications are enabled and properly configured. By default, the logger’s 
Ethernet communications are enabled. Refer to the logger’s User Guide for more information 
on configuring the logger’s Ethernet communications.

Info: The Ethernet and wireless communication protocols are mutually exclusive in the 
logger – only one may be enabled at a time. Enabling the Ethernet protocol automatically 
disables the wireless protocol, and vice-versa. 

To setup LogWare to use the Ethernet method of communication, select Ethernet (TCP/IP) as 
the communication protocol. The TCP/IP Communication Settings dialog displays the appropri-
ate settings for using Ethernet communications. This dialog is displayed when the Communica-
tion Settings button is clicked.

Figure 8 TCP/IP Communication Settings dialog

LogWare supports using both dynamic (DHCP) and static addressing of loggers connected to 
the network. When possible, it is recommended to use dynamic addressing to allow the logger 
to automatically obtain an IP address from the network’s DHCP server. If you want or need to 
use static addressing, you should contact your network administrator to allocate an IP address 
or range of IP addresses that you can use.
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To use dynamic addressing, select the Dynamic addressing (DHCP) option. Selecting this op-
tion allows LogWare to display a list of all detected loggers on the network at the appropriate 
time. Refer to Section 1.10.2.1, Select Logger, for more information on selecting a logger.

To use static addressing, select the Static addressing option. The IP address and Port boxes are 
enabled. Enter the IP address and port of the logger to communicate with in the boxes provided. 
The logger must be configured to use this IP address. By default, the loggers are configured to 
always use port 10001.

Info: An Ethernet to RS-232 adapter is available for connecting logger models 1620 and 
5020A to an Ethernet network.

1.10.2.1	Select Logger

The Select Logger dialog allows the user to select the logger to use from a list of detected log-
gers on the Ethernet network. This dialog is displayed when using the DHCP mode for Ethernet 
(TCP/IP) communications and clicking the Query Logger button on the Real-Time Log Session 
Settings dialog or by clicking the Download button on the Download Options dialog. Refer to 
Section 5, Real-Time Data Logging, and Section 7, Downloading Logged Data, for more infor-
mation on real-time log sessions and downloading logged data.

Figure 9 Select Logger dialog

The Detected Loggers tab displays a list of all loggers detected on the Ethernet network. This 
list indicates the model, serial number, and IP address of each detected logger.

When using the DHCP mode for Ethernet (TCP/IP) communications, a broadcast command 
is sent over the network to detect all loggers. All loggers that responded to the broadcast are 
listed. If a logger is busy when the broadcast command is sent, it may not respond and therefore 
not appear in the list. Click the Refresh button to send the broadcast command again. Refer to 
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Section 1.10.2, Ethernet (TCP/IP) Communications, for more information on using Ethernet 
communications.

Select the logger to use from the list and click OK.

1.10.3	 Wireless Communications
In order to use the wireless method of communication, you must purchase and install a wireless 
RF modem. The RF modems currently come with either a RS-232 (Model 2633-232) or USB 
(Model 2633-USB) interface. Follow the instructions provided with the RF modem to perform 
the installation, including installing COM port redirector software if necessary. The RS-232 
modem will connect directly to an existing COM port on the computer. Installing the USB 
modem creates a virtual COM port for the modem. 

Info: The wireless communication feature of the logger is optional and is sold separately 
or as an upgrade. 

Before you can communicate with a logger using the wireless protocol, the logger’s wireless 
(RF) communications must be enabled and properly configured, and the RF modem must be 
configured. By default, the logger’s wireless communications are disabled. Refer to the logger’s 
User Guide for more information on enabling and configuring the wireless communications.

Info: The wireless and Ethernet communication protocols are mutually exclusive in the 
logger – only one may be enabled at a time. Enabling the wireless protocol automatically 
disables the Ethernet protocol, and vice-versa. 

To setup LogWare to use the wireless method of communication, select Serial (RS-232) as the 
communication protocol. The RS-232 Communication Settings dialog displays the appropriate 
settings for using the wireless communications. This dialog is displayed when the Communica-
tion Settings button is clicked and the Serial (RS-232) communication option is selected.
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Figure 10 RS-232 Communication Settings dialog - RF modem enabled

The COM port field indicates which COM port on the computer the RF modem is connected to. 
This list contains only COM ports which are currently active and available on the computer at 
the time this dialog was displayed and includes both standard and virtual COM ports. Use the 
drop-down list to select the COM port to which the RF modem is connected. If the COM port is 
not listed, it may already be in use by LogWare or another application or the COM port redirec-
tor software that came with the RF modem may not be properly installed.

The Baud rate field indicates the baud rate to use to communicate with the RF modem. Use the 
drop-down list to select the baud rate to use. By default, the RF modem is set to operate at 9600 
baud.

The Use redirector option should be unchecked when using wireless communications. This 
option is only used for non-wireless RS-232 communications when the selected COM port is a 
virtual COM port that uses redirector software.

Check the Use RF modem (wireless) option to enable using the RF modem. The Instrument ad-
dress box and Properties button are enabled.

The Instrument address box indicates the address of the logger to communicate with. Each log-
ger on the wireless network must be assigned a unique address. Enter the instrument address of 
the logger to communicate with in this box. 

If the RF modem has not been previously configured, click the Properties button to access the 
RF modem’s properties. The RF modem’s current settings are read in and displayed in the RF 
Modem Properties dialog.
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1.10.3.1	RF Modem Properties

The RF Modem Properties dialog displays the RF modem’s current settings and allows the set-
tings to be changed. This dialog is displayed when the Properties button on the RS-232 Com-
munication Settings dialog is clicked.

Figure 11 RF Modem Properties dialog

The wireless communications supported by the logger follow the IEEE 802.15.4 protocol for 
wireless communications. For more information on this protocol, visit the IEEE association 
website at www.ieee.org. Refer to the RF modem’s documentation for more details on each of 
these settings. It is not necessary to install or use the modem configuration software included 
with the RF modem. All necessary settings can be accessed using this dialog. 

The PAN ID box indicates the unique Personal Area Network (PAN) ID for the wireless net-
work using this RF modem. Both the modem and the logger must be configured to use the same 
PAN ID. Enter the PAN ID to use in this box. 

The Channel box indicates the RF channel number to use for communications. Both the modem 
and the logger must be configured to use the same channel number. Enter the channel number 
to use in this box.

The Modem address box indicates the address of the modem on the network. Each logger that 
is to communicate through this modem must be configured with this modem’s address. Enter 
the modem address in this box. 

The Serial number box indicates the serial number of this RF modem and is displayed for infor-
mational purposes only. 

The Power level box indicates the strength of the signal that the modem will transmit. This 
setting is not editable on this dialog and is displayed for informational purposes only. If you 
wish to change the modem’s power level setting, you should install and use the configuration 
software that came with the modem.
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Click OK to write the settings to the RF modem. A prompt is displayed to ask if the settings 
should be written to NVRAM. Writing the settings to NVRAM allows the RF modem to retain 
these settings even after power is disconnected from the RF modem. If the settings are not writ-
ten to NVRAM, disconnecting the power will cause the settings to revert back to their previous 
values. It is recommended to always write the settings to NVRAM.
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2	 Security Features
LogWare provides security features that allow an administrator to control which users have 
access to certain functions and features of LogWare. Access to these features is controlled by 
requiring a password protected login account. 

The following security related terms are used by LogWare. Before setting up user accounts, you 
should be familiar with and understand the meaning of these terms.

Table 3 Security glossary

Term Description
Administrator An administrator is someone who is in charge of setting up and configuring default settings, user 

accounts, and other special features of the software. LogWare includes a built-in administrator 
account that should be used initially to create additional user accounts for each user, group, team, 
etc. 

Group Groups are used to assign a pre-defined set of permissions to a user account. Each user account 
must be assigned to a group. Permissions may be customized for any user by assigning the user 
to the “Custom” group. Note: These groups are separate and independent of LogWare’s e-mail 
groups which allow e-mail recipients to be categorized and assigned to e-mail envelopes for 
sending e-mail messages!

Permissions Permissions are rights that are granted to a user account that allow that user to perform certain tasks 
or allow access to certain features of the software.

User account A user account consists of a user name, password, set of permissions, and other information that 
provide a means of allowing a person to gain access to LogWare and its features. 

LogWare’s security features can be accessed from the Manage User Accounts dialog. To display 
this dialog, select the Manage User Accounts option from the Tools menu. Refer to Section 
2.2.3, Managing User Accounts, for more information on managing user accounts.

Note: To setup LogWare’s security features, you must login to LogWare using the built-in 
administrator account, a user account that is assigned to the Administrator group, or a 
user account that has been granted permission to create and/or manage user accounts. 
Refer to Section 2.1, Administration, for more information on the built-in administrator 
account.

 Setup User Accounts and Passwords 

In order to use LogWare’s security features, you must create user accounts. User accounts are 
used to login to LogWare. User accounts may be created for individuals, teams, or groups. Each 
user account may have an associated password. LogWare does allow certain user accounts to be 
configured to not require a password. This is useful when you need to allow auditors or other 
guests “read only” access to the data, and is required when using LogWare’s auto-login feature 
for automatic logins.

 Setup User Account Permissions 

User accounts can be configured to grant users access to the features of LogWare they require 
by setting up permissions. Each user account must be assigned to a group. Each pre-defined 
group has a fixed set of permissions associated with it. However, a “custom” group is provided 
that allows the administrator to assign any combination of permissions to a user account as 
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needed. It is recommended that whenever possible, you should try to use the pre-defined groups 
and avoid customizing permissions. 

Note: Certain features in the software can only be used if the user account is a member of 
the Administrator group, even if the user account has been granted the appropriate 
permissions using the Custom group!

 Changing Passwords 

LogWare allows the administrator to force a user to assign a new password to their user ac-
count. The administrator may also assign a new password to the user account in case the user 
forgot the current password.

Once user accounts have been created, they may be used to login to LogWare from any client 
computer. LogWare does not attempt to restrict the number of computers that can be logged 
in using a given account. The number of concurrent logins is only restricted by the number of 
licenses you have purchased and applied to the system.

The following sections outline how to setup and configure LogWare’s user accounts and other 
security features.

2.1	 Administration
When LogWare is installed on a computer for the first time, a built-in administrator account is 
created. You must initially use this built-in account to login to LogWare to create and manage 
user accounts. You may also setup additional administrator accounts. The user name and pass-
word for the built-in administrator account are:

User name: LogWare

Password: LogWare

Note: You should change the password for the built-in administrator account to prevent 
unauthorized user access. Passwords are case-sensitive!

Every time LogWare runs, the LogWare User Login dialog is displayed. Enter the built-in ad-
ministrator user name and password as indicated above and click OK.

When logged in using any administrator account (accounts that are assigned to the Adminis-
trators group), you are granted special permission to access and change many of LogWare’s 
restricted settings. These restricted settings include, but are not limited to, setting up an auto-
login account, configuring automatic removal of inactive log sessions, and managing software 
licenses. Also, some features of LogWare are disabled when a user is logged in using any 
administrator account, such as automatically starting real-time log sessions on startup.

Select the Manage User Accounts option in the Tools menu to create and manage user accounts.
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2.2	 User Accounts
User accounts allow LogWare to identify users who perform certain tasks. They also allow the 
administrator to determine permissions (which users have access to certain features). Each user 
account consists of a user name, password, and user group and permissions settings. 

By default, LogWare has one built-in administrator account. After LogWare is installed, the ad-
ministrator must initially use this account to login and create accounts for each person or team 
who will use the software. Also, the administrator should change the password for the built-in 
administrator account to prevent unauthorized access to the software.

Note: Do not forget your passwords! Administrators can change or reset user account 
passwords, but they cannot recover passwords. If necessary, write the passwords down 
and keep them in a secure location.

2.2.1	 User Names and Passwords
LogWare imposes some simple rules about user names and passwords that must be observed.

User names…

are not case-sensitive 

must be unique

must be between 4 and 20 characters in length

can consist of numbers, letters, and any of the following symbols: - + . < > @ ! # $ % & 
^ _ | ~

Passwords…

are case-sensitive 

must be between 4 and 20 characters in length

can consist of numbers, letters, and any of the following symbols: - + . < > @ ! # $ % & 
^ _ | ~

Info: Currently, LogWare does not impose any restrictions regarding complexity, 
minimum or maximum age, or re-use of passwords.

2.2.2	 User Groups and Permissions
LogWare requires each user account to be assigned to a user group. User groups define the 
functions and features of LogWare a user is allowed to use. Refer to the table below for infor-
mation on the default permissions for each user group. The Custom user group should be used 
when a user account needs to be assigned special permissions that are not covered by any of the 
pre-defined user groups.

●

●

●

●

●

●

●
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Note: The Custom user group should only be used to grant limited permissions to a user 
account. When possible, a user account should be assigned to one of the pre-defined user 
groups. It is not recommended to use the Custom user group to grant a user account all 
permissions in LogWare. Some features of LogWare are restricted only to members of the 
Administrator user group.

Table 4 Account restrictions

LogWare Functions/Features

User Group

Guest Restricted Typical
 

Administrator

Automatic login X X - -

Automatically start log sessions - X X -

View logged data X X X X

Print reports and graphs X X X X

Remote monitoring X X X X

Run real-time log sessions - X X X

Import data from files - X X X

Download data from logger - X X X

Create annotations for logged data - X X X

Export logged data - X X X

Add new assets (loggers and sensors) - - X X

Add new locations - - X X

Edit alarm settings - - X X

Edit e-mail settings - - X X

Change LogWare’s default settings - - X X

Manage log sessions - - X X

Create user accounts - - - X

Manage user accounts - - - X

Manage assets (loggers and sensors) - - - X

Manage locations - - - X

Delete log sessions - - - X

Manage logged data annotations - - - X

Manage licenses - - - X

Setup auto-login account - - - X

Enable/disable calibration due notifications - - - X

Enable/disable graph customization dialog - - - X

Enable/disable automatically removing 
inactive log sessions from Remote Monitoring 
dialog

- - - X

2.2.3	 Managing User Accounts
In order to use LogWare, users must login using a user account. User accounts are created and 
managed by an administrator. Each user account has a user name and a password.

To create and manage user accounts, you must login using an administrator account or have the 
appropriate permissions. Select the Manage User Accounts option in the Tools menu to display 
the Manage User Accounts dialog.
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Figure 12 Manage User Accounts dialog

The Users list displays the currently configured user accounts. The group that the user account 
is assigned to is indicated in parentheses. The group assignment determines the specific permis-
sions a user account has. All user accounts that are assigned to the Administrator group are 
indicated in bold text and display a different icon from the other user accounts. Items marked 
with an asterisk indicate this user is required to change the account password on next login.

 To setup a new user account… 

1.	 Click the New button to display the New User Account dialog. 

2.	 Fill in the information on this dialog. 

On the User Account tab, the User name field must be unique. 

The First name and Last name fields are optional.

Leave the Require password checkbox checked unless you are creating a user 
account that you do not want to require a password, such as for guest users or for 
auto-login purposes.

On the Permissions tab, select on of the pre-defined groups using the Group drop-
down list.

If the purpose for this user account does not fit one of the pre-defined groups, 
select Custom using the Group drop-down list and check the appropriate 
permissions for this account in the Permissions list.

a.

b.

c.

d.

e.
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3.	 Click OK to close the dialog. The new user account should appear in the Users list with 
the group indicated in parentheses. An asterisk should appear after the user name if this 
account requires a password to be set by the user on first login.

 To change the settings for an existing user account…

1.	 In the Users  list, select the user account to change.

2.	 Click the Settings button to display the <Username> Account Settings dialog.

3.	 Edit the information on this dialog. Note: The User name field is locked and cannot be 
changed!

4.	 Click OK to close the dialog. Updates to the user account group assignment or password 
status should be reflected in the Users list. 

 To remove an existing user account…

1.	 In the Users list, select the user account to remove.

2.	 Click the Remove button. 

3.	 A prompt is displayed to confirm removing the user account. Click Yes to confirm. The 
user account should be removed from the Users list.

Note: A user account should only be removed if it is never to be used again. If you wish to 
temporarily disable an account, simply uncheck the Active option on the <Username> 
Account Settings dialog. The built-in administrator account LogWare cannot be removed!

 To reset a user account password…

1.	 In the Users list, select the user account which requires the password to be reset.

2.	 Click the Reset Password button. 

3.	 The Change Password dialog is displayed. Enter the new password for this user account 
in the New password and Confirm password fields. 

4.	 Click OK to reset the password. 

Note: Changes to user accounts, with the exception of resetting passwords, will not take 
effect until you click the OK button on the Manage User Accounts dialog. Clicking Cancel 
on the Manage User Accounts dialog discards all user account changes! 

2.2.3.1	 User Account Settings

 The User Account Settings dialog allows LogWare user accounts to be created and changed. 
To display this dialog, select the New or Settings button on the Manage User Accounts dialog. 
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Figure 13 User Account Settings dialog

On the User Account tab, enter the user name for this account in the User name field. This field 
is required and is what the user must enter into the login dialog when LogWare starts.

Enter the first and last names for this user account in the First name and Last name fields re-
spectively. This information is optional and may be omitted. If you are creating a user account 
for a group, team, or for general use, you may want to leave these fields blank. 

To allow this user account to be used to login to LogWare, check the Active checkbox. To pre-
vent a user from logging into LogWare using this account, uncheck this checkbox. 

The Change password on next login checkbox indicates whether the user will be prompted 
to change their password the next time this user account is used to login to LogWare. When 
creating a new user account, this checkbox is named Require password and determines whether 
this user account has a password associated with it. If this account is going to be used for 
automatic login, you must uncheck this checkbox! This will allow login using this account 
without requiring a password to be entered.

Note: The Require password option is checked and disabled by default if the user account 
is assigned to the Typical or Administrator group (see below). User accounts assigned to 
these groups always require a password and cannot be used for automatic logins.

The Remarks field can be used for entering notes regarding this user account. When creating a 
new user account, this field indicates the date the account was created and the user that created 
the account. You may change it or add additional notes if desired.

To assign this user account to a group or setup custom permissions, select the Permissions tab. 
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Figure 14 User Account Settings dialog - Permissions tab

Note: Certain tasks in LogWare can only be performed if the user account is assigned to 
the Administrator group. Some of these tasks include resetting user account passwords, 
managing licenses, and configuring some of the default settings on the LogWare III 
Options dialog.

Assign this user account to a group using the Group drop-down list. By assigning a user ac-
count to a group, you are giving that user account permission to access various features and 
perform certain tasks in LogWare. For more detailed information on groups and permissions, 
refer to Section 2.2.2, User Groups and Permissions. If the user is assigned to the Custom 
group, select the permissions that this user should have from the Permissions list. Otherwise, 
the Permissions list indicates the permissions for users that belong to the selected user group.

Note: Whenever possible, assign user accounts to one of the pre-defined groups. Only 
select the Custom group if the purpose for the user account does not fit one of the pre-
defined group’s permissions.

2.2.4	 Setting and Changing Account Passwords
Each user account may have an associated password. Passwords are set when a user logs in for 
the first time on new accounts. Passwords may also be changed by an administrator at any time. 
Optionally, one or more user accounts can be configured to not require a password as long as 
the user account belongs to either the Guest or Restricted user groups.
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Note: Do not forget your passwords! Administrators can change or reset user account 
passwords, but they cannot recover passwords. If necessary, write the passwords down 
and keep them in a secure location.

 To set the password for a new user account… 

1.	 Run LogWare and login using an administrator account.

2.	 Select the Manage User Accounts option from the Tools menu. The Manage User 
Accounts dialog is displayed.

3.	 Create the new user account. Make sure the Require password checkbox is checked.

4.	 Click OK to close the Manage User Accounts dialog and create the user account.

When the user attempts to login the first time using the new user account, the user should enter 
the user name for the account, leave the Password field blank, and click OK. The Change Pass-
word dialog will be displayed. 

 To force the user to change the password for their user account… 

1.	 Run LogWare and login using an administrator account.

2.	 Select the Manage User Accounts option from the Tools menu. The Manage User 
Accounts dialog is displayed.

3.	 In the Users list, select the account and click the Settings button. The User Account 
Settings dialog is displayed.

4.	 Check the Change password on next login option. Click OK to close the User Account 
Settings dialog.

5.	 Click OK to close the Manage User Accounts dialog.

When the user attempts to login using the user name and current password, the Change Pass-
word dialog will be displayed. 

 To reset the password for an existing user account… 

1.	 Run LogWare and login using an administrator account.

2.	 Select the Manage User Accounts option from the Tools menu. The Manage User 
Accounts dialog is displayed.

3.	 In the Users list, select the account.

4.	 Click the Reset Password button.

5.	 The Change Password dialog is displayed. Enter the new password in the New password 
and Confirm password fields and click OK. The password is now set.

6.	 Click OK to close the Manage User Accounts dialog.

 To create a new user account without a password… 

1.	 Run LogWare and login using an administrator account.

2.	 Select the Manage User Accounts option from the Tools menu. The Manage User 
Accounts dialog is displayed.

3.	 Create a new user account.

On the User Account tab, make sure the Require password option is unchecked.a.



9936A LogWare III
Users Guide

44

On the Permissions tab, assign the user account to either the Guest, Restricted, or 
Custom user group. If assigned to the Custom user group, check the Auto-Login 
permission in the Permissions list. 

4.	 Click OK to close the Manage User Accounts dialog.

When the user attempts to login, the user should enter the user name for the account and leave 
the Password field blank. 

Info: Once a password has been assigned to an account, it is not possible to remove the 
password from that account. The password may be changed, but it cannot be removed. 
You must create a new account without a password.

2.3	 LogWare User Login
The LogWare User Login dialog allows the user to login to LogWare.

Figure 15 LogWare User Login dialog

In order to use LogWare, you must first login. The LogWare User Login dialog is displayed 
when LogWare runs unless LogWare is configured to automatically login. 

User accounts must be created and managed by an administrator before users can login. Log-
Ware provides a built-in administrator account that can be used to create new user accounts.

Once user accounts have been created, you can enter the user name and password on this dialog 
to start using LogWare.

Enter the user name in the User name field. User names are not case-sensitive. Enter the 
password for this account in the Password field. Passwords are case-sensitive. For new user ac-

b.
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counts that have not been assigned a password, leave the Password field blank. If required, the 
Change Password dialog will be displayed to allow a new password to be associated with this 
user account.

In order to successfully login to LogWare, there must be a valid license available. Each login re-
quires and uses one license. In a multi-user environment, if all licenses are currently being used, 
the login will not succeed and a message will be displayed indicating no licenses are available. 
Additional licenses may be purchased and applied to the system by an administrator.

2.3.1	 Change Password
The Change Password dialog is used to set or change the password associated with a user ac-
count. This dialog is displayed when logging in using a new user account for the first time or 
when the administrator has forced the password for a user account to be changed on next login.

Figure 16 Change Password dialog

For existing user accounts, the Current password field is displayed. The current password is au-
tomatically filled in with the password entered on the LogWare User Login dialog. Otherwise, 
this field is not displayed.

To set or change the account password, enter the new password in the New password field. 
Then, enter the password again in the Confirm password field. 
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2.4	 Automatic Logins

Note: There are some limitations to using the automatic login feature. Be sure you fully 
understand the feature and its proper use before implementing it.

LogWare may be configured to automatically login on startup. This feature can be very useful 
for:

Automatically resuming real-time log sessions after a power failure without user 
interaction

Setting up a generic user account for people who need read-only access to LogWare’s 
data

Bypassing LogWare’s security features for applications where security of the data is not 
as important

Automatic login is restricted to user accounts that do not have a password associated with them. 
In order to setup a user account without a password, the user account must be assigned to either 
the Guest, Restricted, or Custom user group. User accounts that are assigned to the Typical 
and Administrator user groups always require a password and cannot be used for automatic 
login. 

Note: When assigning a user account to the Custom user group, be sure to only grant 
permissions for the necessary features of LogWare for this user account. When possible, 
always assign user accounts to one of the pre-defined user groups.

 To configure LogWare to automatically login on startup… 

1.	 Run LogWare and login using an administrator account.

2.	 Create a new user account that does not require a password. 

3.	 Select the Options option in the Tools menu to display the LogWare III Options 
dialog.  Select the General tab.

4.	 Check the Enable auto-login using non-password protected account checkbox. 
This option will be disabled if you are not currently logged into LogWare using an 
administrator account.

5.	 Using the drop-down list, select the account created above. Only user accounts that 
are assigned to the Guest or Restricted groups and accounts that have the Auto-login 
permission selected will appear in the list.

6.	 Click OK to close the LogWare III Options dialog.

7.	 Close LogWare.

8.	 Run LogWare. LogWare should automatically login using the selected user account 
(the LogWare User Login dialog should not be displayed) and the status bar at the bottom 
of the LogWare window should indicate the appropriate user name.

●

●

●

1.

2.

3.

4.

5.

6.

7.

8.
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3	 LogWare III Options
 The LogWare III Options dialog allows various default settings to be selected. This dialog is 

displayed by selecting the Options option from the Tools menu.

The settings are divided into four tabs: General, Real-Time, Graph, and Misc. The settings on 
each of these tabs are described in the following sections.

Some default settings are protected, and can only be changed when logged in using an adminis-
trator user account. Each of these settings is indicated with the proper symbol.

3.1	 General tab
The General tab includes some of LogWare’s basic default settings.

Figure 17 LogWare III Options dialog

The Show Log Session Settings dialog checkbox determines whether LogWare should automati-
cally display the Real-Time Log Session Settings dialog every time LogWare starts up. This 
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setting can be used on client computers where real-time log sessions are frequently configured 
manually. This setting should be unchecked on client computers that are used only to remotely 
monitor log sessions and/or view logged data.

The Automatically start log session(s) upon login checkbox determines whether LogWare 
should automatically open the specified real-time log session settings file(s) every time Log-
Ware starts up. This setting is useful when setting up a client computer to automatically login 
to LogWare and run real-time log sessions. LogWare does not limit the number of real-time log 
session settings files you can specify. 

Info: When the Automatically start log session(s) upon login checkbox is checked, 
LogWare expects that the logger(s) corresponding to each settings file is running and 
accessible so that it can communicate with the logger. 

To add a log session configuration file to the list, click the Add button. Navigate to locate the 
log session settings file to add to the list. You may select multiple files by holding down the 
CTRL or SHIFT key when clicking on the filenames.

To remove a log session configuration file from the list, select the file and click the Remove but-
ton. To remove all log session configuration files, click the Remove All button.

 The Enable auto-login using non-password protected account checkbox determines whether 
the auto-login feature of LogWare is enabled. If checked, LogWare attempts to login automati-
cally using the user account selected in the drop-down list. Select the user account to use for 
auto-login using the drop-down list. Note that there are some very specific limitations and 
requirements regarding the configuration and use of this feature. Be sure you understand these 
before enabling this feature. Refer to Section 2.4, Automatic Logins, for more information.

The E-mail Options section provides access to the e-mail settings in LogWare. Click the E-mail 
Options button to enable LogWare’s e-mail features and configure recipients, groups, and enve-
lopes. Click the Event Options button to configure LogWare’s default event settings for send-
ing e-mail messages. Refer to Section 4, E-mail Features, for more information on LogWare’s 
e-mail features.
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3.2	 Real-Time tab
The Real-Time tab displays options that are applicable to performing real-time log sessions. 
Some of these settings also apply to remote monitoring sessions, as indicated.

Figure 18 LogWare III Options dialog- Real-Time tab

Note: Changing these settings only affects real-time log sessions started after closing the 
LogWare III Options dialog, unless otherwise indicated. 

The Plot temperature and humidity readings on same graph checkbox determines whether 
separate graphs are created in the Real-Time Log Session window for temperature and humidity 
readings, or whether temperature and humidity readings are plotted on the same graph. When 
plotting temperature and humidity readings on the same graph, temperature readings use the 
left y-axis and humidity readings use the right y-axis of the graph.

The Show alarm settings in statistics window checkbox determines whether the sensor alarm 
settings should be included in the Real-Time Log Session window’s statistics list. This setting 
also applies to remote monitoring sessions.

The Prompt to manually synchronize log session checkbox determines whether LogWare 
displays a message that the user must respond to before starting a real-time log session. This 
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feature may be useful when you are trying to synchronize LogWare’s real-time log session with 
some other external process. If configuring LogWare to automatically login and start real-time 
log sessions, do not enable the manual syncronization feature.

Note: Do not use the Prompt to manually synchronize log session option in conjunction 
with the delayed start date/time option when setting up a real-time log session! 
Otherwise, your log session may not start as expected! LogWare checks for this conflict 
before starting a real-time log session.

The Sample all sensors simultaneously checkbox determines whether LogWare should attempt 
to query readings from all enabled sensors at the same time, or whether readings should be 
taken from each sensor sequentially. If this checkbox is checked, the Interval between scan 
sequences settings on the Session tab of the Real-Time Log Session Settings dialog are not 
displayed.

The Query logger’s status registers checkbox determines whether LogWare should query the 
status of each enabled sensor on the logger prior to querying measurements. This setting is 
critical and must be checked in order for LogWare to generate e-mail messages related to sensor 
calibration due notifications, sensor hot-swapping, and other sensor related information. It is 
recommended that this setting always be checked.

The Sync logger date/time when starting log session checkbox determines whether LogWare 
sends commands to the logger when starting a real-time log session to synchronize it’s system 
date and time to the client computer’s date and time.

Note: When using the Sync logger date/time when starting log session feature, the Enter 
Password prompt will be displayed when starting a real-time log session if the TIME 
settings in the logger are password protected. If this setting is being used in conjunction 
with the automatic login feature to automatically start a real-time log session when 
LogWare is opened, it is recommended that the password protection for TIME is turned 
off in the logger, or the Never attempt to update password protected settings option should 
be checked.

The Stamp readings with logger’s date/time (instead of computer’s) checkbox determines 
whether LogWare uses the client computer’s date and time or the logger’s system date and time 
to stamp all readings taken during a real-time log session. 

Note: When using the Stamp readings with logger’s date/time (instead of computer’s) 
feature, a caution message is displayed if the Sync logger date/time when starting log 
session option is not enabled. It is recommended to sync the logger to the client computer 
when starting a real-time log session if you are using the logger’s system date/time to 
stamp the readings.

The Enable daily statistics (reset statistics at midnight) checkbox determines whether LogWare 
should automatically reset each sensor’s statistical calculations each day (at midnight) during a 
log session. If unchecked, LogWare’s statistical calculations will reflect the statistics for all data 
logged since the log session started. Statistical calculations can be reset manually at any time 
during a log session. Changing this setting affects all currently running real-time log sessions as 
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well as all real-time log sessions that are started after this setting is changed. This setting also 
applies to remote monitoring sessions.

 The Enable sensor calibration due notifications checkbox determines whether LogWare 
will check the sensor’s calibration due date during a real-time log session. If checked, LogWare 
displays a calibration due message in the Notes field for the sensor on the Real-Time Log Ses-
sion window and may also generate a calibration due e-mail message if the e-mail features are 
enabled and configured. Leave this setting unchecked if LogWare should ignore the calibration 
due date of a sensor. Changing this setting affects all currently running real-time log sessions as 
well as all real-time log sessions that are started after this setting is changed. 

 The Enable Observation mode (do not record log session readings) checkbox determines 
whether LogWare should run real-time log sessions in Observation mode. In Observation mode, 
LogWare does not record any of the readings acquired during a real-time log session. Readings 
are displayed in the Real-Time Log Session window, but no remote monitoring can be done on 
this log session, and there will be no historical data to query. Also, LogWare does not set the 
alarms, sensor ID (location), temperature scale, or resolutions of the logger. This feature can 
be useful if you need to view the data from a logger in real-time but the real-time data does 
not need to be kept or recorded, such as if you want to use the download or import features to 
record historical data. This feature can also be enabled if LogWare is only being used to acquire 
ambient conditions data for MET/CAL. 

Warning: Be careful when using LogWare in Observation mode that you do not need to 
retain the real-time data! This mode should only be used in specific circumstances. A 
warning message is displayed when closing the LogWare III Options dialog if 
Observation mode is enabled. Also, indicators are displayed on the Real-Time Log 
Session Settings dialog and in the Real-Time Log Session window when Observation 
mode is enabled.

The Never attempt to update password protected settings checkbox determines whether Log-
Ware should prompt the user to enter the logger’s password when starting a real-time log ses-
sion if any password protected setting needs to be updated. Password protected settings include 
the logger’s date/time, sensor alarms and sensor ID settings, and the calibration alert setting. If 
this checkbox is checked, LogWare will not synchronize any password protected logger settings 
with the settings used in LogWare. 

Warning: By checking the Never attempt to update password protected settings checkbox, 
you may encounter inconsistencies in data logged in real-time by LogWare and data 
downloaded or imported into LogWare from the logger’s memory. Unless it is absolutely 
necessary, it is recommended to leave this checkbox unchecked. LogWare will never 
prompt to enter a password when automatically starting a log session.

The Logging interval settings indicate the default interval settings to use when creating a new 
real-time log session. The logging interval can be changed when configuring a real-time log 
session using the Logging interval settings on the Session tab of the Real-Time Log Session Set-
tings dialog.

The Reading resolutions settings determine the number of decimal places to use when logging 
temperature and humidity readings. LogWare sends commands to the logger to configure it to 
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use these settings when a real-time log session starts. Select the number of digits to use for tem-
perature readings using the Temperature field and humidity readings using the Humidity field.

The Graph settings X-axis range setting determines the amount of time that is displayed on 
the x-axis of the graph(s) in the Real-Time Log Session window. Select the amount of time to 
display using the drop-down list. 

3.3	 Graph tab
The Graph tab displays options and settings related to real-time log session graphs and logged 
data graphs.

Figure 19 LogWare III Options dialog - Graph tab

Note: Changing these settings only affects graphs that are created and displayed after 
closing the LogWare III Options dialog, unless otherwise indicated.

The Temperature graph settings indicate settings that are used for graphs that are plotting tem-
perature readings only, as in the example below:
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Figure 20 Separate temperature graph

The Humidity graph settings indicate settings that are used for graphs that are plotting humidity 
readings only, as in the example below: 

Figure 21 Separate humidity graph

The Title and Y-axis title fields determine the default text that is displayed on the graphs. The 
title is displayed at the very top of the graph. The y-axis title is displayed on the left y-axis of 
the graph.

The Combined graph title field determines the text that is displayed as the title of graphs that 
plot both temperature and humidity readings, as in the example below:
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Figure 22 Combined temperature and humidity graphs

When both temperature and humidity readings are being plotted on the same graph, the left 
y-axis title uses the Y-axis title field below the Temperature graph heading and the right y-axis 
title uses the Y-axis title field below the Humidity graph heading.

The X-axis title (both graphs) field determines the text that is displayed below the x-axis of all 
graphs.

The X-axis time format setting determines the format for the date and time labels on the x-axis 
of all graphs. Select the desired option using the drop-down list. The graph automatically deter-
mines the exact labels that are used on the x-axis, depending on the time duration displayed on 
the axis. This setting is used by the graphs as an indication of preference.

The Subtitle options settings determine what information is displayed in the subtitle of all 
graphs. Any combination of options may be checked. For real-time log session graphs that 
display information for two sensors, the information for each sensor is separated by a slash “/” 
with the information for the sensor on channel one indicated first. Models and serial numbers 
for sensors and/or loggers are separated with a dash “-“.

Info: When viewing logged data, it may not be feasible to include logger and sensor and 
location information on the graph. For example, when querying data for a specific 
location, the location information will be included in the subtitle, but it is possible, even 
likely, that the sensor and/or logger used to log that data may have changed at some point 
over the selected date/time range. The applicable information should always be included 
in the graph subtitles.

 The Enable customization dialog checkbox determines whether the graph customization 
dialog option is displayed in the popup menu when right-clicking on a graph. Any graph set-
tings changed when using the graph customization dialog apply to the selected graph only. This 
feature is a built-in dialog of the graphing package used by LogWare and access is allowed for 
convenience only. LogWare does not support saving any settings configured on the customiza-
tion dialog.
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The Color options list indicates the default colors that are used for various items on all graphs. 
To change the default color for an item, select the item in the list and click the  (Color) icon 
to display the Color dialog. The default color for the following graph items may be defined:

Selected data point – This item refers to the currently selected data point and applies 
only to graphs in a Logged Data window. A vertical line is drawn on the graph in the 
selected color to indicate where the currently selected data point lies with respect to the 
entire data set.

Data point annotation – This item refers to annotations that have been manually or 
automatically linked to a data point and applies only to graphs in a Logged Data window. 
A vertical line is drawn on the graph in the selected color to indicate data points that have 
an annotation associated with them. 

Sensor 1 temperature trace – This item refers to the default color of the temperature 
trace for the sensor on channel 1 of the logger. This setting applies to all graphs. 

Sensor 1 humidity trace – This item refers to the default color of the humidity trace for 
the sensor on channel 1 of the logger. This setting applies to all graphs.

Sensor 2 temperature trace – This item refers to the default color of the temperature 
trace for the sensor on channel 2 of the logger. This setting applies to all graphs.

Sensor 2 humidity trace – This item refers to the default color of the humidity trace for 
the sensor on channel 2 of the logger. This setting applies to all graphs.

The Other options section defines default settings to be used when displaying graphs. 

The Show alarms checkbox determines whether horizontal lines are drawn on the graphs indi-
cating the current alarm settings. This setting applies to all graphs.

The Show data points checkbox determines whether a symbol is drawn on the graphs for each 
data point. This setting applies to all graphs.

The Show annotations checkbox determines whether the vertical lines for the selected data 
point and data point annotations are drawn on the graphs. This setting applies to graphs in a 
Logged Data window only. 

The Synchronize graph zooming checkbox determines whether zooming in on a section of a 
temperature graph causes the corresponding humidity graph to zoom in to the same section, or 
vice-versa. This setting is only applicable to graphs located in the same window when tempera-
ture and humidity readings are plotted on separate graphs.

●

●

●

●

●

●
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3.4	 Misc tab
The Misc tab displays other miscellaneous options.

Figure 23 LogWare III Options dialog - Misc tab

The Display logger firmware update messages checkbox determines whether LogWare should 
display a firmware update message and send a firmware update e-mail message (if enabled) 
when a real-time log session is configured using a logger with known outdated firmware. This 
feature is intended to advise users when the version of firmware being used in a logger may 
have a known incompatibility with LogWare, and a firmware update may be available. LogWare 
checks the firmware version of a logger every time a real-time log session starts.

 The Automatically remove inactive log sessions from Remote Monitoring dialog check-
box determines whether LogWare should prevent log sessions from appearing on the Remote 
Monitoring Options dialog if the log session has been inactive for a specific period of time. This 
will prevent users from attempting to remotely monitor a log session that has not been able to 
acquire new readings for a period of time. If a log session is able to resume activity after being 
removed from the list, the log session will automatically be re-added to the list of available log 
sessions. If this option is checked, use the drop-down list to select the time interval to use.
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Note: If LogWare is being used in a client/server configuration, this feature should only 
be enabled on one client computer. The effect of removing an inactive log session from 
appearing on the Remote Monitoring Options dialog is system-wide.

The Data server name and Data server port fields indicates the name of the server where Log-
Ware’s data is being stored and the port that is being used to communicate with the server. For a 
client/server configuration, the data server name is the name of the computer that LogWare was 
installed from. For a stand-alone configuration, this should always be “LOCALHOST”. These 
settings are for informational purposes only and cannot be changed.

The MET/CAL interface options settings allow LogWare to be configured to write data acquired 
during real-time log sessions to a file that can be read by Fluke’s MET/CAL software when 
performing calibrations. This feature of LogWare can be used in place of the RHT application 
that comes with MET/CAL for recording ambient conditions during tests. 

To use this feature, check the Write real-time log session readings to .INI file checkbox, and 
specify the location of the RHT.INI file by clicking the “…” (Browse) button to display the 
Browse for Folder dialog. By default, LogWare writes the acquired data to a section of this file 
identified by the serial number of the sensor that the data was acquired from. If you want Log-
Ware to use the serial number of the logger instead of the sensor, check the Use logger’s serial 
number as section name checkbox. 

Note: In order for MET/CAL to be able to see and use the data in the RHT.INI file, this 
file MUST be located in the shared MET/CAL folder. Refer to the MET/CAL product 
documentation for more information on the required location of this file.





59

4 E-mail Features

4	 E-mail Features
LogWare includes e-mail features that allow notifications for various events to be sent to e-mail 
accounts, cell phones, PDAs, etc. LogWare allows you to define who should receive e-mail 
messages when specific events occur. 

The following e-mail related terms are used by LogWare. Before setting up LogWare’s e-mail 
features, you should be familiar with and understand the meaning of these terms.

Table 5 E-mail glossary

Term Description
SMTP Mail Server SMTP stands for Simple Mail Transfer Protocol. This is the standard TCP/IP protocol for 

transferring e-mail messages. A SMTP mail server is a computer that runs e-mail server 
softWare. To use LogWare’s e-mail features, you must be able to access a SMTP mail 
server. A typical SMTP mail server name may look like: mailhost.mydomain.com. Consult 
your system or network administrator to determine the name of the SMTP mail server for 
your company.

Sender Address This is the e-mail address that appears as the ‘From’ address when LogWare sends e-mail 
messages. The sender address must follow the valid e-mail address format (i.e. name@
domain.com).

Envelope An envelope is the container for e-mail messages. LogWare events that generate an -mail 
message are assigned to an envelope. The envelope determines who receives the e-mail 
message. Each envelope can be addressed to one or more ‘To’ groups, ‘CC’ groups, and/or 
‘BCC’ groups. 

Event An event is an occurrence in LogWare that generates an e-mail message. Each event 
in LogWare can be linked to an envelope, which is used as a “container” for the e-mail 
message.

Group A group consists of a collection of e-mail recipients. Typically, all members of a group 
belong to the same team or perform similar job functions. When an e-mail message is sent 
to a group, all members of that group will receive a copy of the message. Note: E-mail 
groups are separate and independent of LogWare’s user account groups, which 
define permissions to use certain features of LogWare!

Recipient A recipient is an individual who needs to receive e-mail messages. Each recipient may 
have a single e-mail address. One recipient should be created for each e-mail address that 
e-mail messages should be sent to. In order to receive e-mail messages, a recipient must 
be assigned to one or more groups. 

‘To’ Group The ‘To’ group identifies the primary recipients of e-mail messages. 
‘CC’ Group The ‘CC’ group identifies public secondary (carbon copy) recipients of e-mail messages.
‘BCC’ Group The ‘BCC’ group identifies private secondary (blind carbon copy) recipients of e-mail 

messages.
Messaging style The messaging style setting indicates the type of e-mail message a recipient should 

receive. LogWare supports Short, Standard, and Verbose e-mail messages. Short 
messages are intended for cell phones and PDAs where e-mail messages are limited 
to a specific number of characters. Standard messages are what most recipients should 
receive. Verbose messages are intended for supervisors, managers, and administrators 
and include additional information regarding the condition or state that caused the e-mail 
message to be sent. This information may be used for troubleshooting. 

LogWare’s e-mail settings can be accessed from the LogWare III Options dialog. To display this 
dialog, select the Options option from the Tools menu.

Note: For client/server, multi-user configurations, LogWare’s e-mail settings are system 
wide and apply to all clients. Enabling or disabling the e-mail features on one client 
computer enables or disables the e-mail features on all client computers. Access to 
changing e-mail settings can be granted or denied to each LogWare user by setting up the 
appropriate permissions. By default, only users assigned to the Typical or Administrator 
user groups can change e-mail settings.
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 Setup SMTP Mail Server 
In order to use LogWare’s e-mail features, you must setup a link to a Simple Mail Transfer 
Protocol (SMTP) mail server. If you do not know if you have access to a SMTP mail server, 
consult your system or network administrator.

 Setup E-mail Recipients 
After setting up the SMTP mail server, you need to identify the potential recipients of Log-
Ware’s e-mail messages. In a typical application, these recipients may include…

Operators and technicians in areas where LogWare is monitoring environmental 
conditions

Quality control/assurance personnel responsible to ensure environmental conditions stay 
within specifications

Facilities managers who are responsible for monitoring and adjusting environmental 
controls

Managers and supervisors who have responsibility for maintaining test equipment

Calibration laboratory personnel in charge of performing equipment calibrations

You need to create one e-mail recipient for each e-mail address to which messages should be 
sent. If a person wants to have a message sent to their work e-mail account, their home e-mail 
account, and their cell phone, you must create three separate recipients for that person. 

 Setup E-mail Groups 
After the e-mail recipients have been setup, you need to categorize the recipients into groups. 
Groups can be used to identify personnel that work together in the same area or who perform 
similar job functions. You may want to consider creating groups for…

Operators and technicians of each area being monitored

Quality control/assurance personnel

Calibration laboratory personnel

Managers and supervisors of teams

Team leaders

You need to create an e-mail group for each identified group of recipients and include all ap-
propriate recipients in the group. Each e-mail recipient can be included in as many groups as 
necessary. 

 Setup E-mail Envelopes 
After the e-mail recipients and groups have been setup, you need to create e-mail envelopes that 
e-mail messages can be placed into. Envelopes are the containers for e-mail messages. Each 
envelope needs to be addressed to the group or groups to which e-mail messages should be sent. 
When an event happens, LogWare generates the content of the e-mail message associated with 
that event. The message content is then placed in an envelope and sent to the members of the 
group(s) that the envelope is addressed to. 

●

●

●

●

●
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●

●
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How you define the envelopes and the groups assigned to each envelope is up to you. You may 
want to consider creating envelopes for…

Operators and technicians of each area being monitored

Quality control/assurance personnel

Calibration laboratory personnel

Managers and supervisors of teams

Team leaders

 Setup Default LogWare Events 
Once the e-mail setup is complete, LogWare’s events may be linked to e-mail envelopes. This 
is how LogWare knows who the recipients are for e-mail messages generated by these events. 
These settings will be used as the default settings when setting up a new real-time log session 
or remote monitoring session. The events associated with each real-time log session and remote 
monitoring session are independent of all other session’s events and can be customized when 
setting up a session or on-the-fly while the session is running.

Note: In a client/server multi-user configuration, whereas LogWare’s e-mail recipient, 
group, and envelope settings are system-wide and apply to all client computers, e-mail 
event settings are “per client”. Each LogWare client computer can and must be 
configured independently of other LogWare client computers.

LogWare generates e-mail messages for events related to the LogWare application itself, for 
real-time log sessions, remote monitoring sessions, and logger and sensor events. These events 
include…

User login/logout

Real-time log session state (started, stopped, aborted, etc.)

Logger state (power failure, low battery, etc.)

Sensor state (sensor attached or detached, locked, etc.)

Sensor calibration due

Temperature and humidity alarm conditions

This structure allows for a very flexible e-mail system. LogWare can be configured as simple or 
as elaborate as you wish. In a very simplistic approach, you could setup all recipients to receive 
all e-mail messages by doing the following…

Create one recipient for each person or unique e-mail address

Create one group and assign all recipients to that group

Create one envelope and assign the group as the ‘To’ group for the envelope

Link all default LogWare events to the envelope

In a more flexible approach, you could configure LogWare to send e-mail messages to a differ-
ent recipient for each event by doing the following…

Create one recipient for each person or unique e-mail address

Create one group for each recipient and assign only one recipient to that group

●
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Create one envelope for each event, or create one envelope for each event for each log 
session, and assign the appropriate group(s) to the envelope

Customize the link for each log session’s events to a different envelope when setting up 
the log session

Of course, it makes sense to find some middle ground between these two scenarios that best 
suits your needs.

4.1	 Setting up E-mail SMTP Server
 LogWare includes e-mail features that allow notifications for various events to be sent to e-

mail accounts, cell phones, PDAs, etc. LogWare allows you to define who should receive e-mail 
messages when specific events occur. 

LogWare’s e-mail settings can be accessed from the LogWare III Options dialog. To display 
this dialog, select the Options option from the Tools menu. On the LogWare III Options dialog, 
select the General tab and click the E-mail Options button to display the SMTP E-Mail Settings 
dialog.

Note: For client/server, multi-user configurations, LogWare’s e-mail settings are system 
wide and apply to all clients. Enabling or disabling the e-mail features on one client 
computer enables or disables the e-mail features on all client computers. However, the 
events can be customized on each client computer independently of all other client 
computers. Access to changing e-mail settings can be granted or denied to each LogWare 
user by setting up the appropriate permissions. By default, only users assigned to the 
Typical or Administrator user groups can change e-mail settings.

Figure 24 SMTP E-Mail Settings dialog

●

●
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To enable LogWare’s e-mail features, select the General tab and check the Enable e-mail fea-
tures checkbox. All other controls on this tab are disabled until this checkbox is checked.

Enter the name of the Simple Mail Transfer Protocol (SMTP) mail server to use in the SMTP 
mail server field. If you do not know if you have access to a SMTP mail server, consult your 
system or network administrator. If you have one, they should be able to provide you with the 
name of the SMTP mail server.

To test the SMTP mail server link, enter your e-mail address in the Sender address field and 
click the Send Test E-Mail Message button. This will generate a test e-mail message and send it 
to the sender address specified. Check your e-mail inbox to ensure you receive the test message. 
You may need to allow a few minutes to receive the message. If you do not receive the message, 
check the SMTP mail server name to ensure it was entered properly.

After successfully testing the mail server, you may want to change the Sender address field 
to an address that allows e-mail recipients to easily identify the source of the e-mail messages 
LogWare generates. This e-mail address does not have to be a valid e-mail address, but it does 
have to follow the format of a valid e-mail address (for example, name@domain.com). If you 
want users to be able to reply to LogWare’s e-mail messages, you need to use a valid e-mail ad-
dress. Your system or network administrator may be able to create an e-mail account for you to 
use, or you can use your own e-mail address.

Note: LogWare does not recognize or receive replies to e-mail messages it generates. It is 
a one-way (outbound) e-mail messaging system.

If you want LogWare to keep a log of all e-mail activity, check the Log e-mail activity to file 
checkbox and enter the path and filename of the file to use to log activity information. You 
can click the … (Browse) button to browse for the folder where the file should be located. For 
client/server, multi-user configurations, the activity log file should be located on the server and 
this field should already be filled in. There should be no need to change it. However, if you 
decide change it, it is recommended that the activity log file be located on the server. The path 
to the log file should be in UNC (Universal Naming Convention) format to allow all client com-
puters to be able to access it (for example, \\<SERVERNAME>\<sharename>\<foldername>\
<filename>.log).

4.2	 Setting up E-mail Recipients
LogWare’s e-mail features require the identification of those persons who should receive e-mail 
messages (recipients) generated by LogWare for specific events. This identifies the e-mail ad-
dress and name of the recipient as well as indicating the type of message that should be sent.
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Figure 25 SMTP E-Mail Settings dialog - Reciepients tab

To setup recipients, select the Recipients tab. By default, the Recipients list is empty. To setup 
a new recipient, change the settings for an existing recipient, or remove recipients, follow the 
instructions below.

 To setup a new recipient… 
Click the New button to display the Recipient Settings dialog.

Fill in the information on this dialog.

Click OK to close the dialog. The new recipient should appear in the Recipients list.

 To change the settings for an existing recipient… 
In the Recipients list, select the recipient to change.

Click the Settings button to display the Recipient Settings dialog.

Edit the information on this dialog.

Click OK to close the dialog. Updates to the recipient’s e-mail address or name should be 
reflected in the Recipients list. 

 To remove an existing recipient… 
In the Recipients list, select the recipient to remove.

Click the Remove button. 

A prompt is displayed to confirm removing the recipient. Click Yes to confirm. The 
recipient should be removed from the Recipients list.

1.

2.

3.

1.

2.

3.

4.
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 To remove all existing recipients… 
Click the Remove All button. 

A prompt is displayed to confirm removing all recipients. Click Yes to confirm. All 
recipients should be removed from the Recipients list.

4.2.1	 Recipient Settings
 The Recipient Settings dialog allows e-mail message recipients to be created and changed. 

To display this dialog, select the New or Settings button on the Recipients tab of the SMTP E-
Mail Settings dialog. 

Figure 26 Recipient Settings dialog

On the General tab, enter the e-mail address for the recipient in the E-mail address field. The 
e-mail address is required. A recipient may have one and only one e-mail address. If you need 
LogWare to send e-mail messages to more than one e-mail address for one person (for example, 
work e-mail address, home/personal e-mail address, cell phone e-mail address, etc.), you need 
to setup a separate recipient for each unique e-mail address.

Enter the user’s first and last names in the First name and Last name fields respectively. This 
information is optional and may be omitted. If you are setting up multiple recipients for one 
person, you can use these fields to identify the e-mail address type for this recipient. For exam-
ple, if you are setting up a recipient for John Smith’s cell phone e-mail address, you may want 
to set the First name field to ”John (cell)” and the Last name field to “Smith”. When assigning 
recipients to groups, the name will appear in the Recipients list as “Smith, John (cell)”.

Select the style of message LogWare should send to this address using the Messaging style 
drop-down list. The exact content of the e-mail message generated and sent by LogWare to this 
recipient depends on this selection. The choices for this setting are as follows:

1.

2.
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Short message – Use this style for cell phone, PDA, or other text messaging devices that 
are limited in the number of characters they can receive or display. LogWare includes 
only essential information about the event in the e-mail message such as a very short 
description, models and serial numbers, location information, and a date/time stamp.

Standard message – This is the default setting. Use this style for typical recipients. 
LogWare includes basic information about the event such as a description, models and 
serial numbers, location information, and other available information about the event. 
These messages are formatted for optimal viewing in an e-mail client application such as 
Microsoft® Outlook.

Verbose message - Use this style for LogWare administrators or others who are 
responsible for maintaining the system. LogWare includes the same information as is 
found in the standard message plus additional information that may help troubleshoot 
and resolve issues. These messages are formatted for optimal viewing in an e-mail client 
application such as Microsoft® Outlook.

4.3	 Setting up E-mail Groups
LogWare’s e-mail features require recipients to be included in groups. A recipient may be in-
cluded in as many groups as necessary. 

Figure 27 SMTP E-Mail Settings dialog - Groups tab

To setup groups, select the Groups tab. By default, the Groups list is empty. To setup a new 
group, change the settings for an existing group, or remove groups, follow the instructions 
below.

●

●

●
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 To setup a new group… 
Click the New button to display the Group Settings dialog.

Fill in the information on this dialog.

Select the recipients who belong to this group.

Click OK to close the dialog. The new group should appear in the Groups list.

 To change the settings for an existing group… 
In the Groups list, select the group to change.

Click the Settings button to display the Group Settings dialog.

Edit the information on this dialog.

Add or remove recipients from the group.

Click OK to close the dialog. Updates to the group’s name or description should be 
reflected in the Groups list. 

 To remove an existing group… 
In the Groups list, select the group to remove.

Click the Remove button. 

A prompt is displayed to confirm removing the group. Click Yes to confirm. The group 
should be removed from the Groups list.

 To remove all existing groups… 
Click the Remove All button. 

A prompt is displayed to confirm removing all groups. Click Yes to confirm. All groups 
should be removed from the Groups list.

4.3.1	 Group Settings
 The Group Settings dialog allows recipients that should all receive the same e-mail mes-

sages to be assigned to a group. To display this dialog, select the New or Settings button on the 
Groups tab of the SMTP E-Mail Settings dialog. 

For help on determining how to group e-mail recipients, refer to Section 4, E-mail Features.

Before setting up e-mail groups, you should first setup e-mail recipients. In order to receive e-
mail messages, a recipient must be included in one or more groups.
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Figure 28 Group Settings dialog

On the General tab, enter the name of the group in the Group name field. The group name is re-
quired. Typically, the group name should indicate the included recipients, such as “Calibration 
Laboratory Personnel” or “Managers”. However, LogWare allows you to name groups however 
you want.

Enter a description for this group in the Description field. The description is optional but can be 
used to indicate the recipients included in this group or any other information about the group.

To select the recipients for this group, select the Recipients tab. A list of all e-mail recipients is 
displayed.
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Figure 29 Group Settings dialog - Recipients tab

Select the recipients for this group by checking the checkbox next to the appropriate recipients. 
To remove a recipient from the group, uncheck the checkbox for that recipient.

To add all recipients to this group, click the Select All button. The checkbox will be checked for 
all recipients.

To remove all recipients from this group, click the Unselect All button. The checkbox will be 
unchecked for all recipients.

4.4	 Setting up E-mail Envelopes
LogWare’s e-mail features require envelopes to be addressed to one or more groups. An en-
velope is used as the “container” for e-mail messages and isused to send the e-mail message 
generated by an event to the proper group(s) of recipients. An envelope may be addressed to be 
sent to as many groups as necessary.
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Figure 30 SMTP E-mail Settings dialog - Envelopes tab

To setup envelopes, select the Envelopes tab. By default, the Envelopes list is empty. To setup 
a new envelope, change the settings for an existing envelope, or remove envelopes, follow the 
instructions below.

 To setup a new envelope… 
Click the New button to display the Envelope Settings dialog.

Fill in the information on this dialog.

Select the primary groups (‘To’) to receive the e-mail messages that use this envelope.

Select the groups to receive a carbon-copy (‘CC’) of the e-mail messages that use this 
envelope.

Select the groups to receive a blind-carbon-copy (‘BCC’) of the e-mail messages that 
usethis envelope.

Click OK to close the dialog. The new envelope should appear in the Envelopes list.

 To change the settings for an existing envelope… 
In the Envelopes list, select the envelope to change.

Click the Settings button to display the Envelope Settings dialog.

Edit the information on this dialog.

Add or remove ‘To’, ‘CC’, or ‘BCC’ groups from the envelope.

Click OK to close the dialog. Updates to the envelope’s name or description should be 
reflected in the Envelopes list. 
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 To remove an existing envelope… 
In the Envelopes list, select the envelope to remove.

Click the Remove button. 

A prompt is displayed to confirm removing the envelope. Click Yes to confirm. The 
envelope should be removed from the Envelopes list.

 To remove all existing envelopes… 
Click the Remove All button. 

A prompt is displayed to confirm removing all envelopes. Click Yes to confirm. All 
envelopes should be removed from the Envelopes list.

4.4.1	 Envelope Settings
 The Envelope Settings dialog allows groups of recipients to be selected for receiving e-mail 

messages. To display this dialog, select the New or Settings button on the Envelopes tab of the 
SMTP E-Mail Settings dialog. 

For help on determining how to setup envelopes, refer to Section 4, E-mail Features.

Before setting up e-mail envelopes, you should first setup e-mail groups. In order for LogWare 
to successfully send e-mail messages, envelopes must be addressed to one or more groups.

Figure 31 Envelope Settings dialog

On the General tab, select whether this envelope should be allowed to be assigned to LogWare 
events by checking or unchecking the Enable this envelope checkbox. Unchecking this box will 
prevent this envelope from being displayed when assigning envelopes to events.
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Enter the name of the envelope in the Envelope name field. The envelope name is required. 
Typically, the envelope name should indicate either the groups that the envelope is addressed to, 
such as “All Managers and Supervisors” or it should indicate the type of event that is assigned 
to use this envelope to send e-mail messages, such as “Sensor Calibration Due”. However, Log-
Ware allows you to name envelopes however you want.

Enter a description for this envelope in the Description field. The description is optional but can 
be used to indicate the groups this envelope is addressed to, the event(s) this envelope should be 
used for, or any other information about the envelope.

To select the primary group(s) (‘To’) for this envelope, select the ‘To’ Groups tab. A list of all 
e-mail groups is displayed. Check each of the groups that should receive e-mail messages sent 
in this envelope.

Figure 32 Envelope Settings dialog - To Groups tab

To select the group(s) to receive a carbon-copy (‘CC’) of e-mail messages sent in this envelope, 
select the ‘CC’ Groups tab. A list of all e-mail groups is displayed. Check each of the groups 
that should receive a carbon-copy of the e-mail messages sent in this envelope.

To select the group(s) to receive a blind-carbon-copy (‘BCC’) of e-mail messages sent in this 
envelope, select the ‘BCC’ Groups tab. A list of all e-mail groups is displayed. Check each of 
the groups that should receive a blind-carbon-copy of the e-mail messages sent in this envelope.

4.5	 Setting up Default Events
 LogWare’s e-mail features allow various application, log session, logger, and sensor events 

to be linked to an envelope. An envelope is used as the “container” for e-mail messages and 
is used to send the e-mail message generated by an event to the proper group(s) of recipients. 
Each event can be linked to only one envelope.

LogWare’s default event settings can be accessed from the LogWare III Options dialog. To 
display this dialog, select the Options option from the Tools menu. On the LogWare III Options 
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dialog, select the General tab and click the Event Options button to display the Default Event 
Settings dialog.

Note: In a client/server multi-user configuration, whereas LogWare’s e-mail recipient, 
group, and envelope settings are system-wide and apply to all client computers, e-mail 
event settings are “per client”. Each LogWare client computer can and must be 
configured independently of other LogWare client computers.

Figure 33 Default Event Settings dialog

In order for LogWare to be able to send e-mail messages for an event, the event must be linked 
to an envelope. Each of the events supported by LogWare can be linked to one envelope. This 
becomes the default envelope for the event. However, each time a real-time log session or 
remote monitoring log session is started, the user may customize the events for that log session 
only by linking the events to different envelopes. If the user does not customize the event set-
tings, the default settings are used.

To setup the default link for an event to an envelope, select the tab indicating the category of 
event to configure. The events list on the left displays all events associated with the selected tab. 
The E-mail envelopes list on the right displays a list of all enabled envelopes. If a check appears 
next to an envelope, this indicates the currently selected envelope for the highlighted event. 
If an event is not linked to an envelope, no e-mail message will be generated when the event 
occurs.

To select the default envelope to use for an event, select the event in the events list on the left 
and check the box corresponding to the envelope to use in the E-mail envelopes list on the right. 
Repeat this process for other events. 
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To determine the recipients associated with an envelope, or to configure envelopes, groups, and 
recipients, click the Options button to display the SMTP E-Mail Settings dialog. For help on 
determining how to setup envelopes, refer to Section 4, E-mail Features.

To clear (reset) the links for all events on all tabs, click the Clear All button.

LogWare supports the following categories of events.

Application Events 
Application events are events that are not directly related to any given log session, logger, or 
sensor.

Warning Message - The Warning Message event occurs when LogWare needs to notify 
the user of an occurrence of notable importance but was unable to display a message 
on-screen. For example, when automatically starting real-time log sessions, if LogWare 
is unable to synchronize the logger’s clock or change a password protected setting in the 
logger, a Warning Message event occurs.

Application Error - The Application Error event occurs when a critical error occurs in 
LogWare when it is not appropriate to display a message on screen, such as during real-
time log sessions. An e-mail message is generated that contains information about the 
error including the error number, description, and source of the error. This information 
can be helpful when contacting Technical Support for assistance on resolving issues with 
the softWare.

Data Server Error - The Data Server Error event occurs when a critical data server 
error occurs in LogWare. An e-mail message is generated that contains information about 
the error including the description and source. This information can be helpful when 
contacting Technical Support for assistance on resolving issues with the softWare.

User Login/Logout - The User Login/Logout event occurs when a user logs into or out 
of LogWare. An e-mail message is generated that contains user information.

Log Session Events 
Log Session events are events that are directly related to real-time log sessions only.

Log Session State - The Log Session State event occurs when the state of a real-time 
log session changes. A log session state change event is generated when a real-time log 
sessions is started, aborted, or finishes normally, or if a real-time log session fails to start 
automatically. This event also indicates when a real-time log session becomes inactive 
(readings cannot be acquired from the sensor) or becomes active again after a period of 
inactivity. An e-mail message is generated that contains log session state information.

Logger Events 
Logger events are events that are directly related to a logger when a real-time log session is 
running.

Firmware Upgrade - The Firmware Upgrade event occurs when the user configures 
LogWare to use a logger that contains outdated firmware with known incompatibility 
issue with LogWare. An e-mail message is generated that contains information regarding 
the logger’s current firmware version. Note: This event does not notify the user when 
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there is newer version of firmware available for the logger - only if there is a known 
incompatibility in the current firmware version.

Logger State - The Logger State event occurs when the state of a logger changes 
during a real-time log session. A logger state change event is generated when a logger’s 
backup battery is low and when the power was recently disconnected from the logger 
and subsequently reconnected. An e-mail message is generated that contains logger state 
information.

Sensor Events 
Sensor events are events that are directly related to a sensor.

Alarm Settings Update - The Alarm Settings Update event occurs when a user updates 
a sensor’s temperature or humidity alarm settings during a real-time log session. An e-
mail message is generated that contains alarm state and settings information. Note: This 
event only applies to real-time log sessions, and only occurs if an alarm is enabled or 
disabled, or if the alarm’s threshold value is changed. This event does not occur if 
any other alarm settings are changed.
Calibration Due - The Calibration Due event occurs when a sensor’s calibration 
has expired or is coming due. An e-mail message isgenerated that contains the sensor 
calibration due date information. Note: This event only applies to real-time log 
sessions.
Hot-Swap Error - The Hot-Swap Error event occurs when a sensor is hot-swapped 
during a real-time log session and LogWare is unable to successfully acquire readings 
from the newly attached sensor. An e-mail message is generated that contains 
information regarding the reason LogWare is unable to acquire readings from the sensor. 
Note: This event only applies to real-time log sessions.
Humidity Alarm - The Humidity Alarm event occurs when the humidity reading from 
a sensor exceeds the current humidity alarm threshold value, or when the humidity 
reading returns to within the threshold value after having exceeded it. An e-mail message 
is generated that contains the sensor’s reading and alarm settings information. Note: This 
event applies to both real-time log sessions and remote monitoring log sessions.
Sensor State - The Sensor State event occurs when the state of a sensor changes during 
a real-time log session. A sensor state event is generated when a sensor is attached or 
detached (hot-swapping), or if the logger is unable to get readings from the sensor, or 
if the logger is configured to lock out the sensor. An e-mail message is generated that 
contains sensor state information, including the reason the logger cannot get readings 
from the sensor. Note: This event only applies to real-time log sessions.
Temperature Alarm - The Temperature Alarm event occurs when the temperature 
reading from a sensor exceeds the current temperature alarm threshold value, or when 
the temperature reading returns to within the threshold value after having exceeded it. 
An e-mail message is generated that contains the sensor’s reading and alarm settings 
information. Note: This event applies to both real-time log sessions and remote 
monitoring log sessions.
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4.5.1	 Customizing Events
 LogWare’s e-mail features allow various application, log session, logger, and sensor events 

to be linked to an envelope. An envelope is used as the “container” for e-mail messages and 
is used to send the e-mail message generated by an event to the proper group(s) of recipients. 
Each event can be linked to only one envelope.

The events for any real-time log session or remote monitoring log session can be customized 
independently of all other log sessions. If events are not customized, the default event settings 
are used. To customize the e-mail event settings for a real-time log session, click the E-mail 
Settings button on the Logger tab of the Real-Time Log Session Settings dialog. To customize 
the e-mail event settings for a remote monitoring log session, click the E-mail Settings button 
on the Sessions tab of the Remote Monitoring Options dialog. The Real-Time Log Session Event 
Settings dialog or the Remote Log Session Event Settings dialog is displayed accordingly.

Figure 34 Real-Time Log Session Event Settings dialog

The Real-Time Log Session Event Settings dialog displays up to four tabs: Log Session Events, 
Logger Events, and one Sensor Events tab for each enabled sensor. The Remote Log Session 
Event Settings dialog displays only one Sensor Events tab corresponding to the sensor for the 
selected log session to monitor. The default e-mail envelope for each event is selected.

To customize an event, select the tab indicating the category of event to configure. The events 
list on the left displays all events associated with the selected tab. The E-mail envelopes list on 
the right displays a list of all enabled envelopes. Select the event in the events list on the left 
and check the box corresponding to the envelope to use in the E-mail envelopes list on the right. 
Repeat this process for other events. If an event is not linked to an envelope, no e-mail message 
will be generated when the event occurs. 

These settings apply only to the real-time log session or remote monitoring log session cur-
rently being setup. 
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5	 Real-Time Data Logging
The primary method of logging data using LogWare is real-time data logging.  Real-time data 
logging requires communicating with a logger using either a RS-232, Ethernet, or wireless con-
nection. This allows LogWare to configure various logger settings and to query the temperature 
and humidity measurements from the logger.

In a multi-user environment, any LogWare client computer can run any number of real-time log 
sessions. LogWare does not limit the number of real-time log sessions that can be run simul-
taneously on a client computer. However, practical limits do exist based on the computer’s 
processor speed and amount of available memory, the real-time log session’s sample interval, 
and the method of communication being used. 

One real-time log session can acquire the readings from one or both sensors on a logger. How-
ever, if you need to acquire data from both sensors, you must do this in a single real-time log 
session. You cannot setup one real-time log session to acquire data from the sensor on channel 
1 of a logger and a separate real-time log session to acquire the data from the sensor on channel 
2 of the same logger. LogWare prevents more than one real-time log session from being run 
against any one logger. 

When a real-time log session is running, you should avoid communicating with the logger us-
ing any other tools in LogWare (i.e. downloading data, etc) or from any other application. 

Warning: As a general rule, if you use LogWare to log data in real-time from a logger 
over a period of time, you should not attempt to import or download readings from the 
same logger that overlap that time period. 

LogWare’s real-time data logging feature is very flexible and can be configured in many ways. 
Listed below are just a few examples of how LogWare could be configured:

Log temperature data in Celsius or Fahrenheit

Log temperature data only, humidity data only, or both 

Log data from one or both sensors simultaneously or sequentially

Log temperature data from one sensor and humidity data from another sensor

Log data at virtually any rate from 1 second to 24 hours

Start a log session immediately or at any future date and time

Allow a log session to run indefinitely, or automatically terminate a log session after 
a certain number of readings have been logged, or after a specific amount of time has 
elapsed

Automatically start one or more real-time log sessions when you login to LogWare

Setup LogWare to automatically login when the computer boots up to resume real-time 
logging in case of a power failure

Setup alarms with related alarm events to perform a certain task if an alarm value is 
exceeded

 To setup a real-time log session… 

Run LogWare and login using an account with at least restricted access.
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Make sure the logger to use is powered up and connected.

Select the New Log Session option from the File menu, or select the Setup option from 
the Datalog menu to display the Real-Time Log Session Settings dialog.

On the Logger tab, select the appropriate communication settings for communicating 
with the logger. Click the Communication Settings button to access detailed 
communication settings.

Click the Query Logger button to establish communications with the logger. LogWare 
will read in all current logger settings, including the temperature scale, sensor 
information, location information, and alarm values.

Configure each sensor according to how the data should be logged. Selecting a sensor 
in the Sensors list and use the controls to setup the location, alarms, statistics, and graph 
trace color.

On the Session tab, select the logging interval, start log session and end log session 
criteria. 

Click the Start button to start the real-time log session.

 To open a real-time log session configuration file… 

Run LogWare and login using an account with at least restricted access.

Make sure the logger to use is powered up and connected.

Select the Open Log Session option from the File menu to display the Open Log Session 
Settings File dialog.  Navigate to and select the log session settings file to open, and click 
the Open button.

The log session settings file is opened and the Real-Time Log Session Settings dialog is 
displayed. Communication is automatically established with the logger. 

Check the log session settings and click the Start button to start the real-time log session.

A log session settings file may also be opened by clicking the Open… button on the Real-Time 
Log Session Settings dialog.

 To setup LogWare to automatically open and start real-time log sessions on login… 

Run LogWare and login using an account with at least typical access.

Select the Options option from the Tools menu to display the LogWare III Options dialog.

On the General tab, check the Automatically start log session(s) upon login checkbox.

Click the Add button to display the Open Log Session Settings File dialog. Navigate to 
and select the log session settings file(s) to open, and click the Open button. You may 
select multiple files by holding down the CTRL or SHIFT keys while clicking on files.

The selected file(s) should appear in the list.

Click OK on the LogWare III Options dialog to close the dialog and save the settings.

Info: When logging into LogWare using an administrator account, auto-start settings are 
ignored. LogWare will only automatically open and start real-time log sessions when 
logging in using a restricted or typical user account. 

2.

3.

4.

5.

6.

7.

8.

1.

2.

3.

4.

5.

1.

2.

3.

4.

5.

6.



81

5 Real-Time Data Logging

5.1	 Real-Time Log Session Settings
The Real-Time Log Session Settings dialog allows the user to configure a real-time log session. 
This dialog is displayed when selecting the New Log Session option from the File menu or 
when selecting the Setup option from the Datalog menu.

Figure 35 Real-Time Log Session Settings dialog

Real-time log session settings can be saved to a configuration file and opened using this dialog. 
If you frequently want to use the same alarm settings, logging interval, and end log session set-
tings to log real-time data, configure the session and save it to a log session settings file (.LSS 
file) by clicking the Save As button. The next time you need to start a log session, simply open 
the appropriate configuration file by clicking the Open button and making sure the logger is 
available.

The Real-Time Log Session Settings dialog has two tabs: Logger and Session. 

Warning: Before configuring a real-time log session, familiarize yourself with the options 
on the Real-Time tab of the LogWare III Options dialog. In particular, be careful when 
using LogWare in Observation mode. This mode should only be used in specific 
circumstances. An indicator is displayed next to the Query Logger button when 
Observation mode is enabled. Refer to Section 3, LogWare III Options, for more 
information.
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5.1.1	 Logger
The Logger tab allows the real-time log session settings regarding the logger and sensors to be 
configured. 

When this dialog is displayed, all fields on this tab are disabled except the communication 
fields and the Query Logger button.

Note: Before proceeding, make sure the logger to use is powered up and connected as 
applicable.

Select the communication protocol to use to communicate with this logger using the Commu-
nication protocol drop-down list. LogWare supports communicating with loggers using serial 
(RS-232), Ethernet (TCP/IP), and wireless protocols. To use wireless communications, select 
the Serial (RS-232) option from the drop-down list. Details of the current communication 
settings are indicated in the Communication settings details field. Click the Communication 
Settings button to change the current communication settings details. Refer to Section 1.10, 
Methods of Communication, for more information on communication settings.

Info: In order to use the wireless method of communication, you must purchase and 
install a wireless RF modem. The RF modems currently come with either a RS-232 or 
USB interface. Follow the instructions provided with the RF modem to perform the 
installation. The RS-232 modem will connect directly to an existing COM port on the 
computer. Installing the USB modem creates a virtual COM port for the modem. 

Once the communication settings are correct, click the Query Logger button. LogWare attempts 
to communicate with the logger using the selected communication settings, reads in the current 
logger settings, and fills in the remaining fields on this tab.

Info: LogWare keeps track of all of the loggers, sensors, and locations used to log data. 
The first time a logger, sensor, or location is used, LogWare creates records for each item. 
Administrators can configure LogWare to prevent certain loggers, sensors, and locations 
from being used to log data. Every time a logger is queried, LogWare checks to make sure 
the logger, sensors, and locations are active and can be used. 

The Logger field indicates the model and serial number of the logger being used. This informa-
tion cannot be changed.

The Temperature scale field indicates the current temperature scale setting of the logger. If you 
wish to log data in a different scale, use the drop-down list to choose the scale to use. When 
running in Observation mode, the Temperature scale field is disabled.

 The E-mail Settings button allows access to the e-mail event settings for this log session. 
This button is disabled if the user does not have permission to change e-mail related settings. 
The e-mail settings for a real-time log session default to the settings configured on the Default 
Event Settings dialog, which is accessible from the General tab on the LogWare III Options 
dialog
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The Sensors list indicates the model, serial number, and state of the sensor(s) connected to the 
logger. The checkbox next to each sensor in this list indicates whether data should be logged 
from the sensor. Unchecking this checkbox indicates LogWare should not log any data from the 
sensor. If the checkbox is checked, temperature and/or humidity data will be logged, depending 
on the state of the Temperature and Humidity checkboxes to the right of the list.

To change the settings for a sensor, select the sensor in the Sensors list. The fields to the right of 
the list are filled with the current settings for the selected sensor.

The Location field indicates the location of the selected sensor. LogWare uses the sensor ID 
field of the sensor to store the location information. When logging data, it is important to know 
not only what sensor logged the data, but where the sensor was located when the data was 
logged (i.e. LABORATORY, MYDESK, OFFICE, CHAMBER, etc). Use this field to indicate 
where the selected sensor is located. Use the drop-down list to select an existing location, or 
add a new location by clicking the  button. When running in Observation mode, the Location 
field is disabled.

Note: You should avoid setting more than one sensor to the same location during a real-
time log session. Setting more than one sensor to the same location makes it difficult to 
view the data by location after it is logged. Instead, create a new location with a similar, 
but unique, name if necessary (i.e. LABORATORY1 and LABORATORY2).

The Temperature and Humidity checkboxes determine whether temperature and/or humidity 
readings for the selected sensor should be logged. To log both temperature and humidity, check 
both checkboxes. To log only temperature, check only the Temperature checkbox. To log only 
humidity, check only the Humidity checkbox. If both options are unchecked, the checkbox in 
the Sensors list is automatically unchecked, indicating no data from the selected sensor should 
be logged.

The three buttons next to the Temperature and Humidity checkboxes allow alarm settings, 
statistics, and the trace color to be configured. These buttons are disabled if the corresponding 
Temperature or Humidity checkbox is unchecked. The vertical bar to the right of the buttons 
indicates the current trace color.

To configure the alarm settings, click the  (Alarm Settings) button. When running in Ob-
servation mode, the alarm settings can be changed, however the logger will not be updated to 
reflect these settings. 

To configure the statistics, click the  (Statistics Settings) button.

To configure the trace color, click the  (Trace Color) button.

5.1.1.1	 Alarm Settings

The Alarm Settings dialog allows low and high alarms to be configured.
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Figure 36 Alarm Settings dialog

The Alarm Settings dialog has two tabs: Low alarm settings and High alarm settings. Both tabs 
display an identical set of fields that can be used to indicate low and high alarm settings.

If the same alarm settings need to be used repeatedly, you may want to save the alarm settings 
to a configuration file. After configuring the settings, click the Save As button to save the alarm 
settings to an alarm configuration file (.ALM file). To open an alarm configuration file, click the 
Open button and select the configuration file to open.

The Enable low alarm or Enable high alarm checkbox indicates whether the low and high 
alarms are enabled. Check this checkbox to enable the alarm, or uncheck it to disable the alarm.

The Threshold value field indicates the low or high alarm value. Enter the value to use for the 
low or high alarm. The defined alarm event will be triggered if a reading is equal to or exceeds 
the threshold value.

The Alarm event field indicates the event that should occur if the alarm threshold value is met 
or exceeded. The supported alarm events include:

No event - No further action is taken

System beep - Causes the default operating system beep to sound

Display message - Displays a modal message (logging stops - user must respond to 
continue logging)

Play .WAV file - Causes the indicated .WAV file to play

Launch .EXE file - Launches the indicated .EXE file 
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If the Display message option is selected, enter the message to display in the Message to dis-
play field. If no message is specified, a default message is displayed. To test the message, click 
the  button to the right of the field.

If either the Play .WAV file or Launch .EXE file option is selected, click the  button to the 
right of the Filename field to locate the .WAV or .EXE file. To test the event, click the  but-
ton to play the .WAV file or launch the .EXE file to make sure the selected file can be played or 
launched.

The Event occurrences field indicates how often the alarm event should occur. The supported 
settings are:

Only once when alarm value is exceeded
After every update

Select the Only once when the alarm value is exceeded option to only allow the event to 
occur on the first reading that trips the alarm. Subsequent readings that also exceed the alarm 
threshold value will not cause the event to occur again until one or more readings are taken that 
reset the alarm.

Select the After every update option to allow the event to happen for every reading that trips 
the alarm and all subsequent readings that exceed the alarm threshold value.

Info: The After every update option cannot be selected if the alarm event is set to 
Launch .EXE file.

5.1.1.2	 Statistics

The Statistics Settings dialog allows the statistical calculations that are to be displayed to be 
defined.

Figure 37 Statistics Settings dialog

The Statistics Settings dialog has two tabs: General and Sliding Window.

●
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General

The General tab indicates the general statistical calculations to display. Check the options that 
should be displayed. Uncheck the options that should not be displayed.

Sliding Window

The Sliding Window tab indicates whether the statistics are calculated from all readings or only 
the most recent readings.

Figure 38 Statistics Settings dialog - Sliding Window tab

To enable the sliding window, check the Enable Sliding Window option and enter the number 
of readings to include in the sliding window. Only the most recent n readings will be used to 
calculate the statistical values displayed.

Note: The sliding window feature is only intended for use with dynamic data sets (during 
real-time log sessions and remote monitoring sessions). Changing the sliding window 
settings on a static data set (viewing logged data) will reset the statistics.

5.1.1.3	 Color

The Color dialog can be used to select the graph trace colors.
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Figure 39 Color dialog

Use the controls on this dialog to select the color to use or to define custom colors. 

5.1.2	 Session
The Session tab allows the user to define when the log session should start, end, and the rate at 
which readings are logged to the database.
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Figure 40 Real-Time Log Session Settings dialog - Session tab

The Logging interval fields determine the rate at which measurements are queried from the log-
ger during the real-time log session. LogWare is capable of logging data at intervals from once 
every second to once every 24 hours. 

Info: The exact interval between measurements on a particular channel depends on the 
Sample all sensors simultaneously checkbox on the Real-Time tab of the LogWare III 
Options dialog. If this checkbox is checked, LogWare attempts to query measurements on 
all enabled channels at the interval indicated by the Logging interval fields (simultaneous 
mode). If this checkbox is not checked, LogWare queries the measurements on only one 
channel at a time at the indicated interval (sequential mode).

The Interval between scan sequences settings are only displayed if LogWare is configured for 
sequential mode. If this feature is enabled, LogWare will query measurements on each enabled 
channel, one at a time at the interval indicated in the Logging interval fields. LogWare will 
then wait until the amount of time specified in the Interval between scan sequences fields has 
elapsed since the measurement process began and query measurements on each enabled chan-
nel again.

By default, LogWare expects to start logging real-time data as soon as you click the Start but-
ton. The Start log session settings can be used to force LogWare to wait until a specific date 
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and/or time before starting to log data. Select whether you want the log session to begin imme-
diately or at a specified date and time using the drop-down list.

The Delayed start date and Delayed start time settings determine when the log session should 
begin if the At date and time specified below option is selected. Use the calendar to select the 
date, and enter the time in the field provided. These settings are disabled if a log session is set 
to begin immediately.

The End log session settings can be used to automatically stop the logging process after a speci-
fied time has elapsed or after a specific number of readings have been logged on each channel. 
Use the drop-down list to select the appropriate option, then set the criteria using the End log 
criteria fields. By default, log sessions continue until they are manually stopped by the user.

Once the logger and session settings are complete, start the log session by clicking the Start 
button. When using the Ethernet (TCP/IP) communication settings in DHCP mode, LogWare 
searches for any loggers on the network and displays the Select Logger dialog. Select the logger 
to use and click OK to proceed.

Figure 41 Select Logger dialog
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Info: When starting a real-time log session, LogWare sends configuration information to 
the logger to synchronize many of its settings with the settings selected for the log session. 
Some of these settings are or may be password protected. If LogWare needs to change any 
password protected settings in the logger, a password prompt is displayed. You must enter 
the correct password for the logger being used in order for LogWare to change the 
necessary settings. If the correct password is not entered, LogWare will log data using the 
location and alarm values configured on the Real-Time Log Session Settings dialog. This 
prompt is not displayed if the logger’s settings are not password protected or do not need 
to be changed, or if the Never attempt to update password protected settings checkbox on 
the LogWare III Options dialog is checked. Note: This password is not related to the 
LogWare user account password!

5.1.3	 Log Session Settings File
It is common to need to use the same real-time log session settings over and over again. To save 
time configuring a log session, LogWare allows the real-time log session settings to be saved to 
a configuration file, called a log session settings file (.LSS file). Log session settings files can 
only be saved from the Real-Time Log Session Settings dialog. A log session settings file can be 
opened by selecting the Open Log Session option from the File menu or by clicking the Open 
button on the Real-Time Log Session Settings dialog. 

A log session settings file contains information about the communication settings, temperature 
scale, logging interval, session start/end settings, and sensor settings including statistics and 
alarm settings for each sensor.

One or more log session settings files can be opened automatically when LogWare runs. These 
settings are available on the General tab of the LogWare III Options dialog.

5.2	 Real-Time Log Session
The Real-Time Log Session window is displayed when a real-time log session is started. The 
window displays the most recent measurements from each sensor in a spreadsheet style grid, 
real-time log session settings information, graphs of the measurements of all enabled sensors, 
and statistical calculations and alarm settings for the selected sensor.

If the log session was configured for a delayed start date/time, the Select Delayed Start Date/
Time dialog may be displayed prior to the Real-Time Log Session window if the start date/time 
passes before the log session starts. Select a new start date/time and click OK to continue. Refer 
to Section 5.2.1, Select Delayed Start Date/Time, for more information on using this dialog.

If the manual synchronization feature is enabled, a prompt is displayed as soon as the log ses-
sion is ready to begin logging data. Click the OK button to begin logging data.
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Figure 42 Real-Time Log Session window

Refer to Section 3, LogWare III Options, for more information on the various settings and op-
tions for real-time log sessions. 

Info: When starting a real-time log session, LogWare sends configuration information to 
the logger to synchronize many of its settings with the settings selected for the log session. 
Some of these settings are or may be password protected. If LogWare needs to change any 
password protected settings in the logger, a password prompt is displayed. You must enter 
the correct password for the logger being used in order for LogWare to change the 
necessary settings. If the correct password is not entered, LogWare will log data using the 
location and alarm values configured on the Real-Time Log Session Settings dialog. This 
prompt is not displayed if the logger’s settings are not password protected or do not need 
to be changed, or if the Never attempt to update password protected settings checkbox on 
the LogWare III Options dialog is checked. Note: This password is not related to the 
LogWare user account password!

 Note: If the date/time stamp for the readings is being queried from the logger, this may 
cause the date and time information displayed on the graph to get slightly out of sync 
with the date and time stamps of the readings. However, the date and time stamps 
recorded with each reading will always be accurate.

The Real-Time Log Session window is divided into three main sections: sensors grid, graphs, 
and statistics and alarms panel. These sections can be resized by dragging the dividers between 
each section. The upper right corner of the window also displays some basic information about 
the log session.
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Warning: When using LogWare in Observation mode, an indicator is displayed at the top 
of the log session information list indicating Observation mode is enabled.

Each sensor is listed in the sensors grid. This grid displays the location information, date and 
time the last measurement was taken, the most recent measurement values, current temperature 
and humidity alarm states (if applicable), and notes. The Notes column gives feedback regard-
ing the sensor, such as sensor state messages, calibration due information (if enabled), and 
more.

Temperature and humidity readings and their alarm states are highlighted in the same colors as 
the graph traces defined for each sensor. If a current measured value exceeds an alarm value, 
the appropriate alarm state column for that sensor is highlighted. 

Right-clicking on a row in the grid displays a popup menu that allows some of the sensor’s set-
tings to be changed.

Figure 43 Real-Time Readings Grid popup menu

Graph trace colors for the selected sensor can be changed by selecting the appropriate option(s) 
from the popup menu. The trace on the graph can be shown or hidden by selecting the Show 
Trace on Graph option, or by simply double-clicking on the appropriate row in the grid.

Info: You cannot hide the traces for both sensors at the same time. If one sensor’s traces 
are currently hidden, and you attempt to hide the traces for the other sensor, the first 
sensor’s traces will be shown. If there is only one sensor, the Show Trace on Graph menu 
option is disabled. Also, selecting the Use Default Trace Colors option resets all traces to 
their default colors, not just the trace(s) for the selected sensor.

As measurements are logged, they are also plotted on the graphs. Temperature and humid-
ity readings may be plotted on the same graph, or on separate graphs. You can zoom in on a 
small section of a graph by clicking on the graph and dragging the mouse to draw a box. When 
temperature and humidity readings are plotted on separate graphs, the zoom feature can be 
synchronized to cause both graphs to zoom to the same area.

Graphs can be printed by selecting the Print | Graph option in the File menu or by selecting the 
Print Graph option in the Graph menu. If the temperature and humidity readings are displayed 
in separate graphs, the Select Graph to Print dialog is displayed. Select the graph(s) to print, 
then click the OK button to print the graph(s).

The graphs can also be configured to show alarm lines and data point markers by selecting the 
appropriate options from the Graph menu or by clicking the corresponding toolbar buttons.

Right-clicking on a graph displays a popup menu with various options for customizing the 
graph’s settings. Note that LogWare does not “memorize” custom graph settings configured us-
ing this popup menu or the associated dialogs. 
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Figure 44 Graph popup menu

The right side of the window shows the statistical calculations for the selected sensor. Option-
ally, the alarm values may also be displayed in this list. If the selected sensor’s current measure-
ment exceeds an alarm value, the alarm in this list is highlighted in a bold typeface. Statistics 
and alarms are also displayed in the defined colors for the selected sensor’s graph traces. Right-
clicking on any temperature or humidity item in the list displays a popup menu for working 
with the temperature or humidity statistics, alarms, and e-mail settings.

Figure 45 Statistics popup menu

Select the Temperature/Humidity Statistics Settings option to change which statistical values 
are displayed. Select the Reset Temperature/Humidity Statistics option to reset only the selected 
statistics. To reset all statistics for the selected sensor, select the Reset Sensor Statistics option. 
To reset the statistics for all sensors simultaneously, select the Reset All Statistics option.

Select the Temperature/Humidity Alarm Settings option to change the current alarm settings.

Note: Changing the alarm settings during a real-time log session also updates and 
synchronizes the alarm settings in the logger. 

 To change the e-mail event settings for this log session, select the E-mail Settings option. 
This menu option is disabled if the current user does not have permission to change e-mail 
settings.

To stop or abort a real-time log session, select the Stop option in the Datalog menu, click on the 
corresponding toolbar button, or click the  button in the upper right corner of the window. 



9936A LogWare III
Users Guide

94

5.2.1	 Select Delayed Start Date/Time
The Select Delayed Start Date/Time dialog is displayed when starting a real-time log session if 
the previously selected start date/time has passed.

Figure 46 Select Delayed Start Date/Time dialog

Use the Select date calendar to select the new start date, and enter the time in the Select time 
field. 

5.2.2	 Select Graph to Print
The Select Graph To Print dialog is displayed when selecting the Print | Graphs option from 
the File menu or the Print Graph option from the Graph menu.

Figure 47 Select Graph To Print dialog

Select the graph(s) to print by checking the appropriate checkbox(es). Click OK to print the 
graph(s).
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5.2.3	 Observation Mode
Observation mode is a special mode of a real-time log session where readings are acquired 
from a logger but are not recorded. Also, LogWare does not set or change the alarms, sensor ID 
(location), temperature scale, or resolution settings of the logger. 

 Observation mode can be enabled on the Real-Time tab of the LogWare III Options dialog. 
When Observation mode is enabled, a label is displayed on the Real-Time Log Session Settings 
dialog and on the Real-Time Log Session window. 
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6	 Remote Monitoring
The primary method of logging data using LogWare is real-time data logging.  Real-time data 
logging requires communicating with a logger using either a RS-232, Ethernet, or wireless 
connection. 

Any LogWare client computer can run any number of real-time log sessions. However, Log-
Ware only permits one real-time log session per logger. In a multi-user environment, it may 
be necessary for multiple users to monitor real-time data for a location. LogWare allows any 
LogWare client to monitor logged data in real-time for any location where data is currently be-
ing logged without communicating with the logger to obtain the readings. This feature is called 
remote monitoring. LogWare does not limit the number of remote monitoring sessions that can 
be open at a time.

LogWare’s remote monitoring feature can be configured in many ways. Listed below are just a 
few examples of how a remote monitoring session could be configured:

Monitor temperature data in Celsius or Fahrenheit

Monitor temperature data only, humidity data only, or both 

Read in and graph historical data for the location

Update data in real-time at an interval from 1 minute to 24 hours

Customize statistical, alarm and e-mail settings (does not affect real-time log session 
alarms and e-mail settings)

To setup a remote monitoring session… 

Run LogWare and login using any account.

Select the Remote Monitoring option from the View menu to display the Remote 
Monitoring Options dialog.

On the Sessions tab, select the location to monitor from the Current log sessions list. 
Real-time log session information is displayed in the list to the right.

Optional: Indicate the readings to monitor by checking or unchecking the checkboxes 
for temperature and humidity readings accordingly. Customize statistics, alarms, trace 
colors, and e-mail settings as desired. To reset the remote monitoring session to use the 
same settings that are being used by the real-time log session, click the Restore Default 
Settings button.

On the Misc. Settings tab, select the historical data to read in, update interval, graphing 
options, temperature scale, and resolutions to use. 

Click the OK button to start the remote monitoring session.

6.1	 Remote Monitoring Options
The Remote Monitoring Options dialog allows the user to select the real-time log session data 
to be monitored. This dialog is displayed by selecting the Remote Monitoring option from the 
View menu.

●

●

●

●

●

1.

2.

3.

4.

5.

6.
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Figure 48 Remote Monitoring Options dialog

The Remote Monitoring Options dialog has two tabs: Sessions and Misc. Settings.

Sessions 

The Sessions tab displays information about the locations for all current real-time log sessions. 
To configure a remote monitoring session, select a location from the Current log sessions list. 

The Current log sessions list indicates all locations where real-time log sessions are currently 
running. If a real-time log session is logging data from both sensors (two locations), each loca-
tion is listed as a separate item in this list. A remote monitoring session can only display the 
data for a single location. Selecting a location from the list displays information about the real-
time log session in the details list on the right. This information includes the real-time logging 
interval, the LogWare user name and computer name where the real-time log session is running, 
logger and sensor model and serial numbers, alarm settings, and other information. 

If LogWare has been unable to obtain readings from a location for a period of time, the item is 
highlighted in bold red text in the Current log sessions list and a bold red label appears above 
the details list when the item is selected. The log session is considered to be currently inactive. 
In the case of a LogWare client computer shutting down unexpectedly, the system still indi-
cates real-time log sessions are running because the log sessions were not terminated properly. 
However, these log sessions will likely appear as being inactive because LogWare is no longer 
obtaining new readings. To close inactive log sessions and remove them from this list, use 
LogWare’s Manage Log Sessions feature.
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Info: If the Automatically remove inactive log sessions from Remote Monitoring dialog 
checkbox on the Misc tab of the LogWare III Options dialog is checked, log sessions that 
have been inactive for more than the specified amount of time will not appear in the list. 
If a log session resumes activity, it will re-appear in the list.

The Remotely monitor temperature readings and Remotely monitor humidity readings check-
boxes indicates whether temperature and/or humidity readings should be displayed in the 
Remote Monitoring window respectively.

The remote monitoring session’s alarm and statistics settings default to the settings being used 
by the real-time log session if the selected location has never been remotely monitored before. 
If the selected location has been remotely monitored previously, the remote monitoring ses-
sion’s alarm and statistics settings default to the previously used settings for that location. 

Info: All remote monitoring session alarm, statistics, and e-mail settings can be 
customized for each LogWare client independently. Customizing remote monitoring 
session settings do not affect the settings used by the real-time log session.

To customize the alarm settings for the remote monitoring session for the selected location, 
click the  (Alarm Settings) button. 

To customize the statistics for the remote monitoring session for the selected location, click the 
 (Statistics Settings) button.

To customize the trace color for the remote monitoring session for the selected location, click 
the  (Trace Color) button.

The e-mail event settings for a Remote Monitoring session can be configured by clicking the 
E-mail Settings button. Remote Monitoring sessions only support sending e-mail messages for 
the following events:

Temperature Alarm event

Humidity Alarm event

To restore all applicable settings to the settings being used on the corresponding Real-Time Log 
Session, click the Restore Default Settings button. Clicking this button affects the following 
settings:

Remotely monitor temperature readings checkbox

Remotely monitor humidity readings checkbox

Temperature and humidity alarm states and threshold values (alarm events are not 
affected)

Temperature scale setting

Update interval setting

All other Remote Monitoring Session settings are specific to remote monitoring and are not af-
fected by clicking then Restore Default Settings button.

●

●

●

●

●

●

●
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Misc. Settings

The Misc. Sessions tab includes settings for the remote monitoring session for the selected 
location.

Figure 49 Remote Monitoring Options dialog - Misc Settings tab

The Display data for previous fields indicate how much historical data should be queried and 
displayed when initiating the remote monitoring session. This setting will determine the x-axis 
range on the graph(s) in the Remote Monitoring window. Querying more historical data causes 
the session to take longer to initiate. It is recommended to query only the amount of historical 
data that is necessary.

The Update interval fields indicate how often the remote monitoring session should check for 
more recent readings. Remote monitoring sessions may be updated up to once every minute. It 
is recommended that the update interval not be set to update more frequently than the logging 
interval used by the corresponding real-time log session. The real time logging interval is indi-
cated on the Sessions tab.

The Plot temperature and humidity readings on same graph checkbox determines whether 
separate graphs are created in the Remote Monitoring window for temperature and humidity 
readings, or whether temperature and humidity readings are plotted on the same graph. When 
plotting temperature and humidity readings on the same graph, temperature readings use the 
left y-axis and humidity readings use the right y-axis of the graph.



101

6 Remote Monitoring

Select the temperature scale for temperature data using the Select temperature scale drop-down 
list. LogWare always records temperature readings in Celsius. Readings are converted to the 
desired scale for viewing.

The Reading resolutions fields indicate the number of decimal places to use to format the data. 
All readings are recorded using the resolution settings that were configured when the data was 
logged. Select the number of digits to use for temperature readings using the Temperature field 
and humidity readings using the Humidity field.

When all settings have been selected, click the OK button to initiate the remote monitoring 
session. The Remote Monitoring window is displayed and populated with the historical data. 
Updates will occur at the selected interval.

6.2	 Remote Monitoring
The Remote Monitoring window is displayed when a remote monitoring session is started. The 
window displays the most recent measurements from the indicated location, remote monitoring 
session information and settings, graphs of the measurements, and statistical calculations and 
alarm settings.

Figure 50 Remote Monitoring window

The Remote Monitoring window is divided into three main sections: current readings, graphs, 
and statistics and alarms panel. These sections can be resized by dragging the dividers between 
each section. The upper right corner of the window also displays some basic information about 
the remote monitoring session.
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The icon displayed on the Remote Monitoring window indicates the status of the session: The 
icon  indicates normal operation; The icon  indicates a problem querying data from the 
server (server busy, timeout, etc); The icon  indicates a critical error occurred communicat-
ing with the server (server not responding, etc). A message is also displayed briefly in the status 
bar of the main window if the Remote Monitoring session is unable to communicate with the 
server.

The most recent readings are displayed in large bold type at the top of the window in colors that 
match the corresponding graph trace colors. The date/time stamp of the most recent success-
ful update is indicated below the readings. If no readings have been successfully queried for 
a period of time, a label appears above the readings in bold red type indicating the associated 
real-time log session appears to be inactive. To manage inactive log sessions, use LogWare’s 
Manage Log Sessions feature.

As updates occur and new measurements are retrieved, they are also plotted on the graphs. 
Temperature and humidity readings may be plotted on the same graph, or on separate graphs. 
You can zoom in on a small section of a graph by clicking on the graph and dragging the mouse 
to draw a box. When temperature and humidity readings are plotted on separate graphs, the 
zoom feature can be synchronized to cause both graphs to zoom to the same area.

Graphs can be printed by selecting the Print | Graph option in the File menu or by selecting the 
Print Graph option in the Graph menu. If the temperature and humidity readings are displayed 
in separate graphs, the Select Graph To Print dialog is displayed. Select the graph(s) to print, 
then click the OK button to print the graph(s).

The graphs can also be configured to show alarm lines and data point markers by selecting the 
appropriate options from the Graph menu or by clicking the corresponding toolbar buttons.

Right-clicking on a graph displays a popup menu (see Figure 44) with various options for cus-
tomizing the graph’s settings. Note that LogWare does not “memorize” custom graph settings 
configured using this popup menu or the associated dialogs. 

The right side of the window shows the statistical calculations for the location. Optionally, the 
alarm values may also be displayed in this list. If the location’s current measurement exceeds an 
alarm value, the alarm in this list is highlighted in a bold typeface. Statistics and alarms are also 
displayed in the defined colors for the location’s graph traces. Right-clicking on any tempera-
ture or humidity item in the list displays a popup menu for working with the temperature or 
humidity statistics, alarms, and e-mail settings.

Figure 51 Remote Monitoring Statistics popup menu
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Select the Temperature/Humidity Statistics Settings option to change which statistical values are 
displayed. Select the Reset Temperature/Humidity Statistics option to reset only the selected sta-
tistics. To reset all statistics for the selected location, select the Reset Sensor Statistics option. 

Select the Temperature/Humidity Alarm Settings option to change the current alarm settings.

 To change the e-mail event settings for this log session, select the E-mail Settings option. 
This menu option is disabled if the current user does not have permission to change e-mail 
settings.

Note: Changing the statistics, alarms, and e-mail settings during a remote monitoring 
session does not affect the real-time log session settings for the selected location.

To stop or abort a remote monitoring session, click the  button in the upper right corner of 
the Remote Monitoring window. 





105

7 Downloading Logged Data

7	 Downloading Logged Data
LogWare provides a tool that allows data to be downloaded from the memory of a logger into 
LogWare. 

Warning: As a general rule, if you use LogWare to log data in real-time from a logger 
over a period of time, you should not attempt to import or download readings from the 
same logger that overlap that time period.

Downloading can be an effective method of getting data into LogWare because it does not 
require a computer to be running and connected to the logger at all times like real-time logging, 
and it does not require using a PC card to transport data from the logger like importing. When 
data is downloaded from a logger, it is actually written to a file, and then imported into Log-
Ware in exactly the same manner as if you were importing data from a PC card file.

Info: Committing data to the data storage system is a slow process that can take many 
hours to complete, depending on the amount of data to commit. For this reason, it is 
recommended that you commit small amounts of data at a time. For larger data sets, you 
may want to commit the data during off hours (overnight).

 To download data from the memory of a logger… 

Run LogWare and login using an account with at least restricted access.

Select the Download option from the Tools menu to display the Download Options 
dialog.

On the Download Options tab, select the appropriate communication settings 
for communicating with the logger containing the data to download. Click the 
Communication Settings button to access detailed communication settings.

Select the remaining options regarding the data to download from the logger.

Click the Download button to begin the download process.

The data will be downloaded and saved to a temporary file. This file is then imported into 
LogWare.

7.1	 Download Options
 The Download Options dialog allows the user to specify the readings to be downloaded 

from a logger’s memory. This dialog is displayed when selecting the Download option from the 
Tools menu.

1.

2.

3.

4.

5.

6.
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Figure 52 Download Options dialog

Choose the communication protocol to use to communicate with the logger. For wireless com-
munications, select the Serial (RS-232) option. Details regarding the current communication 
settings are indicated in the Communication settings details field. To change the communication 
details, click the Communication Settings button. Refer to Section 1.10, Methods of Communi-
cation, for more information on communication settings.

Info: In order to use the wireless method of communication, you must purchase and 
install a wireless RF modem. The RF modems currently come with either a RS-232 or 
USB interface. Follow the instructions provided with the RF modem to perform the 
installation. The RS-232 modem will connect directly to an existing COM port on the 
computer. Installing the USB modem creates a virtual COM port for the modem.

When selecting the data to download from a logger’s memory, there are two options to choose 
from: Download all readings and Download only readings in selected date/time range.
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The Download all readings option indicates that all readings currently stored in the logger’s 
memory should be downloaded. Use this option if data has never been downloaded from a log-
ger before, or if the logger’s memory had been cleared since the last download.

The Download only readings in selected date/time range option allows the user to select a spe-
cific range of readings to download. When this option is selected, the date and time fields can 
be used to select the range or readings to download. Use this option if data has been previously 
downloaded from the logger’s memory, or if you are only interested in data from a specific time 
span.

The Date range fields are used to specify the from date and to date of the readings to download. 
Setting these dates to the same date causes all of the data from that day to be downloaded.

The Time range fields can be used to narrow down the range of the data to download even 
more. To specify a time range, check the Time range option, then select or enter the from time 
and the to time in the appropriate fields.

Info: Because the logger stores data in its memory in a highly compressed format, it may 
be necessary for LogWare to actually download more data than indicated by the selected 
date and time range settings. However, LogWare discards readings that fall outside the 
specified range after the data is downloaded.

The Preview downloaded data before committing checkbox allows the data to be viewed before 
LogWare actually records the data. Leaving this checkbox unchecked indicates that the data 
should be recorded unconditionally. Refer to Section 8.2, Imported Data, for more information 
on viewing downloaded data.

When the options are set appropriately, click the Download button to begin the download pro-
cess. When using the Ethernet (TCP/IP) communication settings in DHCP mode, LogWare 
searches for any loggers on the network and displays the Select Logger dialog. See Figure 41. 
Select the logger to use and click OK to proceed.

Note: Downloading large amounts of data can take several minutes to complete. For best 
results, use the fastest communication settings available.

The status bar at the bottom of the Download Options dialog indicates the download progress. 
When downloading is complete, the data will either be recorded or displayed in the Imported 
Data window.

LogWare does not prevent the same set of data from being committed to the data storage system 
multiple times. However, a unique log session is created each time the data is committed. 
Committing the same set of data multiple times will cause duplication of data when querying 
the data by location or by sensor. Duplicate log sessions should be avoided. If duplicate log 
sessions exist, they should be removed. Refer to Section 10.4, Deleting Log Sessions, for more 
information on removing duplicate log sessions.
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8	 Importing Logged Data
LogWare provides a tool that allows data to be imported from binary files written to a PC card 
by the logger. This tool can be useful when your logger is not located near a computer, or when 
you have multiple loggers in various locations.

Info: The Model 1620A no longer includes a PC card slot. This feature has been left in 
LogWare for backward compatibility with the 1620 and 5020A. 

Importing is only one way to get data into LogWare. Data can also be downloaded directly from 
a logger or logged in real-time. 

Warning: As a general rule, if you use LogWare to log data in real-time from a logger 
over a period of time, you should not attempt to import or download readings from the 
same logger that overlap that time period. 

Importing can be an effective method for getting data into LogWare because it does not require 
a computer to be running and connected to the logger at all times like real-time logging, and it 
does not require the logger to be connected to the PC or to a network like downloading re-
quires. It does, however, require the use of a PC card to transport the data from the logger to the 
computer. 

Info: Committing data to the data storage system is a slow process that can take many 
hours to complete, depending on the amount of data to commit. For this reason, it is 
recommended that you commit small amounts of data at a time. For larger data sets, you 
may want to commit the data during off hours (overnight).

 To import data from a PC card … 

Run LogWare and login using an account with at least restricted access.

Select the Import option from the File menu to display the Import Options dialog.

On the Log Files tab, locate the file to import data from using the Import from drop-down 
list and navigation buttons.

Select the file to import.

Click the Import button to begin the import process.

The data will be imported. 

8.1	 Import Options
 The Import Options dialog allows the user to select a file to import. This dialog is displayed 

when selecting the Import option from the File menu.

1.

2.

3.

4.

5.

6.
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Figure 53 Import Options dialog

The Import from field indicates the location (drive letter or folder) where the import files are 
located. Use the drop-down list to select the drive or folder where the file to import is located. 
A list of folders and files found in the selected drive of folder are displayed in the list below. To 
open a subfolder, double-click the appropriate folder item in the list.

Valid logger files have a .REC extension. Only files with this extension can be imported into 
LogWare. LogWare analyzes each file before it is displayed in the list and displays information 
about the contents of each file in the Contents column. If LogWare is unable to open a file, or 
if the file does not match the expected format, the marker <unknown format> appears in the 
Contents column.

The Preview imported data before committing checkbox allows the data to be viewed before 
LogWare actually records the data. Leaving this checkbox unchecked indicates that the data 
should be recorded unconditionally. Refer to Section 8.2, Imported Data, for more information 
on viewing imported data.

Select the file to import by clicking on the filename in the list. 
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Click the Import button to begin the import process. The status bar at the bottom of the Import 
Options dialog indicates the import progress. When importing is complete, the data will either 
be recorded, or displayed in the Imported Data window.

Info: Committing data to the data storage system is a slow process that can take many 
hours to complete, depending on the amount of data to commit. For this reason, it is 
recommended that you commit small amounts of data at a time. For larger data sets, you 
may want to commit the data during off hours (overnight).

LogWare does not prevent the same set of data from being committed to the data storage sys-
tem multiple times. However, a unique log session is created each time the data is committed. 
Committing the same set of data multiple times will cause duplication of data when querying 
the data by location or by sensor. Duplicate log sessions should be avoided. If duplicate log 
sessions exist, they should be removed. Refer to Section 10.4, Deleting Log Sessions, for more 
information on removing duplicate log sessions.

8.2	 Imported Data
The Imported Data window displays data that has been imported from a file or downloaded 
from a logger’s memory but has not yet been recorded (committed). This window is displayed 
when importing or downloading data from a logger if the Preview downloaded/imported data 
before committing checkbox is checked. 

Figure 54 Imported Data window

Info: Data columns in the grid can be resized as desired. The data columns can be 
reordered by dragging the column header to its new position. The data can also be sorted 
by simply clicking on a column header. These features are provided as a convenience only 
and do not have any affect on how the data is recorded.
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The data is displayed in a spreadsheet style grid. You can use the scroll bars to scroll through 
the data to review it before deciding whether or not to commit the data.

The data displayed consists of the date and time the readings were logged, the channel number, 
location, and sensor model and serial number, the temperature and humidity readings, and the 
temperature and humidity alarm settings (Min and Max columns). The total number of records 
is displayed at the bottom of the window.

If you decide to record (commit) the data, click the Commit button.  

Info: Committing data to the data storage system is a slow process that can take many 
hours to complete, depending on the amount of data to commit. For this reason, it is 
recommended that you commit small amounts of data at a time. For larger data sets, you 
may want to commit the data during off hours (overnight). 

LogWare does not prevent the same set of data from being committed to the data storage system 
multiple times. However, a unique log session is created each time the data is committed. 
Committing the same set of data multiple times will cause duplication of data when querying 
the data by location or by sensor. Duplicate log sessions should be avoided. If duplicate log 
sessions exist, they should be removed. Refer to Section 10.4, Deleting Log Sessions, for more 
information on removing duplicate log sessions.

To discard the data without recording it, simply close the window. A prompt is displayed to 
confirm discarding the data to prevent accidentally closing the window without the opportunity 
to commit the data.
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9	 Managing Logged Data
Once data has been logged, whether in real-time, imported from a file, or downloaded from a 
logger’s memory, the data can be viewed, printed, and/or exported.

When viewing logged data, individual data points may be annotated to indicate special condi-
tions, situations, or events that occurred while the data was being logged. Annotations can help 
identify the cause or source of out-of-tolerance data points or changes to settings.

Logged data can be exported to HTML, RTF or CSV files for distributing, archiving, or import-
ing into other software applications such as Microsoft® Excel or Word for analysis, reporting, 
or additional calculations.

To view logged data…

Select the Logged Data option from the View menu to display the View Logged Data 
Options dialog.

On the Criteria tab, select the data to be viewed.

On the Misc. Settings tab, select other options related to how the data should be viewed.

Click the OK button to view the data. 

The data will be displayed in a Logged Data window.

To print a report containing logged data…

Select the Print | Report option from the File menu to display the Print Logged Data 
Options dialog.

On the Report Options tab, select the appropriate settings for the data to be printed. Click 
the Select Fields to Print button to setup the fields to be printed.

On the Criteria tab, select the data to be printed.

On the Misc. Settings tab, select other options related to how the data should be printed.

Click the OK button to generate the report. 

The data will be printed to a report.

 To export logged data… 

Select the Export option from the File menu to display the Export Logged Data Options 
dialog.

On the Export Options tab, select the appropriate settings for the data to be exported. 
Click the Select Fields to Export button to setup the fields to be exported.

On the Criteria tab, select the data to be exported.

On the Misc. Settings tab, select other options related to how the data should be exported.

Click the OK button to begin the export process. 

The Export Filename dialog is displayed. Select the location and name of the export file 
and click OK.

The data will be exported to the indicated file.

1.

2.

3.
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9.1	 Viewing Logged Data
LogWare allows data that has been logged to be viewed on screen in a spreadsheet style grid 
and graphed. Statistics are also calculated for the data.

When viewing the data, the graphs can be zoomed, annotations can be added to individual data 
points, and the data and graphs can be printed or exported.

To view logged data…

Select the Logged Data option from the View menu to display the View Logged Data 
Options dialog.

On the Criteria tab, select the data to be viewed.

On the Misc. Settings tab, select other options related to how the data should be viewed.

Click the OK button to view the data. 

The data will be displayed in a Logged Data window.

Once the logged data is displayed in the Logged Data window, it may be exported or printed.

9.1.1	 View Logged Data Options
The View Logged Data Options dialog allows the user to choose the data to view and determine 
how it should be displayed. This dialog is displayed when selecting the Logged Data option 
from the View menu.

Figure 55 View Logged Data Options dialog

The View Logged Data Options dialog has two tabs: Criteria and Misc. Settings.

1.

2.

3.

4.

5.
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Criteria

The Criteria tab allows the user to select the data to be viewed. 

When readings are logged in real-time or downloaded or imported, information about the log-
ger, sensor, location, and the method used to log the data are recorded with the data. To view 
logged data, you must indicate which readings you want to view. Readings can be selected 
in one of four ways: by location, sensor, real-time log session, or download/import session. 
Use the Select data for drop-down list to choose how you want to select the readings to view. 
When you select an option, the Matching drop-down list is populated with appropriate selection 
information.

Use the Matching drop-down list to select the appropriate item that matches the readings you 
want to view. The following table indicates the options and choices for selecting readings.

Table 6 View Logged Data Matching drop-down options

When the Select data for 
drop-down list is set to…

The Matching drop-down lists includes…

Location A list of all locations. Some locations may not have any logged 
data associated with them.

Sensor A list of all sensor assets. Some sensors may not have any 
logged data associated with them.

Real-Time Log Session A list of all complete real-time log sessions, sorted by location 
and date/time range of the logged data. Currently open (running) 
real-time log sessions are not displayed.

Imported/Downloaded Data A list of all import/download data sets, sorted by location and 
date/time range of the imported data.

The Date range fields are used to specify the date range of the readings to view. If you want to 
view all readings from the selected location or sensor, leave the Date range checkbox un-
checked. Otherwise, check this checkbox and select the from date and the to date. Setting these 
dates to the same date selects all of the readings from the selected location or sensor for that 
day. These fields are disabled when selecting data by Real-Time Log Session or by Imported/
Downloaded Data.

The Time range fields can be used to narrow down the range of the readings to view even more. 
To specify a time range, check the Time range checkbox, then select or enter the from time and 
the to time in the appropriate fields. These fields are also disabled when selecting data by Real-
Time Log Session or by Imported/Downloaded Data.

Note: LogWare is designed to handle large amounts of data. However, be aware that 
querying and viewing such large sets of data may take a few minutes. Some computers 
may not be able to view large amounts of data in a reasonable amount of time. You may 
wish to break up the data into smaller chunks to be more efficient.

Misc Settings

The Misc. Settings tab includes various options for determining how the data should be viewed.
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Figure 56 View Logged Data Options dialkog - Misc Settings tab

The Temperature readings and Humidity readings checkboxes allow the user to specify which 
readings should be viewed.

The Plot temperature and humidity readings on same graph checkbox determines whether 
separate graphs are created in the Logged Data window for temperature and humidity readings, 
or whether temperature and humidity readings are plotted on the same graph. When plotting 
temperature and humidity readings on the same graph, temperature readings use the left y-axis 
and humidity readings use the right y-axis of the graph.

Select the temperature scale for temperature data using the Select temperature scale drop-down 
list. LogWare always records temperature readings in Celsius. Readings are converted to the 
desired scale for viewing.

The Reading resolutions fields indicate the number of decimal places to use to format the data. 
All readings are recorded using the resolution settings that were configured when the data was 
logged. Select the number of digits to use for temperature readings using the Temperature field 
and humidity readings using the Humidity field.

When all settings have been selected, click the OK button to view the selected data.  The data is 
displayed in the Logged Data window.

9.1.2	 Logged Data
The Logged Data window displays data in a spreadsheet style grid, in graphs and also displays 
statistical calculations for the data. This dialog is displayed when selecting the Logged Data 
option from the View menu, and selecting the criteria for the data to view on the View Logged 
Data Options dialog.
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Figure 57 Logged Data window

The Logged Data window is divided into three main sections: the readings grid, graphs, and 
statistics and alarms panel. These sections can be resized by dragging the bars that divide the 
sections.

The individual readings of the selected data can be viewed in the spreadsheet style grid in the 
upper section of the window. Use the scroll bars to scroll through the data. The displayed data 
consists of the date and time the readings were logged, the temperature and humidity readings 
(as applicable), the temperature and humidity alarm values (as applicable) and annotations. Col-
umns may be resized as desired. The readings are always ordered by date and time.

Temperature and humidity readings and their alarm values are displayed in the colors defined 
on the Graph tab of the LogWare III Options dialog. Temperature or humidity readings that 
exceed an alarm value are highlighted in the grid in the defined color. 

Annotations can be added to any temperature or humidity reading in the grid to indicate special 
conditions, occurrences, or events that can help identify specific points in the data by selecting 
the Annotations option in the Tools menu or by right-clicking on the readings grid to display the 
annotations popup menu. 

Figure 58 Logged Data Grid popup menu

The Annotation column of the grid displays annotation text that has been manually entered by 
a user or automatically entered by LogWare. LogWare allows an annotation to be added to each 
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temperature and/or humidity reading independently. Annotations for temperature readings are 
preceded with the label “T:” while annotations for humidity readings are preceded with the 
label “H:”. 

Other information may also be displayed in the Annotation column of the grid. For readings 
that were acquired after a sensor’s calibration date has passed, the Annotation column is high-
lighted and a message displayed. 

Figure 59 Logged Data Calibration Overdue Annotations

Info: Sensor calibration overdue annotations are only displayed if the Enable sensor 
calibration due notifications checkbox on the Real-Time tab of the LogWare III Options 
dialog is checked.

The data is also graphed. Temperature and humidity readings may be plotted on the same 
graph, or on separate graphs. You can zoom in on a small section of a graph by clicking on the 
graph and dragging the mouse to draw a box. When temperature and humidity readings are 
plotted on separate graphs, the zoom feature can be synchronized to cause both graphs to zoom 
to the same area. Refer to Section 3, LogWare III Options, for more information.

Graphs can be printed by selecting the Print | Graph option in the File menu or by selecting the 
Print Graph option in the Graph menu. If the temperature and humidity readings are displayed 
in separate graphs, the Select Graph To Print dialog is displayed. Select the graph(s) to print, 
then click the OK button to print the graph(s).

The graphs can also be configured to show alarm lines, annotations, and data point markers by 
selecting the appropriate options from the Graph menu.

When showing annotations on the graphs, there are two types of annotations displayed: Select-
ed data point and Data point annotation. The colors that are used to display these annotations 
are defined on the Graph tab of the LogWare III Options dialog. 

The Selected data point annotation indicates the currently selected row in the grid and 
consists of a dashed vertical line and the text indicating the date and time of the selected 
reading.

The Data point annotation indicates annotations manually added to readings or 
annotations that were automatically added by LogWare during a real-time log session 
(for example, when a sensor is detached from or attached to a logger channel). These 
annotations consist of a dashed vertical line and an asterisk (*). Refer to Section 9.1.3, 
Annotations, for more information on manually adding annotations to data points.

The right section of the Logged Data window shows the statistical calculations for the readings 
displayed in this window. Optionally, the alarm values may also be displayed in this area. The 
statistical calculations are always for all readings displayed. The alarm values are for the cur-
rently selected reading in the grid only. If the currently selected reading exceeds an alarm value, 
the alarm in this list is highlighted in a bold typeface.

●

●
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The statistical values displayed can be changed by right-clicking on any of the temperature or 
humidity nodes in the list. The Statistics Settings popup menu is displayed. 

Figure 60 Logged Data Statistics popup menu

Select the Statistics Settings option to change which statistical values as displayed.

Info: The sliding window feature of the statistics cannot be used when viewing logged 
data. This feature is only useful when logging data or monitoring logged data in 
real-time.

9.1.3	 Annotations
Annotations can be added to any temperature or humidity reading once it has been logged. 
Annotations are very useful for making notes about special conditions, occurrences, or events 
that can help identify specific points in the data. During real-time log sessions, LogWare may 
also automatically annotate certain readings, for example, when a sensor is detached from or 
attached to a logger channel.

Annotations can only be added to readings from a Logged Data window. To display data in a 
Logged Data window, select the Logged Data option in the View menu.

Annotations can be added to any temperature or humidity reading using the Annotations option 
in the Tools menu or by right-clicking on the readings grid to display the popup menu.

Figure 61 Annotations popup menu

 To add an annotation to a reading… 

Select the reading in the readings grid of a Logged Data window. 

Right-click on the grid and select Add Annotation from the popup menu or select Add 
from the Annotations sub-menu of the Tools menu to display the Add Annotation dialog.

1.

2.
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 Figure 62 Add Annotation dialog

3.	 Enter the annotation text for the temperature and/or humidity reading(s) and click 
OK. The annotation text should appear in the Annotation column in the readings grid. 
Temperature reading annotation text is preceded with the label “T:” and humidity reading 
annotation text is preceded with the label “H:”.

 Figure 63 Logged Data Annotations

 To edit/change an existing annotation… 

Select the reading containing the annotation in the readings grid of a Logged Data 
window. 

Right-click on the grid and select Edit Annotation from the popup menu or select Edit 
from the Annotations sub-menu of the Tools menu to display the Edit Annotation dialog. 
The current annotation text for the temperature and/or humidity reading(s) should be 
displayed.

1.

2.
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Figure 64 Edit Annotation dialog

3.	 Edit the annotation text for the temperature and/or humidity reading(s) and click OK. The 
new annotation text should appear in the Annotation column in the readings grid.

 To remove an annotation from a reading… 

1.	 Select the reading containing the annotation in the readings grid of a Logged Data 
window.

2.	 Right-click on the grid and select Remove Annotation from the popup menu or select 
Remove from the Annotations sub-menu of the Tools menu.

3.	 A confirmation prompt is displayed to remove the annotation text from the temperature 
and/or humidity reading(s) as applicable. Click Yes to remove the annotation(s).

9.2	 Exporting Logged Data
LogWare has a feature that allows logged data to be exported to a variety of file formats. Statis-
tics can also be calculated and exported with the data. 

 To export logged data… 

1.	 Select the Export option from the File menu to display the Export Logged Data Options 
dialog.

2.	 On the Export Options tab, select the appropriate settings for the data to be exported. 
Click the Select Fields to Export button to setup the fields to be exported.
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3.	 On the Criteria tab, select the data to be exported.

4.	 On the Misc. Settings tab, select other options related to how the data should be exported.

5.	 Click the OK button to begin the export process. 

6.	 The Export Filename dialog is displayed. Select the location and name of the export file 
and click OK.

7.	 The data will be exported to the indicated file.

Logged data displayed in a Logged Data window can also be exported. 

 To export logged data from a Logged Data window… 

1.	 Run LogWare and login using an account with at least restricted access.

2.	 Follow the steps to view the logged data in a Logged Data window.

3.	 With the Logged Data window active, select the Export option from the File menu to 
display the Export Logged Data Options dialog.

4.	 On the Export Options tab, select the appropriate settings for the data to be exported. 
Click the Select Fields to Export button to setup the fields to be exported.

5.	 On the Misc. Settings tab, select other options related to how the data should be exported.

6.	 Click the OK button to begin the export process. 

7.	 The Export Filename dialog is displayed. Select the location and name of the export file 
and click OK.

8.	 The data in the Logged Data window will be exported to the indicated file.

9.2.1	 Export Logged Data Options
The Export Logged Data Options dialog allows the user to choose the data to export and deter-
mine how it should be exported. This dialog is displayed when selecting the Export option from 
the File menu.
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Figure 65 Export Logged Data Options dialog

The Export Logged Data Options dialog has three tabs: Export Options, Criteria and Misc. 
Settings. If you are exporting data from a Logged Data window, only the Export Options tab is 
displayed.

Export Options

The Export Options tab contains various settings regarding how the data is to be exported.

The Export file type field determines the file type that the data is exported to. LogWare can 
export data to one of three file types:

Comma-separated values (csv)
Rich Text Format (rtf)
HTML document (html)

Each of these formats can be useful for different applications. If you want to import the data 
into a spreadsheet, the Comma-separated values (csv) option may be best. If you want to open 
the file in a word processor, use the Rich Text Format (rtf) option. If you want to share or e-
mail the data, the HTML document (html) option is probably the best choice. Select the type 
of file format you want the data to be exported to using the drop-down list.

The Export statistics summary after data option determines whether the calculated statistics for 
the selected data are exported at the end of the file. This option is disabled if the selected file 
format is Comma-separated values (csv).

●

●

●
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The Export out-of-tolerance statistics after data option determines whether the statistics regard-
ing what percentage of the readings in this data are “out of tolerance” (exceeded the alarm 
values) are exported at the end of the file. This option is disabled if the selected file format is 
Comma-separated values (csv).

The Font name and Size (points) settings determine the font to be used to export the report. 
Select the font and size that best suits your needs. These fields are disabled if the selected file 
format is Comma-separated values (csv).

Click the Select Fields to Export button to determine the data columns, column widths, and 
column order to use when exporting reports. Refer to Section 9.2.2, Export Fields, for more 
information on customizing the format of the data to export.

Criteria

The Criteria tab allows the user to select the data to be exported. This tab is not displayed when 
printing data from a Logged Data window.

Figure 66 Export Logged Data Options dialog - Criteria tab

When readings are logged in real-time or downloaded or imported, information about the log-
ger, sensor, location, and the method used to log the data are recorded with the data. To export 
data, you must indicate which readings you want to export. Readings can be selected in one 
of four ways: by location, sensor, real-time log session, or download/import session. Use the 
Select data for drop-down list to choose how you want to select the readings to export. When 
you select an option, the Matching drop-down list is populated with appropriate selection 
information.

Use the Matching drop-down list to select the appropriate item that matches the readings you 
want to export. The following table indicates the options and choices for selecting readings.
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Table 7 Export Logged Data Matching drop-down options

When the Select data for 
drop-down list is set to…

The Matching drop-down lists includes…

Location A list of all locations. Some locations may not have any 
logged data associated with them.

Sensor A list of all sensor assets. Some sensors may not have 
any logged data associated with them.

Real-Time Log Session A list of all complete real-time log sessions, sorted 
by location and date/time range of the logged data. 
Currently open (running) real-time log sessions are not 
displayed.

Imported/Downloaded Data A list of all import/download data sets, sorted by location 
and date/time range of the imported data.

The Date range fields are used to specify the date range of the readings to export. If you want 
to export all readings from the selected location or sensor, leave the Date range checkbox un-
checked. Otherwise, check this checkbox and select the from date and the to date. Setting these 
dates to the same date selects all of the readings from the selected location or sensor for that 
day. These fields are disabled when selecting data by Real-Time Log Session or by Imported/
Downloaded Data.

The Time range fields can be used to narrow down the range of the readings to export even 
more. To specify a time range, check the Time range checkbox, then select or enter the from 
time and the to time in the appropriate fields. These fields are also disabled when selecting data 
by Real-Time Log Session or by Imported/Downloaded Data.

Note: LogWare is designed to handle large amounts of data. However, be aware that 
querying and exporting such large sets of data may take a few minutes. Some computers 
may not be able to export large amounts of data in a reasonable amount of time. You may 
wish to break up the data into smaller chunks to be more efficient.

Misc. Settings

The Misc. Settings tab includes various options for determining how the data should be export-
ed. This tab is not displayed when printing data from a Logged Data window.
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Figure 67 Export Logged Data Options dialog - Misc Settings tab

The Temperature readings and Humidity readings checkboxes are disabled when exporting. To 
choose whether temperature or humidity readings are exported, click the Select Fields to Export 
button on the Export Options tab. Refer to Section 9.2.2, Export Fields, for more information 
on customizing the format of the data to export.

Select the temperature scale for temperature data using the Select temperature scale drop-down 
list. LogWare always records temperature readings in Celsius. Readings are converted to the 
desired scale for exporting.

The Reading resolutions fields indicate the number of decimal places to use to format the data. 
All readings are recorded using the resolution settings that were configured when the data was 
logged. Select the number of digits to use for temperature readings using the Temperature field 
and humidity readings using the Humidity field.

When all settings have been selected, click the OK button to export the selected data.  The Ex-
port Filename dialog is displayed. Choose the filename and folder to write the data to and click 
the Save button. 

9.2.2	 Export Fields
The Export Fields dialog is used to customize the fields to be exported. This dialog is displayed 
when clicking the Select Fields to Export button on Export Options tab of the Export Logged 
Data Options dialog.
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Figure 68 Export Fields dialog 

This dialog is used to determine which columns of data are exported, the order in which the 
columns are exported, and the width of each column.

Columns that are to be exported are indicated in the spreadsheet style grid with the symbol  
. Columns that are not to be exported are indicated with the symbol . To toggle the state 

of a column, click the column header. The symbol will change indicating the current state of the 
column.

To set the order to the columns to export, simply drag the column header to the new position 
and drop it.

To set the width of each column, use the Export column widths fields. Select the column in the 
list, then enter the width in the field provided. You can change the scale using the drop-down 
list. Supported scales are in (inches) and cm (centimeters). When switching scales, the column 
widths are automatically converted to the new scale. The total combined width of all columns is 
indicated below the list.

Info: Adjusting the width of the columns in the grid does not affect the width of the 
columns when exported. You must use the Export column widths fields to set the column 
widths.

To display a preview of the format of the exported data, click the Show Preview >> button. 
A prompt indicating the current settings must be saved is displayed. Click OK to display the 
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preview. The preview uses mock data, but uses the actual selected fields and column width 
settings. After changing a column width or fields to export, click the Update Preview button to 
apply the current settings to the preview.

9.3	 Printing Reports
LogWare has a feature that allows logged data to be printed in tabular format to a printer. Statis-
tics can also be calculated and printed with the data. 

To print a report for logged data…

1.	 Select the Print | Report option from the File menu to display the Print Logged Data 
Options dialog.

2.	 On the Print Options tab, select the appropriate settings for the data to be printed. Click 
the Select Fields to Print button to setup the fields to be printed.

3.	 On the Criteria tab, select the data to be printed.

4.	 On the Misc. Settings tab, select other options related to how the data should be printed.

5.	 Click the OK button to generate the report. 

6.	 The data will be printed to a report.

Logged data displayed in a Logged Data window can also be printed. 

To print a report for logged data from a Logged Data window… 

Follow the steps to view the logged data in a Logged Data window.

With the Logged Data window active, select the Print | Report option from the File menu 
to display the Print Logged Data Options dialog.

On the Print Options tab, select the appropriate settings for the data to be printed. Click 
the Select Fields to Print button to setup the fields to be printed.

Click the OK button to generate the report. 

The data from the Logged Data window will be printed to a report.

9.3.1	 Print Logged Data Options
The Print Logged Data Options dialog allows the user to choose the data to print and determine 
how it should be printed. This dialog is displayed when selecting the Print | Report option from 
the File menu.

1.

2.

3.

4.

5.
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Figure 69 Print Logged Data Options dialog

The Print Logged Data Options dialog has three tabs: Print Options, Criteria and Misc. Set-
tings. If you are printing a report of the data in a Logged Data window, only the Print Options 
tab is displayed.

Print Options

The Print Options tab contains various settings regarding how the data is to be printed.

The Margins options allow the print margins to use to be specified. Use the Top, Bottom, Left, 
and Right fields to set the margins to use. The Units drop-down list allows the units of measure 
to be selected. The choices are in (inches) and cm (centimeters).

The Paper Orientation options, Portrait and Landscape, determine the paper orientation to use 
when printing the report. Select the orientation to use.

The Select printer before printing report checkbox determines whether the Print dialog is 
displayed before the report is printed. This allows the printer to be selected. Unchecking this 
checkbox causes the report to be printed to the default printer.

The Preview report before printing checkbox determines whether the report is displayed on 
screen in the Print Preview window instead of being sent to the printer. Reports can be printed 
from the Print Preview window if desired. Refer to Section 9.3.3, Print Preview, for more 
information.
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The Print statistics summary at end of report checkbox determines whether the calculated sta-
tistics for the selected data are printed at the end of the report.

The Print out-of-tolerance statistics at end of report checkbox determines whether the statistics 
regarding what percentage of the readings in this report are “out of tolerance” (exceeded the 
alarm values) are printed at the end of the report.

The Font name and Size (points) settings determine the font to be used to print the report. Select 
the font and size that best suits your needs.

Click the Select Fields to Print button to determine the data columns, column widths, and col-
umn order to use when printing reports. Refer to Section 9.3.2, Print Fields, for more informa-
tion on customizing the format of the data to print.

Criteria

The Criteria tab allows the user to select the data to be printed. This tab is not displayed when 
printing data from a Logged Data window.

Figure 70 Print Logged Data Options dialog - Criteria tab

When readings are logged in real-time or downloaded or imported, information about the log-
ger, sensor, location, and the method used to log the data are recorded with the data. To print 
a report, you must indicate which readings you want to print. Readings can be selected in one 
of four ways: by location, sensor, real-time log session, or download/import session. Use the 
Select data for drop-down list to choose how you want to select the readings to print. When 
you select an option, the Matching drop-down list is populated with appropriate selection 
information.
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Use the Matching drop-down list to select the appropriate item that matches the readings you 
want to print. The following table indicates the options and choices for selecting readings.

Table 8 Print Logged Data Matching drop-down options

When the Select data for 
drop-down list is set to…

The Matching drop-down lists includes…

Location A list of all locations. Some locations may not have any logged data 
associated with them.

Sensor A list of all sensor assets. Some sensors may not have any logged 
data associated with them.

Real-Time Log Session A list of all complete real-time log sessions, sorted by location and 
date/time range of the logged data. Currently open (running) real-time 
log sessions are not displayed.

Imported/Downloaded Data A list of all import/download data sets, sorted by location and date/time 
range of the imported data.

The Date range fields are used to specify the date range of the readings to print. If you want to 
print all readings from the selected location or sensor, leave the Date range checkbox un-
checked. Otherwise, check this checkbox and select the from date and the to date. Setting these 
dates to the same date selects all of the readings from the selected location or sensor for that 
day. These fields are disabled when selecting data by Real-Time Log Session or by Imported/
Downloaded Data.

The Time range fields can be used to narrow down the range of the readings to print even more. 
To specify a time range, check the Time range checkbox, then select or enter the from time and 
the to time in the appropriate fields. These fields are also disabled when selecting data by Real-
Time Log Session or by Imported/Downloaded Data.

Note: LogWare is designed to handle large amounts of data. However, be aware that 
querying and printing such large sets of data may take a few minutes. Some computers 
may not be able to print large amounts of data in a reasonable amount of time. You may 
wish to break up the data into smaller chunks to be more efficient.

Misc Settings

The Misc. Settings tab includes various options for determining how the data should be printed. 
This tab is not displayed when printing data from a Logged Data window.
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Figure 71 Print Logged Data Options dialog - Misc Settings tab

The Temperature readings and Humidity readings checkboxes are disabled when printing re-
ports. To choose whether temperature or humidity readings print on the report, click the Select 
Fields to Print button on the Print Options tab. Refer to Section 9.3.2, Print Fields, for more 
information on customizing the format of the data to print.

Select the temperature scale for temperature data using the Select temperature scale drop-down 
list. LogWare always records temperature readings in Celsius. Readings are converted to the 
desired scale for printing.

The Reading resolutions fields indicate the number of decimal places to use to format the data. 
All readings are recorded using the resolution settings that were configured when the data was 
logged. Select the number of digits to use for temperature readings using the Temperature field 
and humidity readings using the Humidity field.

When all settings have been selected, click the OK button to print the selected data.  Below is 
an example page of a printed report:
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Figure 72 Example report

9.3.2	 Print Fields
The Print Fields dialog is used to customize the fields to be printed on a report. This dialog 
is displayed when clicking the Select Fields to Print button on Print Options tab of the Print 
Logged Data Options dialog.
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Figure 73 Print Fields dialog

This dialog is used to determine which columns of data print on reports, the order in which the 
columns are printed, and the width of each column.

Columns that are to be printed on the report are indicated in the spreadsheet style grid with the 
symbol . Columns that are not to be printed on the report are indicated with the symbol . 
To toggle the state of a column, click the column header. The symbol will change indicating the 
current state of the column.

To set the order to the columns to print, simply drag the column header to the new position and 
drop it.

To set the printed width of each column, use the Print column widths fields. Select the column 
in the list, then enter the width in the field provided. You can change the scale using the drop-
down list. Supported scales are in (inches) and cm (centimeters). When switching scales, the 
column widths are automatically converted to the new scale. The total combined width of all 
columns is indicated below the list.

Info: Adjusting the width of the columns in the grid does not affect the printed width of 
the columns on the report. You must use the Print column widths fields to set the column 
widths.

To display a preview of the format of the printed report, click the Show Preview >> button. 
A prompt indicating the current settings must be saved is displayed. Click OK to display the 
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preview. The preview uses mock data, but uses the actual selected fields and column width set-
tings. After changing a column width or fields to print, click the Update Preview button to apply 
the current settings to the preview.

9.3.3	 Print Preview
The Print Preview window is used to view reports on screen without having to print a hard 
copy. This window is displayed when printing reports and the preview setting is enabled.

Figure 74 Print Preview window

The Print Preview window toolbar provides buttons to close the window, open and save reports 
to files, open the help file, navigate through all of the pages of the report, zoom in and out, and 
print the report. 



9936A LogWare III
Users Guide

136

Info: Printing a report from the Print Preview window always displays the Select Printer 
dialog, regardless of the setting selected when the report was generated.

Reports can be saved to a report file (.RPT file). However, these files have a proprietary format 
and cannot be opened or viewed by other applications. Report files can only be opened and 
printed from the Print Preview window itself. If you need to share a report with others in a stan-
dard file format such as HTML (.HTM file) or RTF (.RTF file), use LogWare’s Export feature to 
export the data to a standard format file. Refer to Section 9.2, Exporting Logged Data, for more 
information.
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10	 Management Features
LogWare includes many tools for managing logged data and other information. Using manage-
ment features typically requires logging in as an administrator. The following sections describe 
how to use each of the management features in LogWare.

10.1	 Managing Licenses
Access to LogWare is controlled using licenses. A license grants one user the right to connect to 
LogWare’s data storage system on the server. LogWare is designed to allow multiple concurrent 
users to connect, but each user requires a license. 

For stand-alone, single-user configurations, LogWare only supports one concurrent user, there-
fore only one license is required. For client/server, multi-user configurations, LogWare requires 
one license for every concurrent user. LogWare does not limit the number of licenses that 
may be applied to a system, but practical limits exist (based on the processor speed, available 
memory, etc.) of the server computer.

When purchased, LogWare comes with one license. Additional licenses must be purchased 
separately if needed. Licenses are sold individually and in packs (5 pack, 10 pack, etc.). A site 
license is also available. 

When LogWare is installed as a demo, two time-limited demo licenses are automatically 
installed. These licenses allow up to 2 concurrent users to connect to the system. The demo 
licenses are valid for up to 50 total logins (maximum 25 logins for each user) or for 2 months 
from the date of installation, whichever comes first. At that time, the demo licenses will expire 
and will no longer permit logins. This allows LogWare to be evaluated for a period of time 
without having to purchase the software. Valid licenses must be purchased and applied to the 
system to continue using LogWare. 

When purchasing the software, you will be provided with a serial number and one license. 
Additional licenses may also be purchased if needed. The serial number acts as a proof-of-pur-
chase and must be used in order to apply licenses to the system.

Note: Before installing LogWare, be sure to read Section 13, Appendix A, License 
Agreement, and the Warranty Information.

 To apply new licenses to the system… 

Login to Windows® using an account with Power User or better access rights.

Run LogWare. The LogWare User Login dialog is displayed. 

Login to LogWare using an account with administrator permissions.

Select the Manage Licenses option from the Tools menu to display the Manage Licenses 
dialog.

Click the Add button.

If LogWare was installed as a demo, the Serial Number dialog is displayed. Enter the 
software serial number and click OK. The software serial number is provided when the 

1.

2.

3.

4.

5.

6.



9936A LogWare III
Users Guide

138

software is purchased. If the software has not been purchased, you cannot apply licenses 
to the system.

Once a valid serial number has been entered, or if the serial number was previously 
entered, the Open License File dialog is displayed. 

Insert the USB drive (or other media) containing the license file and navigate to the 
folder containing the license file.

Select the license file and click the Open button. The license file is opened, validated, and 
applied to the system.

The new licenses appear in the list on the Manage Licenses dialog.

To apply licenses when all existing licenses have expired…

Login to Windows® using an account with Power User or better access rights.

Run LogWare. If no valid or non-expired licenses are found in the system, a message is 
displayed.

If LogWare was installed as a demo, the Serial Number dialog is displayed. Enter the 
software serial number and click OK. The software serial number is provided when the 
software is purchased. If the software has not been purchased, you cannot apply licenses 
to the system.

Once a valid serial number has been entered, or if the serial number was previously 
entered, the Open License File dialog is displayed. 

Insert the USB drive (or other media) containing the license file and navigate to the 
folder containing the license file.

Select the license file and click the Open button. The license file is opened, validated, and 
applied to the system.

LogWare then displays the LogWare User Login dialog to login to the server.

Info: Once valid licenses have been applied to the system, all demo licenses can be 
removed. The demo licenses can continue to be used to login until they expire, however 
messages will be displayed during the login process indicating demo licenses are being 
used.

 To remove licenses from the system… 

Run LogWare. The LogWare User Login dialog is displayed. 

Login to LogWare using an account with administrator permissions.

Select the Manage Licenses option from the Tools menu to display the Manage Licenses 
dialog.

On the Licenses tab, select the type of license to remove.

Click the Remove button to display the Remove Licenses dialog.

On the Licenses tab, select the license(s) to remove and click the Remove button. A 
prompt is displayed to confirm removing the selected license(s). Click Yes to confirm 
removing the license(s).
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10.1.1	 Manage Licenses
The Manage Licenses dialog allows the user to manage system licenses. This dialog is dis-
played when selecting the Manage Licenses option from the Tools menu.

Figure 75 Manage Licenses dialog

Licenses are used to control access to the server. LogWare supports multiple types of licenses: 
Demo, Typical, and Site license. A description of each license type follows. 

The Licenses tab displays a list of all installed licenses, grouped by license type. Beneath the 
list is an indication of the total number of licenses available and the current number of licenses 
in use. 

Demo license

A demo license allows full access to the system for a limited time. When LogWare is installed 
as a demo, two demo licenses are automatically applied to the system. These demo licenses 
allow up to 2 concurrent logins to the system for up to 50 total logins (maximum of 25 logins 
for each user). Demo licenses automatically expire two months from the date of installation. 
LogWare may be used in its entirety until demo licenses expire. At that time, the software must 
be purchased to continue using LogWare.

Typical license

A typical license allows one user to connect to the system. One typical license is included 
with LogWare when it is purchased. For client/server, multi-user configurations, one license is 
required for each concurrent user. Typical licenses can be shared by multiple users, but only one 
user can use a license at a time. Typical licenses are recommended for client/server, multi-user 
configurations where there are fewer than 20 concurrent users. 

Site license

A site license allows an unlimited number of users to connect to the system. Site licenses are 
recommended for client/server, multi-user configurations where there is likely to be more than 
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20 regular concurrent users, or in a situation where a temporary need may arise for many con-
current users.

To apply new licenses to the system, click the Add button. If LogWare was installed as a demo, 
the Serial Number dialog is displayed. Refer to Section 10.1.1.3, Serial Number, for more in-
formation. In order to apply licenses, you must purchase LogWare. A serial number is provided 
when LogWare is purchased. Enter the serial number and click OK to display the Open License 
File dialog. Insert the USB drive (or other media) containing the license file, navigate to the 
folder, select the license file, and click Open. The new license(s) are displayed in the list.

Info: When unplugging a USB drive, be sure to use the Safely Remove Hardware feature 
of Windows® before unplugging the drive to prevent possible file corruption.

To remove a license from the system, select the type of license in the list and click the Remove 
button. The Remove License dialog is displayed with an itemized list of all of the selected type 
of licenses currently in the system. Select the license(s) to remove and click the Remove button. 
A prompt is displayed to confirm removing the license(s). Click the Yes button to remove the 
license(s).

To view the details of a license, select the license in the list and click the Properties button. The 
license details are displayed on the License Properties dialog.

10.1.1.1	Licenses Properties

The License Properties dialog displays detailed information for a specific type of license. This 
dialog is displayed when the Properties button on the Manage Licenses dialog is clicked.

Figure 76 License Properties dialog

License details are indicated in the list on the Licenses tab. Details include date applied, license 
serial number, and the maximum software version with which the license may be used.
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For demo licenses only, the number of logins remaining is also displayed. Demo licenses auto-
matically expire after a specific number of logins or two months from the date of application, 
whichever comes first.

10.1.1.2	Remove License 

 The Remove Licenses dialog displays detailed information for a specific type of license to 
be removed. This dialog is displayed when the Remove button on the Manage Licenses dialog is 
clicked.

Figure 77 Remove Licenses dialog

License details are indicated in the list on the Licenses tab. Details include date applied, license 
serial number, and the maximum software version with which the license may be used.

For demo licenses only, the number of logins remaining is also displayed. Demo licenses auto-
matically expire after a specific number of logins or two months from the date of application, 
whichever comes first.

To remove one or more licenses from the system, select the appropriate item(s) in the list and 
click the Remove button. A prompt is displayed to confirm removing the selected license(s). 
Click Yes to remove the selected license(s).

Info: If a license is currently in use, it cannot be removed from the system. To remove a 
license, you must wait until the license is no longer in use. Since a connection to the 
system is required to remove licenses, it is impossible to remove all licenses from the 
system.

10.1.1.3	Serial Number

The Serial Number dialog allows the user to enter the software serial number that was provided 
when the software was purchased. This dialog is displayed when attempting to apply licenses to 
the system.
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Figure 78 Serial Number dialog

Enter the serial number in the boxes provided. If you do not have a serial number, you must 
purchase LogWare. A serial number is provided upon purchase.

10.2	 Managing Assets and Locations
Whenever LogWare records data, whether in real-time or by importing or downloading, Log-
Ware also records information about the assets (loggers and sensors) and locations associated 
with the data.

LogWare administrators can manage the assets and locations, including deactivating them to 
prevent them from being used to log data in real-time or to prevent data associated with them 
from being imported or downloaded.

 To add new assets (loggers and sensors) … 

Assets cannot be manually added to LogWare. Instead, LogWare automatically adds the assets 
as needed when configuring a real-time log session or when downloading or importing logged 
data.

 To manage assets (loggers and sensors) … 

Select the Manage Assets and Locations option from the Tools menu to display the 
Manage Assets and Locations dialog.

Select either the Loggers or Sensors tab and select the asset to manage.

To delete an asset, click the Remove button. To change an asset’s settings, click the 
Settings button to display the Logger Asset Settings or Sensor Asset Settings dialog.

1.

2.

3.
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Asset model and serial numbers cannot be changed. To activate or deactivate an asset, 
check or uncheck the Active checkbox. Enter remarks for the asset if desired. Click OK 
to close the dialog.

 To add new locations … 

Select the Manage Assets and Locations option from the Tools menu to display the 
Manage Assets and Locations dialog.

On the Locations tab, click the New button to display the New Location Settings dialog.

Enter a unique location name and remarks for the new location. To make this location 
active, make sure the Active checkbox is checked. Click OK to create the new location.

The new location appears in the Locations list.

 To manage locations …

Select the Manage Assets and Locations option from the Tools menu to display the 
Manage Assets and Locations dialog.

Select the Locations tab and select the location to manage.

To delete a location, click the Remove button. To change a location’s settings, click the 
Settings button to display the Location Settings dialog.

The location name cannot be changed. To activate or deactivate a location, check or 
uncheck the Active checkbox. Enter remarks for the location if desired. Click OK to close 
the dialog.

10.2.1	 Manage Assets and Locations
 The Manage Assets and Locations dialog allows the user to manage and control which as-

sets (loggers and sensors) and locations can be used to log data. This dialog is displayed when 
selecting the Manage Assets and Locations option from the Tools menu. 
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Figure 79 Manage Assets and Locations dialog

The Manage Assets and Locations dialog has three tabs: Loggers, Sensors, and Locations. 

Loggers

The Loggers list displays the model and serial number all logger assets that have been used. 
Logger assets are automatically added to the system when configuring a real-time log session or 
the first time data is imported or downloaded from a logger. If the logger is currently inactive, 
the word “Inactive” appears in the list next to the item. LogWare does not allow real-time log 
sessions to be run using inactive assets. LogWare also prevents data from being imported or 
downloaded from inactive assets.
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Figure 80 Manage Assets and Locations dialog - Loggers tab

 To remove a logger asset, select the logger to remove and click the Remove button. A 
prompt is displayed to confirm removing the logger. Click Yes to remove the logger.

Note: Removing a logger asset from the system will permanently prevent LogWare from 
accepting any logged data from that asset, whether by logging in real-time or by 
downloading or importing. You should only remove assets that are no longer in service. 
To prevent data from being logged from a logger asset temporarily, uncheck the Active 
checkbox on the Logger Asset Settings dialog instead of removing the asset.

 To change logger asset settings, select the logger from the Loggers list and click the Settings 
button to display the Logger Asset Settings dialog. Refer to Section 10.2.1.1, Logger Asset Set-
tings, for more information.

Sensors

The Sensors list displays the model and serial number all sensor assets that have been used. 
Sensor assets are automatically added to the system when configuring a real-time log session, 
or the first time data is imported or downloaded from a logger. If the sensor is currently inac-
tive, the word “Inactive” appears in the list next to the item. LogWare does not allow real-time 
log sessions to be run using inactive assets. LogWare also prevents data from being imported or 
downloaded from inactive assets.
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Figure 81 Manage Assets and Locations dialog - Sensors tab

 To remove a sensor asset, select the sensor to remove and click the Remove button. A 
prompt is displayed to confirm removing the sensor. Click Yes to remove the sensor.

Note: Removing a sensor asset from the system will permanently prevent LogWare from 
accepting any logged data from that asset, whether by logging in real-time or by 
downloading or importing. You should only remove assets that are no longer in service. 
To prevent data from being logged from a sensor asset temporarily, uncheck the Active 
checkbox on the Sensor Asset Settings dialog instead of removing the asset.

 To change sensor asset settings, select the sensor from the Sensors list and click the Settings 
button to display the Sensor Asset Settings dialog. Refer to Section 10.2.1.2, Sensor Asset Set-
tings, for more information.

Locations

The Locations list displays all locations that have been used. Locations are automatically added 
to the system when configuring a real-time log session, or the first time data is imported or 
downloaded from a logger. Locations may also be manually added to the system. If the location 
is currently inactive, the word “Inactive” appears in the list next to the item. LogWare does not 
allow real-time log sessions to be run using inactive locations. LogWare also prevents data from 
being imported or downloaded from inactive locations.

Info: LogWare uses the ID field of the sensor to store the location name associated with 
the sensor. This allows the location name to appear on the display of the logger. For this 
reason, whatever text is in the ID field of the sensor when you attempt to setup a real-time 
log session (or import or download logged data) will be added to the system as a 
location. 
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Figure 82 Manage Assets and Locations dialog - Locations tab

 To manually create a new location, click the New button to display the New Location Set-
tings dialog.

 To remove a location, select the location to remove and click the Remove button. A prompt 
is displayed to confirm removing the location. Click Yes to remove the location.

Note: Removing a location from the system will permanently prevent LogWare from 
accepting any logged data from that location, whether by logging in real-time or by 
downloading or importing. You should only remove locations that are no longer needed. 
To prevent data from being logged from a location temporarily, uncheck the Active 
checkbox on the Location Settings dialog instead of removing the location.

 To change location settings, select the location from the Locations list and click the Settings 
button to display the Location Settings dialog. Refer to Section 10.2.1.3, Location Settings, for 
more information.

10.2.1.1	Logger Asset Settings

The Logger Asset Settings dialog allows the user to manage logger assets. This dialog is 
displayed by clicking the Settings button on Loggers tab of the Manage Assets and Locations 
dialog.
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Figure 83 Logger Asset Settings dialog

The model, serial number, state, and remarks are shown for the logger. By default, when a log-
ger is added to the system, it is marked as active. 

The Model and Serial number fields indicate the model and serial number of the logger and are 
not editable. 

The Active checkbox indicates the current state of this logger. If a logger is active, LogWare is 
allowed to log data in real-time using this logger and data from this logger may be downloaded 
or imported into the system.

 To prevent a logger from being used to log real-time data and prevent data from a logger 
from being imported or downloaded, uncheck the Active checkbox.

The Remarks field is automatically populated with the date and time the logger asset was added 
to the system. The Remarks field can be changed as desired.

10.2.1.2	Sensor Asset Settings

The Sensor Asset Settings dialog allows the user to manage sensor assets. This dialog is 
displayed by clicking the Settings button on Sensors tab of the Manage Assets and Locations 
dialog.
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Figure 84 Sensor Asset Settings dialog

The model, serial number, state, and remarks are shown for the sensor. By default, when a sen-
sor is added to the system, it is marked as active. 

The Model and Serial number fields indicate the model and serial number of the sensor and are 
not editable. 

The Active checkbox indicates the current state of this sensor. If a sensor is active, LogWare is 
allowed to log data in real-time using this sensor and data from this sensor may be downloaded 
or imported into the system.

 To prevent a sensor from being used to log real-time data and prevent data from a sensor 
from being imported or downloaded, uncheck the Active checkbox.

The Remarks field is automatically populated with the date and time the sensor asset was added 
to the system. The Remarks field can be changed as desired.

10.2.1.3	Location Settings

The Location Settings dialog allows the user to manage locations. This dialog is displayed by 
clicking either the Settings or New button on the Locations tab of the Manage Assets and Loca-
tions dialog.
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Figure 85 Location Settings dialog

The location name, state, and remarks are shown for the location. By default, when a new loca-
tion is added to the system, it is marked as active. 

When adding a new location to the system manually, enter a unique name for this location in 
the Location name field. When managing an existing location, the Location name field is not 
editable. 

Info: Because LogWare stores the location name information in the ID field of the sensor, 
location names are limited to 16 characters in length, and can only consist of numbers (0-
9), uppercase letters (A-Z), and/or any of the following characters: - + . < > @ ! # $ % & 
^ _ | ~

The Active checkbox indicates the current state of this location. If a location is active, LogWare 
is allowed to log data in real-time using this location and data associated with this location may 
be downloaded or imported into the system. 

 To prevent a location from being used to log real-time data and prevent data from a location 
from being imported or downloaded, uncheck the Active checkbox.

The Remarks field is automatically populated with the date and time the location was added to 
the system. The Remarks field can be changed as desired.

10.3	 Managing Log Sessions
The primary purpose of LogWare is to log data in real-time and allow others to remotely moni-
tor the real-time data as it is being logged.
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In order for this to happen, LogWare must keep track of all the real-time log sessions that are 
currently running on the system. When starting a remote monitoring session, LogWare can then 
display a list of all locations where real-time data is currently being logged.

During a real-time log session, certain events can occur that prevent LogWare from obtain-
ing readings from a logger or sensor for a period of time. LogWare will, however, continue to 
attempt to query the logger for readings as long as the real-time log session is running. Such 
events may include, but are not limited to:

Power was disconnected from the logger

Logger’s power switch was turned off

Communications cable was disconnected from the logger

Sensor is unplugged from logger channel

LogWare client computer loses network connection

LogWare client computer shuts down unexpectedly (power outage, application error, etc)

If LogWare is unable to obtain readings from a logger for 10 consecutive attempts (logging 
interval periods), the log session is marked as appearing to be inactive. 

In the case of a LogWare client computer shutting down unexpectedly, the system still indicates 
real-time log sessions are running because the log sessions were not terminated properly. Since 
LogWare only allows one real-time log session to be run against each logger, a new real-time 
log session cannot be started until the previous log session is closed. The Manage Log Sessions 
dialog allows these inactive log sessions to be closed manually.

Info: LogWare also has a feature that forces log sessions that have been inactive for a 
specified amount of time to be closed automatically. These settings are found on the Misc 
tab of the LogWare III Options dialog. Also, if LogWare is configured to login and start 
real-time log sessions automatically on startup, inactive log sessions will be closed 
automatically to allow the new real-time log session to start.

 To close a log session… 

Select the Manage Log Sessions option from the Tools menu to display the Manage Log 
Sessions dialog.

A list of all currently running real-time log sessions is displayed.

Select the log session to close and click the Close Selected Log Session button. 

Note: Closing a log session using this dialog will terminate the real-time log session!!

 To close all inactive log sessions… 

Select the Manage Log Sessions option from the Tools menu to display the Manage Log 
Sessions dialog.

A list of all currently running real-time log sessions is displayed.

Click the Close All Inactive Log Sessions button. 

●

●

●

●

●

●

1.

2.

3.

1.

2.

3.
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10.3.1	 Manage Log Sessions
 The Manage Log Sessions dialog allows the user to manage real-time log sessions. This 

dialog is displayed when selecting the Manage Log Sessions option from the Tools menu. 

Figure 86 Manage Log Sessions dialog

The Current sessions list indicates each location of all currently running real-time log sessions. 
Select a log session from the list to view the details of the log session. The details of the log 
session are displayed in the list to the right of the Current sessions list. When a real-time log 
session is terminated normally, it no longer appears in this list.

If LogWare has been unable to obtain readings from a location for a period of time, the item 
is highlighted in bold red text in the Current sessions list and a bold red label appears above 
the details list when the item is selected. The log session is considered to be currently inactive. 
In the case of a LogWare client computer shutting down unexpectedly, the system still indi-
cates real-time log sessions are running because the log sessions were not terminated properly. 
However, these log sessions will likely appear as being inactive because LogWare is no longer 
obtaining new readings. Since LogWare only allows one real-time log session to be run against 
each logger, a new real-time log session cannot be started until the previous log session is 
closed. 

To close an inactive log session, select the log session from the Current sessions list and click 
the Close Selected Log Session button. Although active log sessions may also be closed, closing 
active log sessions is not recommended.

Note: Closing a log session using this dialog will terminate the real-time log session!! 

The time period used by LogWare to determine if a log session appears to be inactive is based 
on the logging interval (Interval) and the Last update date/time stamp as indicated in the log 



153

10 Management Features

session details list: if 10 times the logging interval has elapsed since the last update, the log ses-
sion is considered to be inactive. For example, if the logging interval is 2 minutes, and the last 
update date/time stamp is older than 20 minutes (10 x 2 minutes), the log session is considered 
to be inactive. 

Info: LogWare also has a feature that forces log sessions that have been inactive for a 
specified amount of time to be closed automatically. These settings are found on the Misc 
tab of the LogWare III Options dialog. Also, if LogWare is configured to login and start 
real-time log sessions automatically on startup, inactive log sessions will be closed 
automatically to allow the new real-time log session to start.

To close all currently inactive log sessions, click the Close All Inactive Log Sessions button. 

The information on this dialog is read in at the time the dialog is opened. If this dialog is left 
open for a long period of time, the information becomes outdated. To refresh the information, 
click the Refresh button. 

10.4	 Deleting Log Sessions
The primary purpose of LogWare is to log data in real-time. LogWare also allows data to be 
downloaded and imported from a logger. LogWare stores all logged, downloaded, and imported 
data in its data storage system on the server. Once data is written to the server, LogWare does 
not allow the data to be altered. Data may, however, be removed from the server by an adminis-
trator if needed. 

LogWare only allows data to be deleted from the server for an entire real-time log session or 
download/import session. Individual data points or ranges of data points cannot be removed. 
This is intended to prevent unauthorized tampering of the data by removing, for example, only 
data points that fell outside of alarm limits.

Note: Deleting log session data from the server is permanent! Deleted data cannot be 
recovered. Be very careful when using this feature not to inadvertently delete the wrong 
data. As a precaution, LogWare displays prompts to confirm the deletion of data prior to 
performing the operation. Also, make sure the LogWare server is properly maintained and 
backed up regularly. Refer to Section 11, Maintenance, for more information.

 To delete data for a log session… 

Select the Delete Log Sessions option from the Tools menu to display the Delete Log 
Sessions Options dialog.

On the Criteria tab, select the log session to delete.

Click the OK button to delete the data for the log session. 

10.4.1	 Delete Log Sessions Options
The Delete Log Sessions Options dialog allows the user to select the log session to be deleted. 
This dialog is displayed when selecting the Delete Log Sessions option from the Tools menu.

1.

2.

3.
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Figure 87 Delete Log Sessions Options dialog

LogWare distinguishes between data logged in real-time and data that was downloaded or 
imported into the server. Use the Select data for drop-down list to choose the method that was 
used to log the data that is to be deleted. When you select an option, the Matching drop-down 
list is populated with appropriate selection information.

Note: In order to maintain the integrity of the data, for real-time log sessions where data 
was logged from both sensors, or for downloaded or imported data where data from both 
sensors was imported, LogWare does not allow data from only one of the sensors to be 
deleted. Data for BOTH sensors will be deleted. 

Use the Matching drop-down list to select the appropriate item that matches the data you want 
to delete. The following table indicates the options and choices for selecting data.

Table 9 Delete Log Sessions Matching drop-down options

When the Select data for 
drop-down list is set to…

The Matching drop-down lists includes…

Real-Time Log Session A list of all complete real-time log sessions, sorted by 
location and date/time range of the logged data. Currently 
open (running) real-time log sessions are not displayed.

Imported/Downloaded Data A list of all import/download data sets, sorted by location 
and date/time range of the imported data.
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Note: Deleting log session data from the server is permanent! Deleted data cannot be 
recovered. Be very careful when using this feature not to inadvertently delete the wrong 
data. As a precaution, LogWare displays prompts to confirm the deletion of data prior to 
performing the operation. Also, make sure the LogWare server is properly maintained and 
backed up regularly. Refer to Section 11, Maintenance, for more information.

When the appropriate selections are made, click the OK button to continue. The Confirm Delet-
ing Log Session dialog is displayed to confirm the deletion of the selected data. You must check 
the checkbox and click the OK button for LogWare to delete the selected data. Leaving the 
checkbox unchecked or clicking the Cancel button aborts the deletion process.

Figure 88 Confirm Deleting Log Session prompt

Note: LogWare is designed to handle large amounts of data. However, be aware that 
deleting large sets of data may take a few minutes. LogWare displays a warning message 
when a large data set is selected indicating the allotted time for the delete process may be 
exceeded. The delete process should succeed even if the allotted time is exceeded.
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11	 Maintenance 
It is important to regularly backup your system to minimize the loss of data in the event of 
unforeseen problems, such as virus infections, hardware failures, and malicious and accidental 
activities.

LogWare stores all logged data, asset and location information, software licenses, user ac-
counts, and other information in a database. For stand-alone, single-user configurations, the 
data resides on the computer on which LogWare is running. For client/server, multi-user con-
figurations, the data resides on the computer designated as the server. LogWare is isolated from 
the database and never interfaces directly with it. Instead, LogWare relies on an open source 
application server, JBoss® , to interface with the database. LogWare communicates with the ap-
plication server using an open source SOAP library, pocketSOAP®. The database the applica-
tion server currently interfaces with is an open source database, PostgreSQL®

11.1	 Database Maintenance
When LogWare’s server files were installed, an administrative account was automatically cre-
ated for accessing the database. Also installed were a set of tools for maintaining the Post-
greSQL® database. It is strongly recommended that the administrator of the LogWare system 
review the PostgreSQL® documentation and become familiar with the database maintenance 
utilities and backup capabilities. Regular maintenance of the database can reduce the chance of 
problems and keep the size of the database operating as efficiently as possible.

Server Operation
The computer designated as the server for LogWare is required to run a couple of services. 
These services allow LogWare to communicate with the data storage system on the server. 
Communication is handled through a TCP port on the server. If the server computer has firewall 
software installed, the firewall must be configured to allow communications on the TCP port. 
For more information on these services and other server related settings, refer to Section 1.6, 
Installation. 
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12	 Technical Support
Please contact one of the following authorized Service Centers to coordinate service on your 
product:

Fluke Corporation 
Hart Scientific Division
799 E. Utah Valley Drive
American Fork, Utah 84003-9775
USA
Phone: +1.801.763.1600
Toll Free: +1.800.438.4278
Fax: +1.801.763.1010
E-mail: support@hartscientific.com

Fluke Nederland B.V.
Customer Support Services
Science Park Eindhoven 5108
5692 EC Son
NETHERLANDS
Phone: +31-402-675300
Telefax: +31-402-675321
E-mail: ServiceDesk@fluke.nl

Fluke Int’l Corporation
Service Center - Instrimpex
Room 2301 Sciteck Tower
22 Jianguomenwai Dajie
Chao Yang District
Beijing 100004, PRC
CHINA
Phone: +86-10-6-512-3436
Telefax: +86-10-6-512-3437
E-mail: xingye.han@fluke.com.cn

Fluke South East Asia Pte Ltd.
Fluke ASEAN Regional Office
Service Center
60 Alexandra Terrace #03-16
The Comtech (Lobby D)
118502
SINGAPORE
Phone: +65-737-2922
Telefax: +65-737-5155
E-mail: antng@singa.fluke.com
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Check our website on the Internet regularly for answers to Frequently Asked Questions, soft-
ware updates, and Service Releases.

Before contacting Technical Support, check the items listed below to see if the problem you are 
having can be resolved by information contained in these sections:

Requirements - Section 1.5

Installation - Section 1.6

Running LogWare - Section 1.7

Security - Section 2

Administration - Section 2.1

User Account - Section 2.2

When calling or sending a fax, please send or have the following information ready:

Name of the software (LogWare III)

Software version (as found on the Help | About dialog)

Detailed description of the problem

What the software was doing when the problem arose

The exact wording and/or number of any error message received

Any other information that may help to solve the problem

●

●

●

●

●

●

●

●

●

●

●

●
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13	 Appendix A – License Agreement
The enclosed software product (Software) is furnished subject to the terms and conditions of 
this agreement. Retention of the software product for more than thirty days, opening the sealed 
wrapper surrounding the product, or use of the product in any manner will be considered ac-
ceptance of the agreement terms. If these terms are not acceptable, the unused product and any 
accompanying written material should be returned promptly to Fluke or the place of purchase 
for a full refund of the license fee paid.

GRANT OF LICENSE
Fluke Corporation, through its Hart Scientific division (Hart) grants you the right to use the 
Software in accordance with the terms of this EULA. This grant of license does not include the 
right to modify or distribute the Software.

RESTRICTIONS
You may install the server portion of the Software (application server and database) on 
one computer. 

You may install the client portion of the Software (LogWare) on multiple computers. 

You may not reverse engineer, decompile, or disassemble the Software.

If the Software is an update, any transfer by you must include the update and all prior 
versions.

You may use the Software only in conjunction with the Hart products for which it is 
intended.

You may not export or re-export the Software to any country to which such export or 
re-export is restricted by law or regulation of the United States, or any other government 
having jurisdiction, without prior permission from Hart.

TITLE
The Software is owned by Hart or its suppliers and is protected by United States copyright laws 
and international treaty provisions. Therefore, except for the rights granted to you above, you 
must treat the Software like any other copyrighted material.

TERM
This license agreement is effective upon your acceptance and shall remain in effect until termi-
nated by (a) written notification to Hart or (b) a failure on your part to comply with the license 
agreement. Upon termination of the license agreement, you shall return to Hart or destroy all 
copies of the Software and associated written materials.

OTHER AGREEMENTS
Where terms or conditions of this agreement conflict with terms or conditions of other agree-
ments, this agreement supersedes other agreements.

●

●

●

●

●

●
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LIMITED WARRANTY
Hart warrants that the Software will perform in its intended environment substantially in accor-
dance with the accompanying written materials for a period of 90 days from the date of license 
acceptance. Hart further warrants that the original copy of the Software has been recorded on 
non-defective media. Hart does not warrant that the Software will be error free or operate with-
out interruption.

REMEDIES
Hart’s entire liability and your exclusive remedy shall be at Hart’s option, (a) the return of the 
price paid for the Software, or (b) repair or replacement of the Software that does not meet the 
limited warranty. This limited warranty is void if failure of the product has resulted from ac-
cident, abuse, or misapplication. Any replacement Software will be warranted for the remained 
of the 90-day original warranty period or 30 days, whichever is longer.

NO OTHER WARRANTIES
HART DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED BUT 
NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE AND THE AC-
COMPANYING WRITTEN MATERIALS. In no event shall Hart or its suppliers be liable for 
any damages whatsoever (including, without limitation, indirect, consequential, or incidental 
damages, damages for loss of business profits, business interruption, loss of business informa-
tion, or other pecuniary loss) arising out of the use of or inability to use the Software, even if 
Hart has been advised of the possibility of such damages.

GOVERNING LAW
This agreement and license shall be governed in the United States by the laws of the State of 
Washington, and elsewhere by the laws of the country within which the agreement is made.
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14	 Appendix B – Copyright Notices
LogWare III Temperature and Humidity Logging Software

Copyright © 2006 Fluke Corporation, Hart Scientific Division

Third party software used in the development of LogWare III (complete license agreements can 
be found on the distribution media):

JBoss® application server (http://www.jboss.org) and Hibernate persistence library (http://
www.hibernate.org) are licensed under the LGPL, GNU Lesser General Public License (http://
www.gnu.org/licenses/lgpl.html). 

Copyright © 2002-2006 Red Hat, Inc. All Rights Reserved. JBoss is a registered trademark of 
Red Hat, Inc. 

Filename: lgpl.txt

PocketSOAP (http://www.pocketsoap.com) is licensed under the Mozilla Public License v1.1 
(http://www.mozilla.org/MPL/MPL-1.1.html). 

Copyright © Simon Fell, 2000-2004. All rights reserved.

Filename: mozilla_v11.txt

Bouncy Castle cryptography (http://www.bouncycastle.org)

Copyright © 2000 - 2006 The Legion Of The Bouncy Castle

Filename: bouncycastle.txt

XStream serialization (http://xstream.codehaus.org/) 

Copyright © 2003-2005, Joe Walnes. All rights reserved.

Filename: xstream.txt 

Apache Tomcat application server (http://www.apache.org) is licensed under the Apache Li-
cense, Version 2.0 (http://www.apache.org/licenses/LICENSE-2.0) 

Copyright © 1999-2006, The Apache Software Foundation

Filename: apache-2.txt
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15	 Appendix C – Migrating Data From Previous  
Versions

When upgrading to LogWare III version 2 from a previous version (version 1.x), you may want 
to migrate the data that was logged by the previous version into the data storage system used by 
version 2. A migration utility is provided to facilitate this process.

When the LogWare server files are installed, the LWMigrate.exe application is installed in the 
same folder as the LogWare application files on the server computer. 

Note: The LogWare client files must be installed on the computer where you want to run 
the migration utility. Failure to install the LogWare client files on the computer will cause 
the migration utility to fail to run. 

The process of migrating previously logged data to the new data storage system may take 
several hours, depending on the amount of data to migrate. This process will also require a lot 
of processing time on the server and generate a lot of network traffic if done on a client/server 
configuration. For this reason, we make the following recommendations:

It is strongly recommended to run the migration utility on the server computer only in 
client/server configurations to minimize network traffic. If the server computer is running 
Windows® Server 2003, you will be required to run the migration utility from one of the 
client computers.

It is strongly recommended to migrate previously logged data prior to allowing real-
time log sessions to be started to allow the server to dedicate as much processing time to 
the migration process as possible.

It is recommended to run the migration process overnight or over a weekend when there 
is less activity on the server computer and the network.

It is recommended that the version 1.x database be located on the same computer that 
you run the migration utility on to minimize network traffic. You may need to copy 
the database files from another computer if necessary. The database files for version 
1.x are all included in the \Database subfolder, typically found at C:\Program Files\
Fluke-Hart Scientific\LogWare III. You must copy both the LOGWARE3.MDB and 
LOGWARE3.MDW files to the server!

●

●

●

●
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Figure 89 LogWare III Database Migration Utility

To begin the migration process…
Double-click the LWMigrate.exe file icon on the server computer. By default, this file is 
located in the C:\Program Files\Fluke-Hart Scientific\LogWare III Client folder on 
the server. 

If the computer that you are running the migration utility on is the same computer that 
the previous version of LogWare was installed on, the LogWare III v1.x Database field 
will be filled in. Otherwise, click the  button to locate the LOGWARE3.MDB file.

Enter the Username and Password to use to access the version 1.x database. It is 
recommended to use the built-in LogWare username with its associated password.

Check the Compact database prior to migration checkbox. 

Enter the name of the computer where the LogWare III version 2 server files are 
installed. This field should be filled in automatically. For stand-alone configurations, use 
LOCALHOST as the server’s computer name. The Port field should be set to 8080.

Enter the Username and Password to use to access the version 2 database. It is 
recommended to use the built-in LogWare username with its associated password. 

1.

2.

3.

4.

5.

6.
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To begin the migration process, click the Start button. The migration progress is 
displayed in the Migration Status window.

Because migrating the data is a long process, there is the potential that the process may get 
interrupted. If the process does not complete, you may simply start the process again. The 
migration utility will not create duplicate asset, location, user, or other records in the new data 
storage system. It keeps track of how much data has already been migrated and picks up where 
it left off.

Note: If the migration process does get interrupted, you may be required to manually 
close a migration log session before continuing. Run the LogWare III client application 
and login using the built-in administrator account. Select the Manage Log Sessions 
option from the Tools menu and close any “inactive” log sessions.

7.
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